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elcome to OpenSolaris Bible! This book provides an introduction and tutorial on one of

the newest open source operating systems: OpenSolaris. Based on the enterprise-class

Solaris operating system from Sun Microsystems with roots in UNIX dating back to
1969, and chock-full of exciting new features such as ZFS, Zones, SMF, and DTrace, OpenSo-
laris was released to the open source community in 2005. Since then, Sun and the OpenSolaris
community have added significant virtualization features, such as xVM Hypervisor and Virtual-
Box; created a new network packaging model called IPS; rewritten the installer; and created a
brand-new Live CD distribution. Whether you're looking for a new laptop, workstation, devel-
opment platform, or server, it’s worth your while to read this book and take OpenSolaris for
a spin.

This book is a comprehensive resource on using OpenSolaris. By the time you have completed the
book, you'll know how to install, use, administer, develop on, and deploy OpenSolaris. In fact,
you'll become a power user, conversant in advanced troubleshooting with FMA, SMF, DTrace,
and more. In addition, you'll understand how to use virtualization technologies with OpenSolaris
to optimize your physical hardware.

Additionally, OpenSolaris Bible contains the following features:

B Practical, hands-on advice. As active software developers who use OpenSolaris every
day, the authors have included hands-on usable information. Unlike some books that
address only theory, this book contains practical tips and tricks that you can immediately
put into practice.

B Concrete examples. The book is full of specific examples — including exact command
lines and screenshots — that walk you through the tasks you need to accomplish. These
examples are all well tested.

B Cutting-edge information. As active contributors to OpenSolaris, the authors provide
cutting-edge details about rapidly evolving features such as IPS, xVM Hypervisor, Virtual-
Box, and more.

M Candid insider tips. As both Sun Microsystems employees and OpenSolaris community
leaders, the authors are in an ideal position to explain OpenSolaris to you.
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Introduction

Who Should Read This Book

Perhaps you've heard about the ZFS file system, DTrace, or one of the other novel features in
OpenSolaris and are eager to try out the operating system to see what all the fuss is about; or
maybe you're an experienced UNIX or Linux user who wants to explore one of the newest open
source operating systems on the block. You might be a disgruntled Windows user interested in
moving into the wonderful world of open source software; or perhaps you're already an expe-
rienced OpenSolaris user who would like to move to the next level or learn about a feature
that you haven’t had the chance to try yet. This book has something for you, regardless of your
background or familiarity with OpenSolaris.

The only prerequisite for reading this book is that you have some experience with UNIX or
Linux. That could be with any UNIX/Linux variant, such as Solaris, HP-UX, NetBSD, MacOS X,
Ubuntu, Red Hat Linux, and so on. The key point is that you should be familiar with the basic
UNIX/Linux model: You should know what a shell is, and be familiar with the concepts of users,
processes, file systems, network interfaces, and the like. If you've used only Microsoft Windows,
the UNIX model represents a paradigm shift; and you will find it easier to approach once you've
read an introductory book on UNIX or Linux, such as UNIX for Dummies by John R. Levine
and Margaret Levine Young. However, Chapter 3 of this book provides a whirlwind introduction
to basic OpenSolaris user and administrator concepts, so if you're in doubt, skim through that
chapter to decide whether this book is appropriate for you.

Programming experience is not a prerequisite for this book. You can read the book even if you've
never written a C program or shell script in your life.

How This Book Is Organized

OpenSolaris Bible contains 24 chapters, divided into six parts. Although the book is organized
so that you can start with Chapter 1 and read straight through to Chapter 24, if you're like the
authors of this book you are unlikely to tackle a technical book that way. Instead, you may want
to jump straight to the sections that most interest you, or use the book as a reference for whatever
task you currently have at hand. For example, if virtualization is the hot topic for you right now,
you might want to jump straight to Part V. To that end, this book has been carefully designed
such that each chapter more or less stands on its own. Chapters that reference material in other
parts of the book contain cross-references where appropriate, so you'll always know where to
look for more information.

Part I: Introduction to OpenSolaris

Part I provides a crash course in OpenSolaris. Chapter 1 introduces the OpenSolaris operating
system and open source community, and contrasts it with other popular operating systems such
as Linux. Chapter 2 describes the various distributions available and shows you how to obtain
and install the OpenSolaris distribution from Sun. Chapter 3 concludes Part I with a tour of the
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OpenSolaris operating environment, from the GNOME desktop to the bash shell, from using
vim, to system administration. If you're new to OpenSolaris, Part I is the place to start. This part
assumes no prior experience with OpenSolaris. Even if you're experienced with Linux or Solaris
and are tempted to jump straight to a more advanced topic, you should skim this section to
ensure that you're up to speed on the latest developments in OpenSolaris and how it differs from
other popular operating systems.

Part Il: Using OpenSolaris

Part II provides the details of using OpenSolaris as a desktop or workstation system. Chapter 4
begins Part 11 by covering the GNOME desktop and the various applications available to you for
accessing the Internet, listening to music, and so on. Chapter 5 continues to describe how to use
your OpenSolaris box as a desktop machine by connecting printers and other peripherals, such
as USB devices. Chapter 6 concludes Part II by describing how to obtain additional software and
how to upgrade your OpenSolaris system. Even if you're planning to use OpenSolaris only as a
server, you should familiarize yourself with the software management discussion in Chapter 6.

Part lll: OpenSolaris File Systems, Networking,
and Security

Part III delves into the details of OpenSolaris administration. Any OpenSolaris user or adminis-
trator needs to understand how to use disk storage, how to network OpenSolaris machines, and
how to take advantage of the OpenSolaris security features. Chapter 7 starts Part 111 with an intro-
duction to using disks with OpenSolaris, including disk naming, formatting, and partitioning; the
UFS file system; and the Solaris Volume Manager. Chapters 8 and 10 present details on the ZFS
file system and Network File System (NFS), respectively. Chapter 9 provides a detailed look

at OpenSolaris networking, while Chapter 10 also includes information on the NIS and LDAP
directory services. Chapter 11 concludes Part III with a thorough discussion of the OpenSolaris
security features, including Role-Based Access Control, IP Security, and Kerberos.

Part IV: OpenSolaris Reliability, Availability,
and Serviceability

Part IV describes the reliability, availability, and serviceability features of OpenSolaris. Computer
systems can and will fail at both the hardware and software level. How an operating system
handles these failures determines its suitability as a robust platform. OpenSolaris, based on the
enterprise-class Solaris operating system from Sun, provides significant robustness in the form
of what computer scientists sometimes call RAS: reliability, availability, and serviceability. This
part opens with fault management and service management, in Chapters 12 and 13, respec-
tively. These features combine to implement OpenSolaris’ predictive self-healing, which provides
significant robustness in the presence of both hardware and software faults. Chapters 14 and
15 describe the serviceability aspects of OpenSolaris, including the innovative dynamic trac-
ing (DTrace) facility. The part concludes with Chapter 16, on clustering OpenSolaris machines
together for increased availability of the system as a whole.

XXXI
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Part V: OpenSolaris Virtualization

Part V covers the various technologies available to use with OpenSolaris to share the comput-
ing resources of a single physical machine among multiple users, processes, and even operating
systems. Chapter 17 presents on overview of virtualization terms and concepts. Chapter 18
describes OpenSolaris resource management techniques for virtualizing resources within a sin-
gle operating system instance. Chapter 19 covers the Zones OS-level virtualization feature in
OpenSolaris. Chapters 20 and 21 describe the xXVM and Logical Domains hypervisor-based virtu-
alization approaches on x86 and SPARC hardware, respectively, that enable you to run multiple
operating system instances on a single physical machine. Chapter 22 concludes Part V with a
look at VirtualBox, an easy-to-use virtualization software application that can run on a variety of
host operating systems, including OpenSolaris, and can support OpenSolaris as a guest operating
system. VirtualBox is your best bet for trying out OpenSolaris, even if you don’t have a physical
machine available on which to install it. If that’s the case, you might want to jump to Chapter 22
after reading Part 1.

Part VI: Developing and Deploying on OpenSolaris

Part VI concludes OpenSolaris Bible with a thorough look at deploying web services and using
OpenSolaris as a development platform. Chapter 23 shows you how to use the web stack appli-
cations available on OpenSolaris, such as the Apache web server, MySQL, PostgreSQL, Apache
Tomcat, and others. Chapter 24 presents the various development and debugging tools avail-
able on OpenSolaris, including the Java Development Kit, the Sun Studio Compiler Collection,
NetBeans, the GNU Compiler Collection, and various source code management systems such as
Mercurial. If you're a developer considering OpenSolaris as your platform, Chapter 24 has all the
background information you need.

Conventions Used in This Book

There are many different organizational and typographical features throughout this book designed
to help you get the most from the information.

Text styles

This book uses a number of conventions to present the material clearly and consistently:

B New terms are italicized when they are introduced.
B Keyboard strokes are shown like this: Ctrl+K.

B Nested menu options are listed in order of selection, separated with arrows, like this:
Applications— Graphics—Image Editor

B Code, commands, URLs, filenames, and file listings are all printed in a monospace font
like this: www.opensolaris.com.



Introduction

B  When an example includes both input and output, the same monospace typography is
used, but input is presented in bold type to distinguish the two. Here’s an example of a
command with both input and output:

$ echo "Hello, world"
Hello, world

Command prompts

The book shows two different prompts for shell commands. A root shell is shown with the pound
sign (#), whereas a non-root shell is shown with the dollar sign ($). Here’s an example of a root
shell command:

# svcadm enable network/physical:default
Here’s an example of a user shell command:

$ date
Tue Jul 29 13:11:10 MDT 2008

Note that OpenSolaris allows certain non-root users to execute privileged commands. This capa-
bility is discussed further in Chapters 3 and 11.

Icons
The following items are used to call your attention to points that are particularly important:
& Notes provide additional, ancillary information that is helpful, but somewhat outside

® of the current presentation of information.

5 Tips generally are used to provide information that can make your work
easier — special shortcuts or methods for doing something easier than the norm.

§ This information is important and is set off in a separate paragraph with a special
icon. Cautions provide information about things to watch out for, whether simply
inconvenient or potentially hazardous to your data or systems.

'V

~\\

I: Cross-references point you to other places in the book where you can find related or
additional material.

Hardware Architecture

Throughout the text the term x86 is used to refer generally to both 32-bit and 64-bit AMD or
Intel hardware architectures. SPARC refers to 64-bit systems with either sun4u or sun4v pro-
cessor class CPUs unless specifically noted. This is primarily only an issue in Chapter 21 on
LDoms.

XXX



XXXIV

Introduction

Manual Page References

System commands are sometimes written in the body of the text such that they refer to the
appropriate manual page for that command. For example, svcs (1) means the svcs command,
which is documented in section 1 of the manual pages. OpenSolaris includes the traditional
UNIX man(1) command, which can be used to display the manual page for a command. Thus,
the following example displays the manual page for the svcs(1) command:

$ man svcs

Resources

Most of the chapters include a “Resources” section at the end that provides suggestions for more
information — for example, URLs to project pages, other reference books, or pointers to the
source code.

What's on the Companion Website

The companion website for OpenSolaris Bible, at www.wiley.com/go/opensolaris contains
the source code for the programming examples in Chapters 15 and 24, as well as an up-to-date
errata list.

Minimum Requirements

To install and try out OpenSolaris on bare metal, you need a desktop or laptop machine with the
following minimum requirements:

B Intel or AMD 32-bit or 64-bit Pentium III or faster processor
B 512MBRAM

B 10GB free hard disk space

B CD or DVD drive

If you intend to download OpenSolaris from the Internet, you need a reasonably high-speed
Internet connection and a CD burner to burn the image to a CD. Alternately, you can order a
free CD from http://opensolaris.com.

OpenSolaris does not work perfectly with every off-the-shelf laptop or desktop machine. Use the
device detection tool described in Chapter 2 to determine whether your hardware will work.

OpenSolaris in a virtual machine

If, instead of running on bare metal, you want to run OpenSolaris in VirtualBox, VMware, or
on other virtualization software, you need at least 1GB of RAM, but you won’t need a CD/DVD
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drive or a CD burner. You also won't need to worry about hardware compatibility and the device
detection tool.

Other requirements

A few of the topics in this book require hardware other than the minimum listed here. Logical
Domains, described in Chapter 21, require a sun4v SPARC processor. Running virtual machines
under xVM, VirtualBox, or Logical Domains generally requires more than 512MB of RAM; and
Solaris Cluster Express, described in Chapter 16, requires additional disk space and RAM.

Where to Go from Here

While reading this book, the authors strongly suggest that you “play along at home” by down-
loading and installing the free OpenSolaris distribution from http://opensolaris.com.

After reading the book, you should be a confident user and administrator of OpenSolaris. If you
have clarifying questions or queries about topics not covered in this book, please feel free to ask
the OpenSolaris community at http://opensolaris.org. Chapter 1 contains a list of helpful
mailing lists and forums.

Despite our best efforts to ensure the correctness of all the material in this book, you
might uncover a mistake as you're reading. If you do find a bug, please report it at
www.wiley.com/go/opensolaris.

We hope you find this book useful, and that you enjoy using OpenSolaris as much as we do!

XXXV
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ou probably wouldn’t have picked up this book if you hadn’t at

least heard of OpenSolaris or Solaris, but even if you've poked

around OpenSolaris or used Solaris for years, you might be
confused about what, exactly, OpenSolaris is. Is it an operating system, an
open source code base, an open source community, or a distribution? How
is it different from Solaris? How is it different from Linux? Is it really open
source?

This chapter answers those questions and more. Even if you're an experi-
enced Solaris user, this chapter may be useful in helping you understand
OpenSolaris and its differences from Solaris. On the other hand, if you're
already involved in OpenSolaris, you might still want to skim this chapter
to learn a bit about the history of OpenSolaris and Solaris with which you
might not be familiar.

Introduction to OpenSolaris

OpenSolaris is an open source operating system, similar in scope to
GNU/Linux and BSD, but descended from the proprietary Solaris operating
system from Sun Microsystems. The authors of this book find it helpful to
think of OpenSolaris as divided into three distinct but related aspects: the
code, the distributions, and the community.

OpenSolaris code

OpenSolaris is the open source version of Sun Microsystems” Solaris oper-
ating system, but OpenSolaris consists of code for much more than
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just the core operating system — it includes source for installers, desktops, layered software
such as Open High Availability Cluster, documentation, test frameworks and test suites, and
much more. OpenSolaris is millions of lines of source code in tens of thousands of source files.

You can browse the source code online at http://src.opensolaris.org.

If you're familiar with the Linux world, you can think of this aspect of OpenSolaris as similar to
kernel.org, but with source code for much more than just the operating system kernel.

Some parts of Solaris are legally encumbered, such that they cannot be open sourced.
Thus, OpenSolaris does not contain the source code for the complete Solaris operat-

ing system.

OpenSolaris distributions

Unless youre an operating systems developer, source code doesn’t do you much good. Most
people want a running operating system, not a bunch of code. While you can theoretically
build a running system from the source, if all you want to do is run OpenSolaris, it's much
easier to install one of the OpenSolaris binary distributions. Luckily, there are several of them,
including Solaris Express, Shillix, BeleniX, NexentaCore, and MartUX. This book focuses on the
OpenSolaris distribution from Sun Microsystems, confusingly also named OpenSolaris.

(The OpenSolaris distribution from Sun is available from http://opensolaris.com.)

Sun Microsystems owns the trademark for the term OpenSolaris. Thus, distributions
from outside Sun are allowed to use the term only by following the OpenSolaris
Trademark Policy. See http://opensolaris.org/os/trademark.

The various OpenSolaris distributions are comparable to the various Linux distributions such as
Ubuntu, Red Hat, and SUSE Linux.

§R£E Chapter 2 describes OpenSolaris distributions in more detail.

OpenSolaris community

The OpenSolaris community consists of the activity around the OpenSolaris source code and
distributions, including design and development of new features, bug fixes, advocacy and evan-
gelism, distribution building, discussions, and much more. The development community, cen-
tered at http://opensolaris.org, hosts the source code and provides resources for projects
such as web space, mailing lists, and source code repositories. This community supports active
development, similar to the Apache community.

A more user-centered community built around the OpenSolaris binary distribution from Sun can
be found at http://opensolaris.com.

Both of these OpenSolaris communities are sponsored by Sun Microsystems. However, non-Sun
employees are encouraged to participate at all levels, from using the distributions to writing ker-
nel code.
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The section “Getting Involved in OpenSolaris” near the end of this chapter provides more infor-
mation about the OpenSolaris communities.

OpenSolaris Features

OpenSolaris contains a rich feature-set that makes it suitable for a wide variety of uses, from
running a personal desktop or laptop to providing web services to hosting enterprise-class
databases with stringent availability requirements. OpenSolaris contains far too many features to
list here, but an overview of the key differentiators can help you start to evaluate its usefulness.
For more details on these features and many others, read the rest of this book! Here are some of
the OpenSolaris highlights:

Support for multiple hardware architectures, including both SPARC and 32-bit and 64-bit
x86-based systems. OpenSolaris also performs well in many industry benchmarks.

High scalability. OpenSolaris runs on both single processor machines and multiprocessor
systems with hundreds of CPUs and terabytes of RAM.

Innovative file system and volume manager support. Solaris uses a Virtual File System
(VES) layer so that different file systems can be plugged in on top of it relatively easily. In
addition to the standard Unix File System (UFS), OpenSolaris includes the Solaris Volume
Manager (SVM) and the new ZFS.

Networking features, including a kernel-level, high-performance TCP/IP stack, IPv6
support, IPsec, Network Auto-Magic (NWAM) for automatic detection and configuration
of network interfaces, and IP Network Multipathing (IPMP) for fault tolerance and load
balancing.

Complex resource management, including processor pools, physical memory controls,
and a fair share scheduler.

Sophisticated security, including role-based access control (RBAC), configurable privi-
leges, and trusted extensions.

Rich observability and debugging support, including myriad system monitoring tools, the
Modular Debugger (MDB), and the dynamic tracing facility (DTrace).

Predictive self-healing features in the form of the Fault Management Architecture (FMA)
and Service Management Facility (SMF). They work together to detect hardware and soft-
ware faults and take appropriate action.

Multiple forms of virtualization. In addition to the operating-system-level virtualization of
Solaris Zones, OpenSolaris offers support for xVM Hypervisor, Logical Domains (LDoms),
and VirtualBox, and runs in VMware and other virtualization frameworks.

Sophisticated 64-bit fully preemptable kernel. The OpenSolaris kernel is also

modular — device drivers can be installed without requiring a system reboot, and features
can be configured without recompiling the kernel. The virtual memory subsystem uses
demand paging for greater performance and less memory usage. The process scheduling
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system supports multiple scheduling classes, including timeshare, real time, interactive,
fair share, and fixed priority.

B Full POSIX compliance with a rich application programming API, including support for
64-bit applications.

B Integrated AMP stack (Apache, MySQL, PHP) for running web services.

With all of these features in mind, let’s take a look at open source software.

The “Open” in OpenSolaris

As implied by the “open” in the name, OpenSolaris is open source software. The general
meaning of open source is that the source code is available for anyone to look at. However,
the details vary, and in fact OpenSolaris is not open source in exactly the same way as Linux,
Apache, MySQL, BSD, Perl, Java, or most other open source software with which you might be
familiar. To understand the details of the OpenSolaris open source model, it’s helpful to first
review and define some open source software basics.

Open source software basics

In the traditional closed source model of software development, companies or developers
distribute only running programs in the form of binaries. Users cannot look at the source code
from which those binaries were compiled. In the open source model, as its name implies,
anyone can view, modify, compile, and even redistribute the source code for the programs.
More specifically, the Open Source Initiative, a respected authority and advocate for open source
software, specifies 10 criteria that software must fulfill in order to be open source, including the
following:

B Free redistribution — Anyone can sell or give away the software by itself or as part of an
aggregate distribution.

B Source code — Source must be available for all distributions.

B Derived works — Anyone can modify the code and redistribute it.

B No discrimination — The code must be available to anyone for any “field of endeavor.”

The complete list is available at http://opensource.org/docs/osd. It's important to
remember that open source software, despite sometimes being called free software, is not
required to be free of charge. Think of the “free” in free software as referring to free speech,
rather than free beer. Thus, companies or individuals can sell programs built from open source
code.

Other terms for open source software include free software and free and open source
software (FOSS).

This book uses the term open source software not to emphasize any particular software philoso-
phy but because the authors think it’s the clearest term.
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Open source licenses

All open source code is available under an open source license, which defines the terms of use.
Different open source projects choose different licenses. Some licenses with which you might be
familiar are the GNU General Public License version 2 (GPLv2), under which Linux is available,
and the BSD license, under which OpenBSD, NetBSD, and other BSD variants are available.

The major difference between the licenses is their requirements regarding derivative works, or
modifications to the source code. Specifically, if someone who is not the original author takes
some open source code and changes it by adding newly written code, removing code, or com-
bining it with other code, is she required to release the new code under the original license, or
can she use a different license? Based on this criterion, there are three categories of open source
licenses:

B Strong copyleft licenses require that any derived code stay under the original license.
Therefore, if a developer adds some code to a file under a copyleft license, then that
new file must also be released under the original license. A strong copyleft license is
project-based, rather than file-based. That is, all source files in a project must be under the
same license. This requirement generally means that code under a strong copyleft license
cannot link (either statically or dynamically) with code under a non-strong copyleft
license. Another way of looking at it is that every piece of code that strong copyleft
licensed code touches must also be under that license. For this reason, strong copyleft
licenses are sometimes called viral licenses. Thus, you cannot generally combine code
under a strong copyleft license with code under other licenses. The best-known strong
copyleft license is the GNU General Public License (GPL), both versions 2 and 3. The
Linux kernel, the GNU tools, Java, and a multitude of other software projects use the GPL.

B Weak copyleft licenses are nearly identical to strong copyleft licenses except that they’re
file-based instead of project-based. That is, modifications to a file must be released under
the original license, but that file can be combined in a project with code under a different
license. As a result, weak copyleft licenses are not viral in the same way as strong copyleft
licenses. The Mozilla Public License (MPL), under which the Mozilla Firefox browser is
licensed, is a weak copyleft license.

B Non-copyleft licenses do not require derived works to stay under the original license.
They do not even require derived code to be released under any open source license.
Thus, someone could take an open source project under a non-copyleft license and use
it as a basis for a proprietary product. The BSD license is the best-known example of a
non-copyleft license.

While these differences can seem esoteric, a quick glance at the discussions in various open
source communities shows that the debate can become quite passionate. Some people, par-
ticularly in the Linux and GNU communities, feel strongly that only strong copyleft licenses

are “true” open source licenses because they best protect the original author. Others feel that
non-copyleft licenses, such as the BSD license, are preferable because they give the most freedom
to developers creating derived works. Still others find weak copyleft licenses to be a reasonable
compromise.
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Open source licenses generally include provisions to distribute binary executables built from the
source. The licenses usually require that the source code be made available with the binary exe-
cutables, or be made available upon request. For example, both the Linux source and the Linux
distributions are available under the GPLv2.

OpenSolaris licenses

The OpenSolaris source code is heterogeneous in its open source licenses and the predominant
license may be unfamiliar to you.

Common Development and Distribution License

The majority of the OpenSolaris source code is available under the Common Development and
Distribution License (CDDL), pronounced “cuddle.” Written by Sun explicitly for OpenSolaris,
this license has been officially approved by the Open Source Initiative (OSI) as a legitimate open
source license. It’s a weak copyleft license like the MPL (which it resembles) in that it requires
derivative works to maintain the same license on a per-file basis, but does not require all the
files in a project to be under the CDDL.

Because the CDDL is copyleft, changes to the source code itself must be released under the
CDDL as well. It is hoped that any such changes are contributed back to the OpenSolaris
community itself, but that is not a requirement. However, because the CDDL is weak copyleft,
instead of strong copyleft, whole pieces of it may be incorporated into projects under different
licenses, including proprietary projects. This aspect of the license has allowed OpenSolaris
features such as DTrace and ZFS to be ported to other operating systems such as Mac OS X
10.5. (DTrace and ZFS are covered in Chapters 15 and 8, respectively.)

& The GPLv2 is incompatible with the CDDL because the GPLv2 requires all code in
the project to be under the GPL. Thus, porting OpenSolaris features to Linux is signif-
icantly more complicated than porting to other systems.

Because the Solaris code base contained some open source and third-party code even before
it was open sourced by Sun, not all the OpenSolaris code is under the CDDL. Parts of it are
licensed under the BSD license and other open source licenses. Each source file contains a
header comment specifying the license for that file.

Binary distributions under the CDDL

It's sometimes perplexing that some binary distributions of OpenSolaris are available under the
CDDL. Isn't the CDDL a source code license? Yes, it is. However, like many other open source
licenses, the CDDL permits binary executables built from source code under the license to be
distributed under the CDDL. Thus, distributions of OpenSolaris may be distributed under the
CDDL.

As if things weren’t confusing enough with the source code licenses, OpenSolaris also uses
another binary license called the OpenSolaris Binary License (OBL). Binaries under this license
are freely redistributable, and can be used for running and developing OpenSolaris. Binaries
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released under the OBL include build tools, parts of Solaris that cannot be open sourced (and so
aren’t under the CDDL), and binaries built from proprietary code.

Open development

Open source software is generally, but not always, developed as part of a community in an open
development process. In open development, developers can collaborate in public forums, par-
ticipants need not all work for the same company, and there is freedom to pursue projects that
might not fit within the scope of a single company’s business needs.

The opposite of an open development process is a proprietary development process, in which
a company or individuals write the code on their own, with their particular business needs in
mind, and without interacting with people outside their group.

Eric S. Raymond’s seminal article, “The Cathedral and the Bazaar,”
compares these two software development models. You can read the article at

SENOTH

www.catb.org/~esr/writings/cathedral-bazaar/cathedral-bazaar.

Although the Solaris operating system was originally developed in a proprietary development
model, the OpenSolaris community is intended to support an open development model.
Consequently, you will find many active developers, discussions, and ongoing projects at
www.opensolaris.org.

What open source OpenSolaris means to you

At this point you might be wondering what the open source and open development aspects of
OpenSolaris mean for you. On the open source side, while the specific terms of the licenses
and the legal requirements can be complicated, the important thing to remember is that you
can always look at the OpenSolaris source code. That may not be too useful if you only want
to run an OpenSolaris distribution, but if you're a developer or advanced system administrator,
studying the OpenSolaris code can be a valuable proposition.

On the other hand, the open development aspects of OpenSolaris should interest everyone. The
OpenSolaris community is a great place to ask for help, contribute suggestions, participate in
discussions, and in general influence the direction of OpenSolaris!

The History of OpenSolaris

The history of OpenSolaris, and even some of the source code, dates back to 1969. In that year,
Ken Thompson at AT&T Bell Laboratories wrote the first version of the UNIX operating system.
UNIX was designed from the beginning to be multi-user and multi-tasking, with an interactive
shell that would still look familiar to any UNIX or Linux user today. Over the next few years,
Thompson and Dennis Ritchie continued refining UNIX, which was used mostly inside Bell
Labs. However, in the mid to late 1970s, UNIX versions 6 and 7 were distributed fairly
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widely, and used by various academic and government institutions, including the University of
California at Berkeley.

Because of the lenient license terms in early versions of AT&T’s UNIX, other organizations
began significantly customizing and enhancing it. This work led to several major branches of
UNIX, the most relevant of which to OpenSolaris was the Berkeley Software Distribution (BSD).
In 1978, Bill Joy and others at Berkeley added virtual memory, demand paging, and other
embellishments to UNIX Version 7 to create a version of UNIX called 3BSD. Joy and others
continued enhancing BSD UNIX over the next few years, adding the familiar TCP/IP networking
stack, the C shell, the VI editor, and other key features.

In 1982, Bill Joy co-founded Sun Microsystems and by 1984 had used BSD UNIX as the
basis for the SunOS operating system that ran Sun’s workstations. In the meantime, AT&T
continued developing its line of UNIX, calling it System V, and other companies created their
own branches, such as Microsoft’s Xenix (which later became SCO UNIX).

In the late 1980s, Sun and AT&T began work on a joint project to remerge several popular vari-
ants of UNIX to create System V Release 4. The result, completed in 1990, contained the best
features from AT&T’s earlier System V Release 3, Sun’s SunOS, 4.3BSD, and Xenix 5, includ-
ing TCP/IP support, the Network File System (NFS), the Unix File System (UFS), and the Vir-
tual File System (VFS) interface. Additionally, System V Release 4 (SVR4) fully complied with
the Portable Operating System Interface (POSIX) standard, which defines an application pro-
gramming interface, utilities, and other aspects of an operating system. Theoretically, a program
written to POSIX interfaces can run on any POSIX-compliant operating system. In 1992, SVR4
became the basis of Sun’s new operating system, Solaris 2.0.

“Solaris” technically refers to the entire operating environment, including the graph-
ical user interface. The kernel itself is still called SunOS. However, this book uses
Solaris in the colloquial sense to refer to both the entire operating environment and the kernel.

In the years since, Sun has continually enhanced Solaris with features such as the kernel slab
memory allocator, multithreaded kernel and multithreaded process support, 64-bit kernel and
process support, Solaris doors inter-process communication, and many others. The most recent
release of Solaris, Solaris 10, introduced several exciting new features such as a dynamic tracing
facility (DTrace), the Service Management Facility (SMF), Zones, and the ZFS file system.

In 2005, Solaris became the first mature proprietary operating system to go open source when
Sun released the source code as OpenSolaris. The open sourced code was basically the source
for Solaris 10, which had been first released approximately five months earlier. Since then,

some of the active development in OpenSolaris has been backported and released in Solaris 10
updates, but much of it is currently unique to OpenSolaris. It’s important to note that backports
of OpenSolaris features to Solaris 10 can only be done by Sun because the Solaris 10 source
code is not open source.

In summary, OpenSolaris’s development path has not been exactly straightforward. As an open
source operating system based on a closed-source operating system that in turn is related to sev-
eral other open source and closed source operating systems, OpenSolaris can be confusing. If
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nothing else, this history should help you understand why there are so many AT&T and Uni-
versity of California Berkeley copyrights in the OpenSolaris source code.

Comparing OpenSolaris to Other
Operating Systems

So how does OpenSolaris compare to other open source and proprietary operating systems? Let’s
take a look.

OpenSolaris and Solaris

OpenSolaris is an open source code base, community, and distribution. Solaris is a proprietary
product from Sun Microsystems. The two are not synonymous, but they are intertwined. First of
all, OpenSolaris was seeded from the Solaris code base around the time of Solaris 10. However,
the OpenSolaris code base has subsequently diverged from the Solaris 10 code base, so the latest
update of Solaris 10 is significantly different from OpenSolaris.

Solaris is a product from Sun, whereas OpenSolaris is an open source code base,
community, and distribution.

Confusingly, Sun does release a distribution of OpenSolaris called OpenSolaris. This distribution
is not the same as the Solaris 10 product. For one thing, unlike Solaris 10, the OpenSolaris dis-
tribution is available free of charge and is fully redistributable. This book focuses primarily on
the OpenSolaris distribution.

¥ The OpenSolaris distribution and other distributions are described in Chapter 2.

In the future, Sun will likely release a version of the Solaris product with long-term support that
is based on a more recent OpenSolaris snapshot. This model will be similar to the way Red Hat
Enterprise Linux is based on the open source Fedora code base.

OpenSolaris and Linux

Linux and OpenSolaris are both open source UNIX-like operating systems. They can support
identical user interfaces, such as GNOME, run many identical applications, such as Apache,
MySQL, Mozilla Firefox, and OpenOffice, and support identical tools such as the GNU compiler
tools, Java, Perl, Python, Ruby, and others. But the two operating systems have significant
differences in their histories, licensing, distribution models, and underlying implementations.

History

Although UNIX-like, the Linux source code is not descended from the original AT&T or BSD
UNIX code. Linus Torvalds and others created it independently in the early 1990s. Because

11



| 214¢ & Introduction to OpenSolaris

12

Linux is not based on the original AT&T UNIX, BSD, SVR4, or any other form of UNIX, it
does not have any kernel code in common with OpenSolaris. Linux was open source from the
beginning, and was developed following a community development model.

Conversely, OpenSolaris was open sourced in whole based on the mature Solaris operating sys-
tem, which was developed in large part in a proprietary development model. Partly because of
this history, Linux has a much larger development community than does OpenSolaris. Linux
also has many more distributions, from several different vendors.

Licensing

The Linux kernel uses the GNU General Public License version 2 (GPLv2), which is incompati-
ble with the CDDL used by OpenSolaris because of the GPL’s viral nature, as described earlier in
this chapter. Thus, code cannot be ported between the OpenSolaris kernel and the Linux kernel.
However, both OpenSolaris and Linux can run userland programs distributed under the GPL
and other licenses, which is why they can appear to be quite similar.

Distributions

The Linux kernel, user applications, tools, and libraries are developed separately and then
packaged together into distributions, which some in the free software community refer to as
GNU/Linux because of the combination of the GNU tools and the Linux kernel. Some of the
well-known distributions include Ubuntu, Red Hat Enterprise Linux, SUSE Linux, and Debian
GNU/Linux.

OpenSolaris is more of a monolithic model, in which many of the userland tools, libraries, and
applications are part of OpenSolaris itself. However, OpenSolaris distributions also use a signif-
icant amount of third-party open source software such as GNOME, Firefox, OpenOffice, and
more.

Technical differences

Some of the most apparent differences between Linux and OpenSolaris derive from the fact

that OpenSolaris is a variant of UNIX System V Release 4, while Linux is not. One of the most
noticeable results of Linux not being based on SVR4 is that it doesn’t use SVR4 packaging. Linux
packaging varies between distributions, but lately it has tended toward a model whereby pack-
ages can be easily downloaded and installed dynamically from a network package repository.
Interestingly, OpenSolaris has recently introduced a more Linux-like packaging approach called
the Image Packaging System (IPS).

& OpenSolaris contains many of the same GNU tools found on Linux. Historically,
these were in /usr/gnu/bin/ and /usr/sfw/bin/, but are moving to /usr/bin/ when
possible. Because of conflicts, some commands are still in /usr/gnu/bin/ and /usr/sfw/bin/.

Additionally, the Linux and OpenSolaris kernels differ significantly in the areas of scheduling,
virtual memory, file systems, and others. For more details, consult one of the references listed in
the “Resources” section at the end of this chapter.
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OpenSolaris and BSD

Because OpenSolaris is based on Solaris, which is based in part on BSD, OpenSolaris and BSD
have significant similarities in their code. The main differences are threefold. First, BSD has been
developed in the open, like Linux, and so has diverged substantially from Solaris. Interestingly,
the BSD community has split into three main camps such that there are now three different
BSD-based operating systems: OpenBSD, NetBSD, and FreeBSD.

Second, BSD is not based on SVR4. In fact, OpenSolaris is the only open source UNIX System V
Release 4—based operating system.

85 Historically, Solaris contains the SVR4-style tools in /usr/bin, while its BSD-style
tools are in /usr/ucb/. However, in OpenSolaris the BSD-style tools are moving to
/usr/bin when possible. Because of conflicts, a few tools remain in /usr/ucb/.

(RO S

Finally, unlike the CDDL used for OpenSolaris and the GPL used for Linux, the BSD license is
a non-copyleft license. This lenient license does not force modifications and enhancements to be
contributed back to the “commons.”

Interestingly, Mac OS X is a variant of UNIX based on the Mach operating system, which itself
is based on BSD. However, Mac OS contains a distinctive Macintosh user interface, hiding the
details of the underlying UNIX operating system from most of its users. Apple has ported some
OpenSolaris features, such as DTrace and ZFS to Mac OS X, and has released the source code of
the core operating system as the Darwin Open Source Project.

Getting Involved in OpenSolaris

As you read this book and use OpenSolaris, we encourage you to become involved in the Open-
Solaris community. There are a number of ways to do so, from trying out a distribution to con-
tributing code. A good starting point is http://opensolaris.org/os/participate.

Running OpenSolaris

The best way to get started with the OpenSolaris community is to actually try out OpenSolaris.
In fact, playing with OpenSolaris simultaneously with reading this book will significantly
enhance your learning experience.

7 [l s The OpenSolaris distribution from Sun, related documentation, and user help forums
SRS are available from http://opensolaris.com. Chapter 2 contains more information
about the OpenSolaris distribution from Sun as well as other distributions available.

While using OpenSolaris, you can enhance your community involvement in two ways. First, if
you encounter a problem, ask questions on the community discussion lists and forums. Several
relevant discussion lists are introduced in the next section. Second, if you find a bug, report it
at http://defect.opensolaris.org (for problems with the OpenSolaris distribution from
Sun) or http://bugs.opensolaris.org (for other issues) so that it can be tracked and fixed.
You can also request enhancements.

13
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Participating in discussion lists

The OpenSolaris communities feature a plethora of forums and mailing lists on a variety of
topics. www.opensolaris.com contains user-oriented forums on the OpenSolaris distribution
from Sun, while www.opensolaris.org contains developer-oriented mailing lists. If you're just
searching for a particular piece of information, you can read the list archives online. However,
to begin to get a feel for the OpenSolaris communities and the day-to-day issues and questions,
consider subscribing to the mailing lists to receive e-mails directly. Some useful lists include the
following:

B opensolaris-help@opensolaris.org— This list is a great resource for general
questions about “getting, building, and installing OpenSolaris.”

B opensolaris-announce@opensolaris.org— Thisis a moderated list for general
community announcements. It’s useful for keeping track of the major OpenSolaris hap-
penings.

B ogb-discuss@opensolaris.org— The public mailing list for the OpenSolaris
Governing Board. Although theoretically for “governance” issues, the list seems to be a
catch-all for any sort of controversy in the community, and is therefore a good way to
track current “hot” issues.

B advocacy-discuss@opensolaris.org— The mailing list for the Advocacy commu-
nity. This is useful to understand what sort of outreach and marketing efforts are going on
for OpenSolaris.

i Many new community members are tempted to subscribe to
“ opensolaris-discuss@opensolaris.org. We do not recommend that
list because it’s high-traffic without much useful content.

Additionally, you can subscribe to more focused lists in your areas of interest. For

example, if you are interested in Sun’s OpenSolaris distribution, subscribe to indiana-
discuss@opensolaris.org. If you are interested in high-availability clusters, subscribe to
ha-clusters-discuss@opensolaris.org. If you are interested in DTrace, subscribe to
dtrace-discuss@opensolaris.org.

& You may have heard the phrase, “There are no stupid questions.” That’s not entirely

. % true in the OpenSolaris community. As in many online technical communities, some
people have little patience for redundant, off-topic, or trivial questions. To avoid possible embar-
rassment, search this book, the mailing list archives, relevant FAQs, and other resources before
asking anything on the discussion lists.

Finding OpenSolaris user groups

OpenSolaris user groups connect people in similar geographic areas for face-to-face meetings,
from Adelaide, Australia, to New York City to Warangal, India. They are a good way to meet
other OpenSolaris users and enthusiasts, and to learn more about cutting-edge topics. If you live
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in a large metropolitan area, chances are good that you can find an OpenSolaris user group in
your area.

Each user group is independently run, so check out the individual group for mail-
ing lists, upcoming meetings, and other resources. The complete list can be found at
http://opensolaris.org/os/community/advocacy/usergroups/ug-leaders.

If there is no OpenSolaris user group in your area, consider starting one! You can find instruc-
tions for doing so at http://opensolaris.org/os/community/advocacy/usergroups.

Contributing to OpenSolaris

The best way to increase your involvement in the OpenSolaris community is to start
participating in relevant development discussions. These usually occur on mailing lists at open-
solaris.org. You can find a complete list of mailing lists at http://opensolaris.org/os/
discussions.

If you're interested in contributing code or other tangibles to the OpenSolaris community effort,
consult the instructions at http://opensolaris.org/os/communities/participation for
the current process.

OpenSolaris Development Process

Although you may not be interested in contributing code to OpenSolaris, it can be interesting
and useful to understand how the operating system is developed. Before delving into the pro-
cess, it helps to understand the OpenSolaris source-code layout. The OpenSolaris code base is
divided into major areas, called consolidations, each of which has its own source-code repository.
The core OpenSolaris consolidation is Operating System/Networking (ON), which contains the
operating system kernel, userland libraries, and tools. Other consolidations include Developer
Product Tools (Dev Pro), Documentation (Docs), and Globalization Support (G11N). You'll find
a list of consolidations at http://opensolaris.org/os/downloads.

& Unlike some open source projects, OpenSolaris does not have a notion of ““com-
% mitters” or a select group of people who are permitted to integrate code. Anyone
can integrate code into OpenSolaris as long as they follow the process and have submitted a
signed Sun Contributor Agreement. See http://sun.com/software/opensource/contributor_

agreement. jsp for details.

OpenSolaris allows two different paths for source code development, depending on whether the
code is destined for an official consolidation such as ON.

If the code is not destined for an official consolidation, then no standard development process
must be followed. Anyone can start an OpenSolaris project and create a code repository or post
code as a tarball on the project page.

15
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However, code developed in that way will not become part of the OpenSolaris code base. If
you want your code to become part of the OpenSolaris code base, you must follow a rigorous
development process to integrate it into a consolidation. This process evolved from the internal
process that Sun Microsystems required for integration into Solaris. Although it varies by
repository, the process generally includes the following:

B Initiation — Propose a project.

B Architecture review — The architecture is generally reviewed by an Architecture Review
Committee (ARC). Projects destined for ON are mostly reviewed by the Platform Soft-
ware Architecture Review Committee (PSARC), projects destined for Open HA Cluster
are reviewed by the Cluster Architecture Review Committee (CLARC), and projects des-
tined for the desktop area are generally reviewed by the Layered Software Architecture
Review Committee (LSARC). See the Architecture Processes and Tools Community Group
at http://opensolaris.org/os/community/arc for more information.

B Design — Prepare written documentation about the code design of your project.

Development — Write, test, and debug the code.

B Code reviews — Each area has different requirements regarding the number of code
reviewers, but a good rule of thumb is to obtain reviews from at least two people, at least
one of whom is a known expert in that area.

B Integration approval — Every project must be approved for integration by the C-Team.
Currently, the C-Team is Sun-internal only, but it is moving to become more open.

B File request to integrate (RTI) — This is the formal mechanism for obtaining the final
integration approval.

B Integrate

As you can see, this process is not for the fainthearted; but it’s the price to pay to keep Open-
Solaris at the same level of quality as the Solaris product on which it was based, and it’s not too
extreme compared with the process in other open source projects. For example, the Linux ker-
nel contribution process, although different in style, is similarly rigorous.

& Various parts of the development process moved from Sun internal to OpenSolaris

“ at different times. To allow external contributions before the source code repository
offered direct-commit access from outside Sun, OpenSolaris used a request/sponsor model in
which a Sun employee sponsored an external contributor.

For more information on the OpenSolaris development process, see the complete process in the
ON Community Group: http://opensolaris.org/os/community/on.

Resources

The user-oriented site on the OpenSolaris distribution from Sun is http://opensolaris.com.
It provides binary downloads and contains documentation and help forums. The documentation
is located at http://opensolaris.com/learn.
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The developer site for the OpenSolaris community is at http://opensolaris.org. It con-
tains useful mailing lists, user group details, and a plethora of information about past and cur-
rent development projects. You can start with http://opensolaris.org/os/participate.

The Trademark Policy can be found at http://opensolaris.org/os/trademark.
The OpenSolaris source code can be browsed at http://src.opensolaris.org.

You can file bugs at http://defect.opensolaris.organd http://bugs.open
solaris.org.

The Open Source Initiative web page (http://opensource.org) contains much useful infor-
mation on open source code, including the text of all the licenses mentioned in this chapter.

For general information on operating systems, consult Operating System Concepts by Abraham
Silberschatz, Peter Baer Galvin, and Greg Gagne (Wiley, 2005).

For details on the Solaris and OpenSolaris implementation, see Solaris Internals: Solaris 10 and
OpenSolaris Kernel Architecture by Richard McDougall and Jim Mauro (Prentice Hall, 2006).

For more information on using and administering Linux, see the Linux Bible by Christopher
Negus (Wiley, 2005).

For details on the Linux implementation, see Understanding the Linux Kernel (Third Edition) by
Daniel Bovet and Marco Cesati (O'Reilly, 2000).

You can find the Sun Contributor Agreement at http://sun.com/software/opensource/
contributor _agreement.jsp.

The Architecture Review Process and development process are documented at http://open
solaris.org/os/community/arc/ and http://opensolaris.org/os/community/on.

Summary

This chapter introduced OpenSolaris, described its three main aspects, enumerated some of the
salient OpenSolaris features, explained its licensing, related some of its history, contrasted Open-
Solaris with several familiar operating systems, explained the OpenSolaris development process,
and described how to get involved in the community. Now you're ready to learn more about
the OpenSolaris distributions in Chapter 2 and to jump into a crash course on OpenSolaris in
Chapter 3.
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surprisingly large number of distributions are derived from the
OpenSolaris source base, given the relative youth of the Open-
Solaris community. This chapter covers the basics of the
distributions created through mid-2008:
B Solaris Express Community Edition (SXCE)
Schillix
BeleniX
NexentaCore
MartUX
MilaX
B OpenSolaris

The OpenSolaris distribution is specifically created for users new to the
OpenSolaris community and technology, and is a special focus of this
book. After getting a feel for what the other OpenSolaris-based distribu-
tions are about and the reasons why you might be interested in them,
you'll walk through the process of downloading, installing, and updating
OpenSolaris. By the end of this chapter you should have a clear idea about
which OpenSolaris-based distribution is likely to be right for you; and

if you've chosen OpenSolaris itself, you'll have a working installation to
use to explore further. (If you find the multiple meanings of OpenSolaris
confusing, you may find it helpful to review Chapter 1.)

| In addition to the download site for each distribution, a
community-run mirror of all of the redistributable distribution
downloads is provided at http://genunix.org.
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Solaris Express Community Edition

Solaris Express Community Edition (commonly abbreviated SXCE) is the “original” OpenSolaris
distribution. Releases of SXCE began with the establishment of the OpenSolaris community in
2005. It is available for both x86 and SPARC processor platforms. SXCE is targeted specifically
at developers who want to participate in the development of OpenSolaris, giving them access
to the same development platform used by Sun’s own engineering staff. SXCE is distributed

as a free download from Sun’s website. Its license is limited: while the software is free to use,

it may not be put into production. Additionally, the images may not be mirrored or otherwise
redistributed outside of the organization to which the license is granted. Within the images,

the individual software components in the SXCE distribution are provided in the form of SVR4
packages. SXCE is not a pure open source distribution in that it includes components that are
closed source and proprietary to it; most of the examples of these components are drivers for
which Sun does not have licensing permission to offer for redistribution. In short, it is a hybrid
of open and closed source components.

How SXCE Is Developed

XCE offers the clearest view into how Solaris has historically been developed by making Sun’s
development snapshots of the Solaris release under development, which is code-named Nevada,
directly available to the OpenSolaris community.

For many years, Solaris releases have been developed on a two-week build cycle. This means that
every two weeks, each consolidation contributing software to the distribution provides its current
binary packages to the release management, or Product, team. The Solaris Release Engineering
organization then uses a set of custom-built tools to assemble the packages into the media formats
used to release the software. These include CDs, DVDs, and pre-built network installation images
(only the CD and DVD images are released outside of Sun).

Once the images have been built, they are passed along to various test organizations for validation;
after the build passes a basic set of tests, it is released within Sun. Releases to the community
generally follow within a few days, after any necessary legal and regulatory approvals are obtained.
These biweekly releases are not a supported product, but instead are considered test builds for the
next release of Solaris, so each version of SXCE is referred to by a build number starting from 1.
Nevada has had by far the longest development cycle of any Solaris release since Solaris 2.0, well
past three years at this writing.

For a time, Sun offered a stabilized version of SXCE known as Solaris Express Developer Edition
(SXDE). It provided a simplified installer, additional software such as an AMP (Apache/MySQL/PHP)
stack, and developer tools such as NetBeans and Sun Studio. You may still see references to SXDE,
but it has been replaced by the OpenSolaris distribution described later in this chapter.
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Users obtain SXCE by downloading media images from the Sun download center. This dis-
tribution is available to the community as a DVD ISO image. Installing the release requires
downloading the ISO image, burning it to media, and then booting from the DVD and installing
the distribution to disk. The installation media is a bootable version of Solaris, but it's designed
strictly for installation and some limited disaster recovery, not for a general evaluation of the
distribution.

To upgrade from one build of SXCE to another, it is necessary to download the entire media
image. Then you have two options: burn the image to optical media and boot from the media

to upgrade, or mount the media image as an ISO file system and then use a technology known
as Live Upgrade to copy the already installed version of Solaris and then upgrade that copy, all
while the original installed version of Solaris remains running and usable for normal operation.
Live Upgrade is generally the preferred option if the system has sufficient free disk space to use
it because system downtime is minimized and the impact of a failed upgrade or any other seri-
ous problem with the new build is minimized, as the system can always be booted back into the
original image should it be necessary. SXCE also supports both forms of upgrade from older ver-
sions of Solaris, not just older releases of SXCE.

& Downloads of Solaris Express Community Edition are available from http://
“ opensolaris.org/os/downloads.

Schillix

Schillix holds a special claim to fame as the first OpenSolaris distribution created from the
OpenSolaris source code. As its creators, Jorg Schilling and Fabian Otto, proudly note on the
project home page (http://schillix.berlios.de), the first version of Schillix was released
just a week after the public opening of the OpenSolaris community in June 2005. Truth be told,
they didn’t do all of the work in a week; a closed pilot of the OpenSolaris community enabled
them to get a head start on building this new distribution. Nonetheless, Schillix rightfully
deserves respect for blazing the trail for other non-Sun distributions.

Schillix is a pure open source operating system, consisting entirely of open source components.
It is distributed under a license that allows free redistribution, and is available only for the x86
platform.

Schillix is distributed as a downloadable DVD ISO image, which boots into a text-based live
DVD environment, enabling users to test drive the distribution without any more commitment
than burning a DVD; even less than that is possible by booting the ISO image under some other
operating system using any one of a number of virtualization tools.

& A live CD or live DVD is a CD or DVD that’s designed to boot into an operating
W% system and run directly from the CD or DVD without altering the computer’s hard
drive. A live CD is often used to demonstrate an operating system to new users, usually with
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an installation option, but a live CD is also very useful as a toolkit for recovery and repair of sys-
tems that have been damaged in some way that makes them unable or unsafe to boot.

Schillix uses the SVR4 packaging system, just as Solaris Express does, but it adds the pkg-get
utility developed by the Blastwave project. This utility allows for easy, automatic download and
installation of software from an extensive repository of pre-built open source software packaged
by the Blastwave project maintainers for Solaris and OpenSolaris. Thus, while the system
provided on the Schillix media is fairly basic, it is easily extended to include a full desktop such
as GNOME and myriad other utilities. The other unique attribute of Schillix is that it includes
Jorg’s own set of utilities, which have been developed over the last 20 years; these include the
popular CD authoring tools mkisofs and cdrecord, also provided in the other OpenSolaris
distributions and many Linux distributions, as well as improved versions of utilities such as
make, tar, and cpio.

Schillix has been updated irregularly, as its developers find the time to make improvements. It
remains a very basic distribution, lacking an integrated desktop environment and requiring a
complex, manual installation process. It’s probably best suited to users who like to get under
the hood and build a distribution from the ground up, understanding how the pieces are put
together.

In addition to being the first non-Sun distribution, Schillix was also the first OpenSolaris distri-
bution to provide a live CD, a feature that is now common across distributions.

BeleniX

BeleniX is another pure open source distribution based on the OpenSolaris source code. Led by
Moinak Ghosh, BeleniX was created primarily by a group of engineers in India, many of whom

are Sun employees. Because it is substantially a product of India, this distribution has achieved

quite a bit of local notoriety, made minor celebrities of its developers, and created a lot of inter-
est in OpenSolaris among that country’s technology community. As with Schillix, BeleniX has a
license that allows for free redistribution, and it is available only for x86 platforms.

From a technical standpoint, BeleniX has made a substantial contribution to advancing the
OpenSolaris technology. While Schillix created the first OpenSolaris live CD, BeleniX took the
basic concepts and developed them to the point where its performance and functionality rival
the well-known Linux live CD distributions. BeleniX developed the techniques used to compress
the CD’s contents and optimize its layout to achieve acceptable boot performance. The team also
adapted the live CD to run from a USB flash drive and developed session persistence for it. With
this capability, you have the option of carrying around a fully usable OpenSolaris computing
environment without carrying a computer.

Additionally, BeleniX was the first to offer the KDE and Xfce desktops as part of an Open-
Solaris distribution. The BeleniX team has also been a substantial contributor in porting
additional desktop technologies from the GNOME and X.Org projects to OpenSolaris, helping
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OpenSolaris to take advantage of developments in those communities in as timely a fashion as
Linux distributions. Finally, they've pioneered the porting and development of disk partition
management tools from Linux and BSD distributions, enabling a simpler experience in installing
OpenSolaris alongside other operating systems on a single system.

BeleniX continues to be under active development, releasing updates periodically. Because many
of the technologies developed in BeleniX are being incorporated into the OpenSolaris code base
as part of the development of the OpenSolaris distribution, the focus of BeleniX has shifted
somewhat to being a KDE-oriented derivative of the OpenSolaris distribution. The collaboration
across these distributions is only natural given the strong shared Sun engineering influence, and
should help accelerate the evolution of OpenSolaris technologies. 1f your preferred desktop on
other operating systems is not GNOME, you may well find that BeleniX will be your favorite
OpenSolaris distribution.

NexentaCore

NexentaCore is an OpenSolaris distribution with a substantial twist: It fuses the OpenSolaris
kernel and utilities with the GNU Project’s utilities (these are available in the Solaris and
OpenSolaris distributions, but not as complete a set or as the default environment) and the
Debian Linux-developed packaging technology APT (Advanced Packaging Tool). The result is a
rich operating system that feels in many ways like a version of Ubuntu Linux (the best-known of
the Debian-based Linux distributions and the direct source for many of the packages available
for NexentaCore), but with the underlying core of OpenSolaris. NexentaCore is available only
for x86 platforms, and is provided with a license that allows for free redistribution.

The Nexenta team initially produced a desktop-oriented distribution known as NexentaOS,

but has subsequently focused on the NexentaCore distribution, which is designed to be a

stable foundation platform on which specialized distributions can be built. The team put this
foundation to use in building a storage appliance (called NexentaStor) that leverages ZFS and the
attributes of NexentaCore to provide a very simple yet powerful NAS (network-attached storage)
appliance.

Although NexentaCore is itself a small distribution (a single CD) with low memory requirements
(256MB is the stated requirement), the distribution’s decision to leverage the Ubuntu software
repository makes a large selection of software available. The system installed from the CD boots
to a text console, from which adding software is a simple matter of using the aptitude com-
mand to select and install packages from the Nexenta repository. The APT system automatically
resolves dependencies of packages that are selected for installation and includes them in the
process.
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Beyond these standard capabilities of APT, the Nexenta team has integrated the power of the
ZFS file system. NexentaCore uses ZFS as its default file system for the installed operating
system; and by melding it with APT, it has provided something that the Debian family of Linux
distributions lacks: a truly safe software upgrade and rollback paradigm, enabling users to back
out of a failed or unsatisfactory upgrade and return to a known state with a new command
called apt-clone. This is conceptually similar to the Live Upgrade capability described earlier
for Solaris Express, but based on the ZFS file system, simplifying and speeding up many aspects
of the implementation. A substantial benefit of this capability is that it frees users to experiment
with newer versions of software, safe in the knowledge that recovering from failure will be
simple and straightforward. As the Nexenta APT repositories provide stable, testing, and unstable
versions of packages, users have a great deal of opportunity to take advantage of apt-clone.

Another interesting attribute of the NexentaCore distribution is an outgrowth of the hybrid
GNU/OpenSolaris environment it provides. The default installation places the GNU utilities in
the normal executable search path, which means that the command-line environment generally
feels quite Linux-like. However, for those who prefer a more traditional Solaris feel, that's easily
available by merely setting the SUN_PERSONALITY environment variable to 1, and the view
presented to the user switches seamlessly to one familiar to Solaris users. It’s a clever way to
provide both choice and compatibility.

NexentaCore has an active development community and is updated frequently. Outside of the
Solaris Express and OpenSolaris distributions, it is probably the most polished of the OpenSo-
laris distributions, feeling like a professional product. If you have experience with Debian Linux
distributions, starting with NexentaCore may help you make a very smooth transition to the
OpenSolaris community.

i More information on NexentaCore, including downloads, can be found at
http://nexenta.org

MartUX

Created by Martin Bochnig, MartUX is, first and foremost, a distribution designed to appeal to
SPARC devotees because it was the first non-Sun distribution available for SPARC. One capa-
bility it provides that is not available with Solaris Express is that it can run on systems with the
original UltraSPARC 1 64-bit processor, found in systems such as the now-ancient Ultra 1 work-
stations. MartUX runs on these processors in 64-bit mode, which Sun never supported. Note
that 32-bit SPARC support is not available in the OpenSolaris kernel sources.

Providing an open source distribution on SPARC turns out to be a fairly difficult problem

to solve. That's because the drivers for most SPARC graphics devices are proprietary to Sun
and not available for free use by other distributions. In several cases, the X.Org X server can
support these devices as strictly X Window displays, but the system must be run with a serial
console. Partly because of this issue, MartUX remains a prototype, primarily of interest to
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those who would like to hack on a very rough distribution and figure out how it works, or
die-hard owners of old SPARC systems who would like to use them with the latest OpenSolaris
technologies. This prototyping has proven valuable to the broad community, however; the
significant effort Martin Bochnig has invested, for instance, has resulted in much better driver
support for the SPARC graphics chips in the X.Org X Window server. He has also been a major
contributor to the Fully Open X project, doing the majority of the work required to port it to
SPARC hardware. These changes are important because supporting SPARC in the X.Org server
enables SPARC to benefit much more completely from the work done in the X community.

The MartUX DVD image makes use of the compression and 1/O scheduling enhancements
developed by the BeleniX team for their live CD, and thus provides reasonable performance. The
DVD image also includes a large collection of software from the Blastwave project repository. In
addition to the SPARC focus discussed here, MartUX is available for x86 systems as well, but
x86 users new to OpenSolaris will likely find the other distributions discussed in this chapter an
easier introduction to the OpenSolaris community. Recently, Martin and others have launched a
derivative of MartUX and the OpenSolaris distribution called Natamar, which appears to be the
project’s focus of development.

MilaX

One of the newer OpenSolaris distributions is MilaX. Created by Alexander Eremin, this
distribution fills a previously unexplored niche in the OpenSolaris universe, that of the minimal
distribution. Modeled on small Linux distributions such as Damn Small Linux, MilaX provides
the core OpenSolaris technology in a more lightweight wrapper, eschewing the fully integrated
desktop environments such as GNOME and KDE for a simpler X Window desktop and a more
restricted selection of included software. MilaX supports both x86 and SPARC; the SPARC
edition does not provide a graphical desktop at this writing. All of the MilaX software is freely
redistributable.

MilaX’s approach to constructing a distribution offers two principal benefits:

B A small initial download

B Support for lower-cost hardware with limited memory capacity
That makes it a great “starter” distribution for those new to OpenSolaris. It’s also especially well
suited for running in a virtual machine such as VMware or VirtualBox. Finally, it’s a handy

rescue CD for use when you have trouble booting your system’s installed OS, because it boots
quickly with limited resource requirements yet includes a rich set of system tools.

MilaX is freely redistributable, and has been regularly updated since its initial release in early
2008. You can download it from its website at http://milax.org.
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OpenSolaris

The last distribution from the OpenSolaris universe to be discussed here is OpenSolaris. Initially
known as Project Indiana, OpenSolaris is an aggregation of the core OpenSolaris code with
several key projects that are under development. OpenSolaris is heavily supported by Sun’s
engineering organization, and it is expected to provide the basis for the successor release to
Solaris 10.

History of the OpenSolaris distribution

The core idea of the OpenSolaris distribution is that, while Solaris is in many ways the most
advanced UNIX operating system, some aspects of it had become quite dated. For example,
the software packaging system, known as SVR4 Packaging, was state-of-the-art 20 years ago
but has become outdated. It not only lacks enhanced features such as network repositories
that are common in newer packaging systems, but also has become increasingly creaky as its
implementation was modified to deal with features such as Zones that extended it in ways that
its original design could not possibly have anticipated. The patching system layered on top of
SVR#4 Packaging suffers from similar issues.

Similarly, the installation software was based on a design from the early 1990s; and the user
experience, along with the look and feel, were based on network and GUI technologies, as well
as assumptions about users, that are no longer in touch with current trends. Requiring users

to download an image that was several gigabytes in size, burn it to media, and then install it
to a system before they could even try out the software meant that only the most devotedly
interested users would ever run Solaris. Potential users who had heard about it from the media
or a friend would usually not make it to the point where they’d actually install Solaris and
become users. Having to repeat the experience to obtain newer versions only added to users’
frustration. Simpler ways to obtain, try, and use OpenSolaris were necessary if the technology
was to attract a growing number of users in the increasingly crowded open source operating
systems market.

In addition, because many utilities had only been updated for conformance to standards such

as POSIX, the command-line user environment felt much like a relic of the UNIX of the early
1990s; meanwhile, those same utilities on Linux and BSD platforms had gained additional fea-
tures. All told, users who were new to Solaris would often describe the experience as familiar,
but uncomfortable, in the way that going back to one’s childhood neighborhood may be familiar
yet uncomfortable because none of the people you remember live there anymore.

By mid-2007, OpenSolaris-sponsored projects to address many of these shortcomings in Solaris
were starting to bear fruit in the form of working prototypes that were functional enough to use
within the development community. However, the projects were still far from integrating into
the Solaris Express releases. Additionally, a rising issue within the OpenSolaris community was
user confusion about distributions; many users from Linux backgrounds come to the Open-
Solaris community site expecting to download a distribution called OpenSolaris, but instead
find the list of distributions discussed earlier in this chapter. Because the names are mostly
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unfamiliar, and many users have a difficult time understanding the differences between the
distributions, they were left to choose between Solaris Express, with Sun’s name behind it, and a
cast of other distributions they’d likely never heard of before. No matter what choice they made,
they were likely to find a less comfortable and polished system than the most popular Linux
distributions, and were often left decidedly unimpressed with OpenSolaris.

To address these problems, Sun decided to release a new distribution with the installation,
packaging, and modernization technologies that were under development. By using the Open-
Solaris name for the released distribution, new users to the community would find what they
were looking for: a distribution named OpenSolaris that represented the work of the community
with a polished, easy-to-use, and supported product that would make their introduction

to the community as simple as possible. The goal was to establish this distribution as the
reference for the community, and to base the next version of Solaris on it, effectively turning the
relationship between OpenSolaris and Solaris inside out. The use of the OpenSolaris name for
the distribution proved to be a controversial topic within the community, due to the trademark
restrictions that Sun had originally placed on the name. This confusion spawned a project to
develop trademark guidelines that allow the use of the OpenSolaris name by other distributions.

As mentioned earlier, this effort was initially established under Project Indiana to distinguish it
from the Nevada code name already in use for the next version of Solaris. The first preview of
OpenSolaris was released in October 2007, and it was a solid success, with thousands of down-
loads in the first week; a second preview was released in February 2008. The first supported
release arrived in May 2008, and the second in November 2008, with subsequent releases
expected approximately every six months. Sun offers paid support by its support organization
for these OpenSolaris releases; see the opensolaris.com site for information on the support
products. Between each release, development builds are made available, approximately every two
weeks, in synchronization with SXCE builds. The OpenSolaris distribution is provided under

a license that allows for free redistribution. The releases so far support only x86 systems, but
SPARC support is anticipated in 2009.

What OpenSolaris includes

OpenSolaris consists of open source and a few freely redistributable binary components
produced by the various OpenSolaris communities and projects. It includes the following major
components:

B The OpenSolaris kernel, networking, and command-line utilities from the OS/Net com-
munity. The OpenSolaris distribution’s version of this code is virtually identical to that
included in the other distributions.

M The X Window System from the Fully Open X (FOX) project. The OpenSolaris version
differs from the version used in Solaris Express, which includes drivers and other legacy
components that are not available under redistributable license terms.

B The GNOME desktop from the Desktop community. The primary difference between the
OpenSolaris version of GNOME and that used in Solaris Express is the removal of Sun
proprietary branding and trademark elements.
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The Image Packaging System (IPS) from the project of the same name
The installer from the Caiman project

The live CD technology from the Live Media project

Modifications to the default user environment designed to increase familiarity for users
coming from Linux or BSD distributions

These technologies and projects are discussed in more detail later in this book. The remainder of
this chapter focuses on how to download and install OpenSolaris.

¢ Chapter 3 provides a crash course in using OpenSolaris once you have it installed.

Will OpenSolaris run on my hardware?

Because of the tremendous diversity of x86-based computer systems that are available, one
common question is whether a particular operating system can support your hardware. The
last thing you, as a user, want to do is spend a great deal of time or money downloading or
purchasing an operating system only to find out that it won’t run on your computer.

If you already have the OpenSolaris live CD, perhaps the best answer is to just stick it in

your system and try to boot from it. There really is nothing like just trying out the system to
determine whether it works. In addition, the CD includes the Device Detection Utility; if you
boot the CD and run this utility, it provides a complete report of the OpenSolaris device support
for your system. If you don’t have the media yet, aren’t sure that OpenSolaris is likely to run

on your system, and would like to have an answer before you spend the time downloading
OpenSolaris, then consider the following options to perhaps save some time.

First, if you have virtual machine technology such as VirtualBox or VMware available, you'll
likely find that OpenSolaris runs satisfactorily with it. In the case of those two virtual machine
technologies, this book walks you through the process of creating an OpenSolaris virtual
machine, booting, and installing within it. Other virtual machine technologies such as Parallels
for Mac OS, Xen, or KVM also generally support OpenSolaris guests.

The next best option is to use the Sun Device Detection Tool, which provides you with a
custom and complete answer for your specific system. This tool does have some limitations,
however, that can prevent it from being an answer for everyone. First, you must be running
Windows (2000, 2003, XP, or Vista), a Linux distribution with a 2.6 kernel, or Solaris. You
must also have a Java Runtime Environment (JRE) installed on your system. If you meet those
two requirements, then running this tool will, in just a couple of minutes, give you a detailed
list of the hardware devices on your system, and an answer as to whether OpenSolaris has the
drivers necessary to support your hardware. It can be time well spent because its device database
is updated frequently and includes pointers to third-party drivers that may not be included in
the OpenSolaris media (for licensing or other reasons).

If you can't use the Device Detection Tool, then the traditional answer to hardware support
questions has been lists of compatible systems and components that you can search. That can be
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a tedious process and requires you to know a great deal about your system’s hardware, including
technologies, manufacturers, speeds, and so on. It’s probably best regarded as your last resort in

terms of determining system compatibility, but it can be a useful resource if you're in the market
for a peripheral device and the vendor doesn’t necessarily specify support for OpenSolaris.

T & The Sun Device Detection Tool can be accessed at
S http://sun.com/bigadmin/hcl/hcts/device_detect. jsp.

Sun’s hardware compatibility list for the Solaris family of operating systems is available on the
BigAdmin website at http://sun.com/bigadmin/hcl/search.jsp.

Downloading OpenSolaris

The first noticeable difference between OpenSolaris and Solaris Express is how you obtain

it. OpenSolaris is distributed as a single live CD image, in the manner of Ubuntu Linux;

the live CD’s design and implementation are based on the work pioneered in the Schillix

and BeleniX distributions. Thus, as with any live CD, you have the possibility of a complete
try-before-you-buy experience, which enables you to evaluate how well the distribution works
on your system before the potential disruption of making any commitment of disk space to it.
In addition to the live CD, OpenSolaris can be installed over a network using an automated
installer. This technology is under development as of this writing, so you should consult the
OpenSolaris documentation for information.

Beyond the image format, the other immediately noticeable difference from Solaris Express is
that OpenSolaris is available from sites other than Sun’s own download center. You'll find it
mirrored at a number of other sites for traditional HTTP and FTP downloads, and you can also
obtain it through the BitTorrent file-sharing system. These new options are possible because
OpenSolaris contains only software that’s licensed to be freely redistributed. Conversely, Solaris
Express contains a number of components that are under more restrictive licenses that may
require Sun to maintain distribution records for the software, and therefore can’t be made
available other than through Sun’s download center.

N r ¢ Download locations for OpenSolaris are available on the distribution’s website:
S http://opensolaris.com.

You can use your web browser or programs such as wget or ftp to retrieve the image from
the URLs provided on the download page. Downloads through BitTorrent are also provided.
Once you have downloaded the CD ISO image for OpenSolaris, you have several options for
trying it out.

If you have a virtual machine technology available that can host OpenSolaris as a guest operating
system, then you often can use the ISO image directly to boot OpenSolaris in a virtual machine;
this generally does not require actually burning the ISO image to media. Later in this chapter
you will walk through the booting and installation process using VMware. Chapter 22 explains
how to install OpenSolaris as a VirtualBox guest.

The traditional approach, which is always possible, is to burn the ISO image to a CD and then
boot your system from it. On most Linux and OpenSolaris distributions, selecting the ISO image
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file from the desktop’s file browser program (such as Nautilus in GNOME desktops) presents a
menu option to write the ISO image to a disc; select it and follow the prompts, if any. From a

shell command prompt, most distributions provide the cdrecord command for burning CDs.

For example, assuming the OpenSolaris ISO image is named OpenSolaris.iso, the following
procedure would discover the correct device number for the CD drive and then use that device
number to burn the CD:

$ cdrecord --scanbus

scsibus9:
9,0,0 900) 'MATSHITA' 'DVD-RAM UJ-841S ' '1.40' Removable CD-ROM
9,1,0 901) *
9,2,0 902) *
9,3,0 903) ~*
9,4,0 904) *
9,5,0 905) *
9,6,0 906) *
9,7,0 907) ~*

$ cdrecord dev=9,0,0 OpenSolaris.iso

On Windows and Mac systems, use your favorite CD burning program to burn the CD
image; if it offers the option to burn a bootable CD, rather than a data CD, be sure to burn a
bootable CD.

Booting the OpenSolaris CD

Now that you've burned the OpenSolaris ISO image to CD, the next step is to boot it and try
it out. Shut down your currently running operating system, make sure the OpenSolaris CD is
inserted into your system’s CD drive, and then boot your system. Depending on your system’s
BIOS settings, you may need to press a special key such as Esc or F12 to select the CD, rather
than the hard drive, as the boot device. If you've done that successfully, you should be greeted
with a screen that resembles Figure 2-1.

Sharp-eyed Linux users will recognize this screen as a fairly standard GNU GRUB (GRand
Unified Bootloader) menu. OpenSolaris uses GRUB as its primary boot loader, which enables its
boot menu to also directly boot Linux and BSD operating systems and indirectly boot Windows
by invoking the Windows boot loader.

% If you plan to install OpenSolaris as a dual-boot system with another operating

“ system that also uses GRUB, save your existing GRUB menu configuration to a USB

memory stick that has a DOS file system format, or print it out, so that you can merge the menu

entries from the other operating system with the OpenSolaris GRUB menu after you have finished
installing OpenSolaris.

Selecting the first item in the boot menu boots OpenSolaris to a graphical desktop. This is
usually the option you'll want. If you don’t want a graphical desktop for some reason (this
may be necessary if the graphical desktop is unable to automatically start on your system),
select the second item, which boots OpenSolaris to a text-only mode, where you can log in.
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The Boot from Hard Disk item on the menu merely skips attempting to boot from the CD and
instead starts the boot process from your system’s primary hard disk. The final two menu items

enable assistive technology for those with visual impairment; see the OpenSolaris website for
information on their use. The remainder of this walk-through assumes you've chosen the first
item and will boot to a graphical desktop.

FIGURE 2-1

Boot screen from the OpenSolaris CD
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Using GRUB with OpenSolaris

o boot any operating system on the x86 processor platform, a relatively simple program called
Ta boot loader is required to enable the transition from the machine’s BIOS to the operating
system kernel. For OpenSolaris, and many Linux distributions, GRUB serves as that boot loader.
The OpenSolaris version of GRUB contains all of the features of the GRUB version used in Linux
distributions, but it also contains several extensions that are not available in the main GRUB
distribution. The extensions that are of the most interest to users of OpenSolaris distributions are
related to automatic selection of 32- or 64-bit kernels, and support for ZFS. You normally do not
need to deal with these extensions directly; selecting the desired entry from the main GRUB menu
is usually all you need to do to boot OpenSolaris.

An example OpenSolaris GRUB menu entry would be as follows:

title OpenSolaris 2008.11 snv_100 X86
kernel$ /platform/i86pc/kernel/$ISADIR/unix -B $ZFS-BOOTFS

continued
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continued
module$ /platform/i86pc/$ISADIR/boot _archive

Automatic selection between 32- and 64-bit kernels is enabled by two new commands, kernel$
and module$, that extend the standard kernel and module commands, respectively. The new
commands can expand simple tokens within the parameters supplied to them, whereas the standard
commands do not. The OpenSolaris menu items contain a $ISADIR token that expands to amd64
on 64-bit systems, and to the empty string on 32-bit systems, meaning that the same menu entry
can be used on either type of system and automatically select the correct kernel. If you need to boot
a 64-bit system in 32-bit mode for some reason, use the GRUB command-line editor and remove
the $ISADIR tokens and you’ll boot a 32-bit kernel.

ZFS boot support is flagged by providing the -B $ZFS-B00OTFS option to the kernel or kernel$
commands. In the preceding example, GRUB would locate a ZFS pool on the first disk in the system
and read the pool’s bootfs property to determine the name of the ZFS dataset within which the
kernel (and module) can be found. You can also use another new GRUB command, bootfs, to
specify the ZFS dataset; usually this is necessary only if you need to boot from a different dataset
temporarily for system maintenance or repairs.

Because these extensions are not likely to be present in the version of GRUB supplied with Linux
distributions, always use the version of GRUB supplied with OpenSolaris as your primary system
boot loader if you have multiple operating systems installed on your system. See the installation
walk-through in this chapter for tips on merging Linux and OpenSolaris GRUB menu entries.

For basic documentation on the common features of GRUB, refer to the GRUB project’s website,
http://gnu.org/software/grub/grub-Tegacy.en.html.

After the OpenSolaris kernel begins running and starts loading the system services, you'll be
prompted to select the keyboard layout used by your system. Figure 2-2 shows an example of
the display for selecting the keyboard. You need only enter the number corresponding to your
keyboard’s layout. US-English is the default value.

After you select the keyboard layout, OpenSolaris next prompts you to select the language for
the desktop from the list of languages supplied on the CD. Once a language is selected, Open-
Solaris completes booting, auto-configures the X Window graphics system, and starts a GNOME
desktop. At this point, you can try out the desktop, viewing the menu items and starting and
running applications. Chapter 3 presents a crash course in OpenSolaris, and Chapter 4 presents
an overview of the OpenSolaris desktop if you'd like to explore it more deeply. If you have a
network interface connected, either wired or wireless, OpenSolaris will attempt to automatically
configure it, although the success of this depends on OpenSolaris having a device driver avail-
able for your system’s network hardware.

= See Chapter 9 for more information about OpenSolaris networking.
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Installing OpenSolaris

Once you've booted OpenSolaris to the desktop as described in the previous section, double-
click the Install OpenSolaris icon to start the installer. Figure 2-3 shows the first screen of the
installation.

This welcome screen provides a link to the release notes for the distribution. Clicking the link
launches the Firefox web browser to load the release notes page from the OpenSolaris website,
so you need network access to display the notes. Selecting Next advances the installer to the
disk selection and partitioning screen.

Disk partitioning in an OpenSolaris installation

The Disk screen (see Figure 2-4) displays the disks found on the system, including any remov-
able hard disks or USB disks.

Note that the recommended and minimum sizes for installation are displayed at the very top.
The recommended size is typically several times larger than the minimum size. Its value is
chosen to allow for local storage of your own files, installation of additional software after the
operating system installation, and later updates of OpenSolaris. Updates of OpenSolaris require
additional space because the update process always uses a copy of the OS for its work, enabling
you to roll back to a prior version if the update is a problem for any reason.

dr)@l~ene)d e See Chapter 6 for more details on updates and OpenSolaris software management.
CROSS-REE : P ' °

Selecting a size smaller than what is recommended may leave you with insufficient space for
your work or prevent you from updating OpenSolaris later. Unless you're fairly experienced
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in operating system installations, using the recommended size generally gives you the most
satisfying result.

FIGURE 2-3

Initial screen of the OpenSolaris installation
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Release Notes

The disks are displayed across the top to enable you to select the disk that will be used for
installation. Point your mouse at a disk in the display to get a more detailed description of

it, including manufacturer and device names, which sometimes can be necessary to help
differentiate between similar disks. After you choose the disk you want, use the bottom half
of the screen to select the partition to use. Partitioning is a means of parceling out portions of
the disk for different uses; for example, to have multiple operating systems (perhaps Windows,
Linux, and OpenSolaris) installed and available to boot at different times, you would typically
assign a partition to each operating system. On x86 systems, the partitioning standard allows
up to four primary partitions to be created on each disk; Linux can use multiple partitions for
different portions of its installation, but OpenSolaris can use only one partition on each disk.

Linux users may also be accustomed to installing multiple distributions in dif-

“ ferent partitions. However, the limitation of using only one partition on each

disk means that you must install multiple OpenSolaris distributions into the same partition,
allowing them to either share the same ZFS pool or use different slices within the partition. This
book does not cover this topic, so see the OpenSolaris Installation and Packaging community,
http://opensolaris.org/os/community/install, for information.

If you're going to use the entire disk for OpenSolaris, select the Use the whole disk radio button.
To use only part of the disk and have an available partition entry and space, select Partition the
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disk, and then set up a partition for OpenSolaris to use. Any existing partitions on the disk are
displayed. To assign a partition to OpenSolaris, set that partition’s partition type to Solaris and
select a size at least as large as the minimum size; if you select a partition that is smaller than
the minimum size, you cannot proceed beyond this screen.

FIGURE 2-4

Disk selection and partitioning screen
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If you don’t have a partition of at least the minimum size available, you may need to shrink the

size of one or more existing partitions. Two types of repartitioning can be done: destructive and
non-destructive.

i The OpenSolaris installation program can do only destructive repartitioning. It warns

you if any changes you make to the partitioning will result in a destructive change to
an existing partition.

Destructive partitioning means that if you change the size of a partition, the existing contents of

that partition (and possibly others that are adjacent to it on the disk) will no longer be readable.
Non-destructive repartitioning requires more advanced software that can understand the format
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of the file system contained within the partition and shrink it into a smaller space without losing
any files, allowing the free space to be reallocated to another partition.

If your system only has Windows on it, there will typically be a fairly large amount of empty
space on the Windows partition that can be reclaimed and used for other partitions because

in most installations the entire disk will have been allocated to Windows. Windows Vista

offers a built-in utility to shrink its partitions, whereas older versions of Windows require a
third-party tool. If you have spare space from a Linux distribution installation, your distribution
may well include the GNU parted utility and possibly the graphical interface for it, known as
GParted. Otherwise, you can download it from http://gparted.sourceforge.net. The
latest versions of the GParted live CD can also safely shrink Vista partitions — and usually more
completely than Vista’s own shrinking tool.

& For instructions on shrinking Windows Vista partitions, search for ““Can I repartition
* my hard disk?”” at http://windowshelp.microsoft.com.

GParted doesn’t list OpenSolaris or Solaris as a partition type that it will create, so any new parti-
tions you create for OpenSolaris using GParted should be created as unformatted; the OpenSolaris
installer will format the partition correctly once you select it.

You may notice that, unlike many other operating systems, the OpenSolaris installer allows you
to select only a single partition for OpenSolaris, and doesn’t require you to specify the file sys-
tems to associate with partitions. That's because OpenSolaris uses the ZFS file system for all of
its storage, and ZFS uses a pooled storage model. The partition you create is set up as a pool,
and the OpenSolaris installer creates a number of ZFS file systems in it to install the operating
system. You can easily create additional file systems for your data within that pool at any time
after OpenSolaris is installed and running.

= See Chapter 8 for a detailed discussion of ZFS.

Configuring the time, time zone, language, and users

Once you've provided the necessary disk space for the OpenSolaris installation, you need to
configure the system’s clock and time zone on the Time Zone, Date and Time screen (see

Figure 2-5). To specify the time zone, either click on the appropriate location on the map that’s
displayed or select by region and location from the menus on this screen. If the date and time
require adjustment, you can either enter them directly into the text fields or use the spin buttons
next to the text fields to adjust their values. Clicking Next immediately sets the system time to
the selected value.

On the installer’s next screen, Locale, you select the default language for the installed system, as
shown in Figure 2-6. Here you have the opportunity to select a language on the installed sys-
tem other than the one used during installation; the default value selected in this screen is the
language you selected during the CD boot process.

The next screen, Users (see Figure 2-7), enables you to set the system’s root password, create a
user account, and provide the name by which the system will be known.
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Set the time and time zone.
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The user account that you create during installation is a special account that has administrative

access to the computer, provided by the OpenSolaris security technology known as Role-Based

Access Control. Create a user account here and OpenSolaris also makes the root account a role,
which is a special type of account that is not available for login. This provides an extra layer of
system security by ensuring that only user accounts with administrative access can become root.
You can choose to not create a user account during installation, in which case the root account

is not made into a role and is available for direct login.

F See Chapter 3 for a quick introduction to, and Chapter 11 for detailed information
“% on, Role-Based Access Control and other OpenSolaris security features.

Experienced UNIX and Linux users will note that there’s no option at installation to
¥ set details of the user account, such as the user ID number or group memberships.
If necessary, these values can be modified after installation using the desktop administration tools
included with the system. Chapter 3 discusses this and other basic administration topics.
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The computer name set on this screen is the name by which the system knows itself, and the
name it advertises on the local network to other systems that are running discovery protocols
such as multicast DNS (see Chapter 9 for more on OpenSolaris networking). The name selected
is not registered into centralized naming services such as DNS or LDAP; such registrations must
be made by the administrators of those services.

FIGURE 2-6

Select the language support.
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Click Next to display the Installation screen. Here you review the selections you’ve made before
starting the actual installation process. The screen looks much like the one shown in Figure 2-8.

When you're satisfied with your selections, click Install to start the installation process; prior to
this point no changes have been made to your system’s permanent storage. Once you initiate
the installation, a progress screen displays as the installation proceeds. On most systems the
installation process takes roughly twenty minutes. During this time, the installer is copying

the contents of the live CD onto the provided disk partition. When the installation process
completes, the Finish screen is displayed, indicating the success or failure of the installation.
The installer also offers the option to display the installation log, should there be a problem
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or you're just curious about what happened during the installation. The installation log is also
saved on the installed system at /var/sadm/system/lTogs/install_1og, should you need
to reference it later. Clicking the Reboot button causes the system to reboot and start using
OpenSolaris.

FIGURE 2-7

Create root and user accounts.
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Troubleshooting installation

There are several points at which you might run into trouble installing OpenSolaris. The first
potential problem can occur when booting the OpenSolaris CD. As mentioned in the instruc-
tions for booting the CD, you need to select the CD as the preferred boot device in your BIOS.
Most BIOSs allow a one-time selection by pressing a key at boot and then selecting from a menu
using the arrow keys on the keyboard, but you may have to go into your BIOS menu to ensure
that booting from CD is enabled, and that it is preferred over the hard disk. Unfortunately, the
method for doing this varies across BIOS implementations, so we can't offer general instructions,
but your system’s manuals should be helpful in sorting this out.

If you're trying to boot from the CD but it fails to bring up the GRUB menu shown earlier
in this chapter, you most likely have a bad CD. This happens much more often than you
might think — burning CDs is notoriously prone to failure. First, ensure that the ISO image
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you downloaded wasn't corrupted by comparing its checksum with the one published on the
download site. To help make the CD burning process more reliable, try to leave your computer
alone while it’s burning the CD, as it is necessary to send data to the CD at a constant rate
during the burning process. If you've tried both of those suggestions and still have unreliable
results, you might check your computer vendor’s support site for BIOS or firmware updates
(bugs in CD and DVD drives are not at all unheard of).

FIGURE 2-8

Review your choices.
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If you do get the GRUB menu and can start booting OpenSolaris but it hangs while booting and
doesn’t present a login prompt, you may have a device driver problem. Consulting the release
notes page for OpenSolaris, which are linked from the download page, should be your first

step in case there’s a known issue and solution that matches your problem. If there isn’t such

a release note, consulting the support forums on opensolaris.com or sending mail to the
OpenSolaris help mailing list, opensolaris-help@opensolaris.org, should connect you

to experts who can assist in diagnosing your problem. To get answers as quickly as possible,
send as much detail as you can about the type of system, the version of OpenSolaris, and any
messages displayed on the screen.

OpenSolaris may manage to partially boot but run into a problem that it prevents it from
completely booting. At that point it displays a message that says “Requesting System Main-
tenance Mode” and then prompts you for the root password. The CD’s root password is
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opensolaris, so enter it and you should be logged in as root to a shell prompt. From there
you're generally troubleshooting why a critical service did not start, which requires you to work
with the Service Management Facility (SMF) to diagnose the problem.

i See Chapter 13 for instructions on how to troubleshoot with SMF.

A graphical desktop failing to display usually points to problems with the X Window system
display drivers, which may not support your system’s display hardware, especially if it’s very
new or very old. Because diagnosis is difficult and the supported devices change very frequently,
the best advice in this situation is to contact opensolaris-help@opensolaris.org with the
details of the problem.

Finally, if you have a graphical desktop that looks correct but you are having trouble running
the installation program, you can first consult the installation log, which can be found at the
pathname /tmp/install_log during the live CD session. Consulting the release notes may
also be helpful here, but your best source of help at this point is likely to be the Installation
and Packaging community, http://opensolaris.org/os/community/install, which will
connect you directly with the developers of the installation software.

Booting OpenSolaris

Assuming your installation of OpenSolaris succeeded, a reboot of the system brings up a GRUB
menu with graphics similar to the menu shown on the live CD. If it brings up the live CD’s
menu again, this means the system’s device boot order is choosing the CD first, and you should
either eject it and reboot the system, or select the Boot from Hard Disk menu item, which takes
you to the hard disk’s GRUB menu. Its first, and default, selection is to boot OpenSolaris; if you
select it or allow it to time out, it will boot OpenSolaris for the first time. During this initial
boot, the operating system may take a moment to configure various system services, but before
long you are presented with the login screen (see Figure 2-9).

Enter the username and password that you provided to the installer. You'll be presented with a
GNOME desktop that is virtually identical to the desktop on the live CD. Once you've reached
the desktop, the first thing to do is start a terminal window (select Accessories» Terminal on the
desktop menu) and ensure that your system’s software database is updated. In the terminal, type
the following:

# pkg refresh
# pkg list -a

FMRI STATE UFIX

NAME (AUTHORITY) VERSION STATE UFIX
BRCMbnx 0.5.11-0.99 installed ----
FSWfontconfig-devel-docs 0.5.11-0.99 known -
FSWxorg-client-docs 0.5.11-0.99 installed ----
FSWxorg-client-programs 0.5.11-0.99 installed ----
FSWxorg-clientlibs 0.5.11-0.99 installed ----
FSWxorg-data 0.5.11-0.99 installed ----
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FSWxorg-devel-docs 0.5.11-0.99 installed ----
FSWxorg-fonts 0.5.11-0.99 installed ----
FSWxorg-headers 0.5.11-0.99 known -
FSWxwpft 0.5.11-0.99 installed ----

FIGURE 2-9

OpenSolaris login screen
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sername: [

The pkg refresh command updates the system’s local catalog of software available in the
repository. Always do this immediately after installation to ensure that the system is synchro-
nized with the software listing from the package servers; youw'll likely want to do it periodically
thereafter so that you're always operating from current information when deciding which
versions of software to install.

# See Chapter 6 for more information on OpenSolaris software management.
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The pkg 1ist -a command displays the list of all software available from the openso-
laris.org package repository, including whether it’s installed on your system (STATE column
value is installed) or available for download and installation (STATE column value is known).
The listing is very long. One package that many users will want to install for working on
documents is OpenOffice; it can be installed with a simple command:

# pkg install openoffice
S8 To locate the package containing a particular program of interest — gcc, for

“ example — use the command pkg search -1r gcc, which searches both the locally
installed software and the package repositories.

At this point, take a breath and congratulate yourself — you've got a running OpenSolaris
system!

& If you have previously saved a GRUB menu configuration from other operating

% systems that are also installed on the system, this would be a good time to use a
text editor such as gedit to merge those entries with the OpenSolaris GRUB menu. You'll find
the OpenSolaris GRUB menu at /rpool/boot/grub/menu.Tst. If you have placed your saved
menu on a USB stick, inserting the stick into a USB port causes OpenSolaris to mount it and
display a Nautilus file browser window with the contents of the stick. The stick will be mounted
under /media.

Installing OpenSolaris in a virtual machine

If you're interested in running OpenSolaris but aren’t ready to make it your primary operating
system, one particularly convenient approach is to use a desktop virtualization program. Another
benefit to this approach is that while OpenSolaris might not directly support your system hard-
ware, the virtual machine that the virtualization program provides generally emulates hardware
that’s well-supported by OpenSolaris.

The virtualization options available to you depend on what primary operating system you

run, but two of the more popular are VirtualBox, which is a free, open source virtualization
program from Sun that runs on nearly every popular desktop operating system, and VMware
Workstation, a proprietary product of VMware, Inc., that runs on Windows and Linux; VMware
also offers its similar Fusion product for Mac OS users.

i = For detailed information on using VirtualBox, including procedures for installing
“ OpenSolaris as a guest in VirtualBox, see Chapter 22.

This section assumes that you already have VMware Workstation 6 installed on your system; if
not, you can obtain it free from VMware’s website: http://vmware.com.

Installing OpenSolaris as a VMware virtual machine is a simple process. Once you've started
VMware Workstation, the main window presents several options. Select Create A New Virtual
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Machine. This starts the New Virtual Machine wizard, which walks you through the process of
creating the virtual machine.

The first screen of the wizard offers two options for creating a virtual machine: Typical and
Custom. The Typical virtual machine has a fairly standard set of devices and configuration
options. For the Custom option, you specify the details yourself. OpenSolaris generally works
well without requiring any custom settings, so selecting Typical is a good choice. The main
reason you might choose Custom is if you know that you want to assign a larger amount of
RAM than the default 512MB that will be assigned, although you can always change this later so
don’t feel compelled to choose the Custom path right now. Click Next when you're done with
this screen.

Now you need to select a type of guest operating system. Choose Sun Solaris; and for the ver-
sion, select either Solaris 10 or Solaris 10 64-bit, depending on whether your host operating sys-
tem is 32-bit or 64-bit (if VMware offered an OpenSolaris option youwd select that, but because
it doesn’t, Solaris 10 is the closest option). Click Next, and then supply a name for the virtual
machine and a location to store its virtual disk image. VMware suggests defaults for these values;
accepting them may be the simplest option.

The next screen requires you to choose the virtual machine’s type of network connection.
Usually either Bridged Networking or Network Address Translation is a good choice; the main
difference is whether you want the virtual machine to obtain its own address from the host
system’s network (bridged networking) or use the host operating system’s network address
(network address translation). If you can easily obtain additional addresses on the host system’s
network, bridged networking may be a more convenient option. If you select “Use host-only
networking” or “Do not use a network connection,” OpenSolaris won't be able to contact any
package repositories and you'll likely find it difficult to install additional software into the virtual
machine.

The final screen of the wizard enables you to specify the size of the virtual disk assigned to the
machine. OpenSolaris recommends at least 8GB of disk space, so select at least that much space
here. Allowing VMware to split the disk into 2GB files enables the virtual machine to be created
more quickly, and generally won't affect its performance, so you may want to select that option.
After you click Finish, VMware pauses briefly while it creates the virtual machine, after which
you are returned to the main window, shown in Figure 2-10.

Your next step depends on whether you are going to boot OpenSolaris from a physical CD or
from a downloaded ISO image file. If you're using an I1SO image file, select the virtual machine
and then select Edit Virtual Machine Settings. In the dialog that is displayed, select the CD-ROM
device in the Hardware listing, select the Use ISO Image radio button, and either enter the path
to the ISO file or use the Browse button to browse the file system to find the ISO image. Make
sure that the Connect at power on box is checked so that the virtual machine can boot from the
virtual CD.

Finally, select the virtual machine in the list and click the Power On button. This should start
the boot process for the virtual machine, and you can now follow the directions from the “Boot-
ing the OpenSolaris CD” section earlier in the chapter.
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Resources

Most of the distributions discussed in this chapter can be downloaded from http://
genunix.org.

Downloads, documentation, and support forums for the OpenSolaris distribution are available at
http://opensolaris.com.

Solaris Express Community Edition can be downloaded from http://opensolaris.org/
os/downloads.

Schillix information and downloads are available at http://schillix.berlios.de.
BeleniX information and downloads are available at http://belenix.org.
Nexenta downloads and documentation can be found at http://nexenta.org.

Information on MartUX and Natamar, including downloads, can be found at http://
martux.org.

MilaX information is available from http://milax.org.
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Summary

This chapter gave you a brief introduction to each of the OpenSolaris-based distributions,
pointing out the unique contributions each has made to the OpenSolaris community and high-
lighting the reasons why you might be interested in each of them. If you chose the OpenSolaris
distribution, you've walked through how to verify that OpenSolaris will run on your system,
how to download the distribution, and how to boot and install it both to physical hardware
and VMware Workstation. You should, at this point, have a working installation of OpenSolaris
and be ready to dive in. Chapter 3 provides a crash course on the most common administration
tasks you might be interested in as a new user. Later chapters explore the various technologies
in OpenSolaris in much greater detail.



t’s time to jump in and start using OpenSolaris. This chapter provides

a whirlwind tour of the OpenSolaris operating environment, includ-

ing an overview of the GNOME desktop and an introduction to the
OpenSolaris command line, focusing on the bash shell. You'll learn how
to leverage the OpenSolaris internationalization features, how to get online,
and how to use the new Image Packaging System to obtain the software
you need. The chapter concludes with an overview of OpenSolaris system
administration. Although this chapter provides an introduction to many
aspects of OpenSolaris, most of the content in this chapter is discussed in
more detail in subsequent chapters.

This chapter is aimed at the beginning and intermediate user. If you're
already familiar with OpenSolaris, you can probably skip it and move right
into Part II of the book. If you're an experienced UNIX or Linux user, you
might still want to skim this chapter to bring yourself up to date on the
differences between those platforms and OpenSolaris.

Note that this chapter, and, with a few exceptions, most of this book,
focuses on the OpenSolaris distribution from Sun. However, much of the
information is applicable to other distributions as well.

Discovering the Desktop

After installing, booting, and logging in to OpenSolaris as described in
Chapter 2, you are presented with a desktop, as shown in Figure 3-1.

This graphical user interface is the GNOME desktop, the default window-
ing environment in OpenSolaris. GNOME should be familiar to
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you if you're coming from Red Hat, Fedora, Ubuntu, or many other Linux distributions. Even if
you've never used GNOME before, it’s pretty intuitive, so you should be able to find your way
around relatively quickly.

FIGURE 3-1

The GNOME desktop is the default windowing environment in OpenSolaris.

Start Here

Overview

As shown in Figure 3-1, the default GNOME interface on OpenSolaris consists of two gray pan-
els lining the top and bottom of your screen, separated by a large blue desktop area.

The panels contain menus, application launcher icons, and other tools. The top panel on the left
contains three menus (Applications, Places, System) and several icons. From left to right, the
icons can be used to launch a file browser, launch the Mozilla Firefox web browser, launch the
Mozilla Thunderbird e-mail client, launch the graphical package manager, open a command-line
terminal, and search for files. Later sections in this chapter cover most of these applications and
tools in more detail. On the right, the top panel contains the battery/AC power indicator, two
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network status monitors, the volume control, and a clock. Mouse-over or click on the various
tools to access more information or change settings.

The bottom panel lists all the open windows, including minimized windows. On the far right,
you can select from among the four different workspaces. The following section on managing
windows provides more detail on these workspaces. The bottom panel also contains a trash can,
which functions similarly to the Recycle Bin on Windows.

The large desktop area is empty in Figure 3-1 except for a few icons, which are present in the
default configuration. However, the desktop can also show application windows, icons for vol-
umes such as CDs and USB sticks, and any files or folders in your Desktop directory.

Managing windows

GNOME on OpenSolaris uses the Metacity window manager. Each graphical user interface appli-
cation that you run opens one or more windows on the desktop. Figure 3-2 shows Mozilla Fire-
fox and a command-line terminal window open.

FIGURE 3-2

GNOME applications open one or more windows on the desktop.
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If you're familiar with Microsoft Windows XP, you should feel right at home. As in XP, each
window has three buttons on the top right that, from left to right, enable you to minimize,
maximize, or close the window. Each window also generally has its own menu for the specific
application.

Only one window at a time has the focus, which means it accepts keyboard input. There are a
few ways you can switch between windows in the default configuration. First, you can use the
mouse to click on the window that you want to have the focus. Second, you can click on the
name of the window you want on the bottom panel. Finally, you can use the Alt+Tab keyboard
shorteut to cycle through the windows. This shortcut is the same as the default in Windows XP.
The button on the far left of the bottom panel minimizes all windows.

= The window focus behavior is configurable. See Chapter 4 for details.

One nice feature of Metacity is the capability to navigate between multiple virtual desktops.
These workspaces give you more desktop space and enable you to run multiple applications
without cluttering up a single desktop with windows. If you're familiar with Macs, workspaces
in GNOME are quite similar to spaces on the Mac. Each of the four boxes at the far right of the
bottom panel represents a workspace. You can switch between workspaces by clicking on the
box of the workspace you want, or you can cycle through them with the Ctrl4+Alt+Right Arrow
and Ctrl+Alt+Left Arrow keyboard shortcuts. You can move applications between workspaces
by clicking and dragging their little icons in the four boxes on the right of the bottom panel.

Navigating files and directories

GNOME uses the Nautilus file browser. To open a file browser, click the File Browser icon on
the top panel or select Places » Home Folder, Places » Desktop, or one of the other locations in
the Places menu. Once you have a Nautilus browser open, you can navigate to any of the direc-
tories on your system. The Nautilus browser is shown in Figure 3-3.

You can drag and drop files between directories (called folders in Nautilus), create new folders,
delete folders and files, and, in short, do pretty much anything you can do in Windows
Explorer.

Media that you've inserted, such as a USB stick or a DVD, will show up both in the Places menu
and as icons on the desktop. You can browse that media with Nautilus by double-clicking the
desktop icon or selecting it from the Places menu. Most media also cause GNOME to automati-
cally open a Nautilus File Browser window.

& Eject CDs and DVDs from the system by right-clicking on the volume’s icon on the

“ desktop and selecting Eject. Similarly, always unmount a USB volume by right-clicking
on its icon and selecting Unmount Volume before pulling out the USB stick. (Chapter 5 covers
peripheral devices in detail.)

Select Places » Network to bring up a Nautilus browser showing file systems that are remotely
accessible, automatically detecting available Samba shares, NFS shares, and even Windows work-
groups.



OpenSolaris Crash Course

FIGURE 3-3

The Nautilus file browser enables you to browse the files and directories on your system.
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Using the Internet

OpenSolaris comes with the Mozilla Firefox web browser, which you can use to browse the
World Wide Web. You can launch it by clicking the Firefox icon on the top panel or by
selecting Applications > Internet > Firefox Web Browser.

&8 OpenSolaris does not include the Adobe Flash player, which is neces-

: i sary for viewing many websites. Install it by navigating your browser to
http://adobe.com/products/flashplayer and clicking the Download Now button.

Select Solaris x86 or Solaris SPARC as appropriate for your platform, and click the yellow “Agree
and install now”” button. Select Save to Disk from the window that pops up and save it in your
home directory. Next, open a terminal window, as described later in the section “The OpenSolaris

Command Line,” and execute the following commands:

$ cd ~
$ mkdir .mozilla/plugins
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$ bunzip2 flash_player_9 solaris_x86.tar.bz2

$ tar -xvf flash_player 9 solaris_x86.tar

x flash_player_9 solaris_rl25 x86, 0 bytes, 0 tape blocks

x flash_player_9 solaris_rl25 x86/flashplayer.xpt, 856 bytes,
2 tape blocks

x flash_player 9 solaris_rl25 x86/1ibflashplayer.so, 6733812
bytes, 13152 tape blocks

$ mv flash_player_9 solaris_rl25 x86/* .mozilla/plugins/

Finally, exit Firefox and restart it. Flash should now be working.

OpenSolaris also includes two popular e-mail clients: Thunderbird and Evolution. Both are
found in the Applications » Internet menu. You can also launch Thunderbird from its icon,
directly to the right of the Firefox icon.

For your instant messaging needs, OpenSolaris includes the Pidgin Internet Messenger program,
which you can launch from Applications > Internet > Pidgin Internet Messenger. Pidgin enables
you to talk on any of your favorite chat networks, such as AIM, MSN, Google Talk, IRC, and
others.

Office suite

The primary office suite for OpenSolaris is Open0ffice.org. It's not installed by default, but
you can add it through the graphical Package Manager or the command line as described a little
later in the section “Adding Software.”

Once OpenOffice.org is installed, you can use its Writer, Calc, and Impress components to do
word processing, spreadsheets, and presentations, respectively. These applications all show up
under the Applications » Office menu. The first time you launch one of them, OpenOffice.org
takes you through a configuration and registration process. Open0ffice.org also includes
additional tools for preparing graphics and equations for documents, and for interfacing with
databases.

You can read PDF files with the Evince document viewer, which should launch automatically
if you download a PDF with Firefox. You can launch it manually from Applications > Office
» Evince Document Viewer.

Multimedia

OpenSolaris includes several audio and video multimedia applications — including Rhythmbox
music player and Totem Movie Player — under Applications > Sound & Video.

For image editing, you can use the Gnu Image Manipulation Program (GIMP) which is available
in the package repository in the SUNWgnome-img-editor package. To just view photos, use
the Image Viewer or Image Organizer in the Applications » Graphics menu.
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EF Chapter 4 explores the multimedia capabilities of OpenSolaris in more detail.

Printers and peripherals

OpenSolaris supports most USB-based printers and peripherals, such as webcams, mp3 players,
and the like. Generally, OpenSolaris can auto-detect and configure them, but occasionally you
will have to configure them manually. OpenSolaris also supports network printers, and peripher-
als connected via older technology such as serial ports.

¥ F See Chapter 5 for details on using printers and peripherals with OpenSolaris.

Customizing GNOME

You can customize many aspects of the GNOME interface. Most of the customization preferences
can be accessed through System » Preferences. For example, to change the screensaver, select
System > Preferences » Screensaver.

One customization of particular interest is the Visual Effects feature. These effects use the Com-
piz composting window manager. To enable them, select System > Preferences » Appearance,
choose the Visual Effects tab, and select one of the options. If you come from a Mac world, the
visual effects should make you feel somewhat at home — they include functionality similar to
Exposé on the Mac.

You can also add menu items, launchers, icons, and other tools to the panels and desktop.

) F Chapter 4 provides more details on customizing GNOME.

Logging out and shutting down

To log out the current user, select System » Log Out <username> ... . This brings up a confir-
mation dialog to ensure that you really want to log out before actually doing so. Once you log
out, you are presented with the login screen again.

To shut down or reboot the computer, select System » Shut Down ... . A pop-up window
enables you to Restart, Cancel, or Shut Down.

If you're going to be away from your computer, select System » Lock Screen to start the screen-
saver and require your password before allowing access again.

2 This section was just an introduction to the GNOME desktop. The remainder of this
“ chapter focuses on the command line. For more details on the OpenSolaris graphical
user interface, see Chapter 4.
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Using the Command Line

If you're like the authors of this book, the first thing you generally want to do in any window-
ing environment is find your way to a command line. You can open a command line terminal
by clicking the command line terminal icon on the top panel or by right-clicking on the desktop
and selecting Open Terminal from the pop-up menu.

Like many Linux systems with which you might be familiar, OpenSolaris includes
support for Virtual Console (VC), also called Virtual Terminal (VT). This feature
enables you to switch between multiple text consoles without the windowing system, or between
the windowing system and various text consoles. As of this writing, only the former option
(switching between multiple text consoles) is available. Consult the vt (7I) man page for
details.

Shells

The user that you created in the OpenSolaris installer is assigned the GNU Bourne-Again
Shell (BASH) by default. If you're familiar with Linux, you'll feel right at home with bash on
OpenSolaris. If you've used Solaris Express or Solaris 10 in the past, this may be a change for
you. If you prefer a different shell, OpenSolaris includes several other options, as shown in
Table 3-1.

TABLE 3-1

OpenSolaris Shells

Shell Path Comments

Bourne-Again Shell /usr/bin/bash Default for user created by installer and for
root role

Korn Shell /usr/bin/ksh Korn Shell 93 (not the older Korn Shell 88
that ships with Solaris 10)

C Shell /usr/bin/csh, Standard C shell and enhanced C shell

/usr/bin/tcsh

POSIX-compliant Shell /usr/xpg4/bin/sh  POSIX-compliant shell; quite similar to Korn
Shell 88

Z Shell /usr/bin/zsh Z Shell

The Z Shell (zsh) and the enhanced C Shell (tcsh) are not installed on your system
by default. To use them you must install the SUNWzsh and SUNWtcsh packages from
the network package repository. See the ““Adding Software” section later in this chapter for details
on installing packages from the package repository.
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The system shell, /bin/sh, is now Korn Shell 93, not the old Bourne shell you find on Solaris
Express, Solaris 10, and previous releases. /usr/bin/jsh (the job-control shell) also is a sym-
link to Korn Shell 93.

You can, of course, change your shell. To try one out, simply type the path of the shell you
want to use. To change your default shell, consult the section “System Administration” later in
this chapter.

To exit a shell, use exit or Togout.

BEERNEC e

The remainder of this section assumes you have some familiarity with a command-line environ-
ment, so it doesn’t explain every detail about the shell or about navigating your environment. It
also assumes use of the bash shell, although many of the features discussed apply to the C shell
and Korn shell as well.

i To get system console output, launch a terminal from your shell using
/usr/X11/bin/xterm -C &.

Both bash and the UNIX command-line environment are quite prevalent and popular, so you
can find plenty of information about them elsewhere if you're a beginner. For example, most
introductory Linux books contain a good overview of bash. For details on bash and the other
shells available in OpenSolaris, consult one of the references listed in the “Resources” section.

This section focuses on the user side of things. For administration, consult the section “System
Administration” later in this chapter.

Executing commands

As with all shells, you enter commands to the bash command prompt followed by a carriage
return (the Enter key on your keyboard). The $ in the following examples is the command
prompt. Everything else on that line is what the user types:

$ echo ''Hello, world"'
Hello, world

You can execute multiple commands on a single line by separating them with a semicolon:

$ touch filel
$ rm filel; 1s filel
filel: No such file or directory

If you end a command line with a backslash, bash lets you continue the command on the next
line. This feature is useful for entering lengthy commands:

$ touch \
> filel

$ 1s filel
filel
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One particularly nice feature of bash is command-line editing. You can edit your com-
mand line in place before executing it. Use the left and right arrows to move the cursor
back and forth on the line, to delete characters with the backspace, and to enter text as
normal. You can also use keystrokes for moving around the line, editing the line, and even
cutting and pasting text within the line. For example, Alt+F and Alt+B move forward

and backward, respectively, on a word-by-word, instead of character-by-character, basis.
The Bash Reference manual at www.faqs.org contains a useful list of editing keystrokes:
http://faqs.org/docs/bashman/bashref _81.html.

The bash command-line editing keystrokes are in many cases identical to the corre-
sponding keystrokes in the emacs text editor, with Alt used instead of the Meta (Esc)
character in emacs. For example, Ctrl-+K to cut (“kill"’) to the end of the line and Ctrl+Y to paste
(“yank’”’) are the same as in emacs.

Another nifty feature of bash command-line editing is automatic completion. If you press the
Tab key with the cursor at the end of a partially completed word, bash attempts to complete it
as a command, filename, environment variable, or other entity depending on context. If multi-
ple options are available, bash first completes the word up to the divergence, and then a second
Tab presents a list of all the options. For example, to get a list of all the commands in your path
that start with “fil,” type fil and press Tab twice:

$ file<tab><tab>
file file-roller filesync
$ file

bash first completed the word up to file (because there were no commands starting with f11
that didn’t have an e next), and then provided a list of possibilities with the second Tab.

Here’s an example of the context-sensitive nature of the completion:

$ 1s

filel file2z file3 otherfile
$ 1s file<tab><tab>

filel file2z file3

$ 1s file

Note that the tab autocomplete for file shows only those files in the directory beginning with
the string file. In this case, bash completed file as a filename in the working directory, not
as a command.

$? holds the exit status of the most recent command executed. Print it with the echo
command:

$ date

Fri Jul 18 15:22:23 MDT 2008
$ echo $?

0

$ 1s nothere
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nothere: No such file or directory
$ echo $?
2

Shell History

bash keeps a history of all the commands you execute. Unlike some other shells, this history
is kept on a per-user basis, not on a per-session basis. This means that the history is persistent
between login sessions, and represents an aggregation of the commands executed from all your
login sessions. Type the history command to see the complete history of commands:

$ history

1 1s
1s -a
pwd
whoami
touch testfile
which gcc
which cc
rm testfile
history

W00 Ny OB WM

Give history an integer argument to see only that number of previous commands:

$ history 2
12 date
13 history 2

To execute a command in the history, use ! <command number>. To execute the previous com-
mand, use the !! shortcut:

$ 14

whoami

test

$ date

Fri Jul 18 15:03:58 MDT 2008
$ 11

date

Fri Jul 18 15:03:59 MDT 2008

& Rather than use the history command to generate a list of commands, use the up
arrow on your keyboard to iterate backward through the command history. Once
you’ve moved backward into the history, you can use the down arrow to iterate forward. After
you find a command with the arrows, you can edit it and execute it. You can also use Ctrl+R to
search (backward) through the history.

The history is stored in the .bash_history file in your home directory. The number of com-
mands saved in the history is controlled by the HISTSIZE environment variable, with 500 as the
default. See the next section for details on environment variables.
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Environment variables

Like most shells, bash stores some information in special variables known to the shell called
environment variables. You can view a complete list of the currently defined environment vari-
ables with declare:

$ declare

BASH=/usr/bin/bash

BASH_ARGC=()

BASH_ARGV=()

BASH_LINENO=()

BASH_SOURCE=()

BASH_VERSINFO=([0]=""3"" [1]=""2"" [2]=""25"" [3]=""1""
[4]=""release"'" [b]="'"i386-pc-solaris2.11"")
BASH_VERSION="'3.2.25(1)-release’

COLUMNS=80

You can print the values of the environment variables using the echo or printf commands,
accessing the value of the variable by prefixing it with the usual $ character:

$ echo $SHELL
/bin/bash

$ printf ''$PATH\n''
/usr/bin

Set the value of an environment variable with an assignment statement. The following example
sets the shell history size to 1,000:

$ echo $HISTSIZE
500
$ HISTSIZE=1000
$ echo $HISTSIZE
1000

& Environment variable values are not persistent between sessions. To set up your envi-
“ ronment consistently between login sessions, add your changes to the .bashrc file.
See the section on Customizing Bash with .bashrc later in this chapter.

You can create your own environment variables by setting them to a value:
$ MYVAR=test

$ echo $MYVAR
test

Usually when you set an environment variable you also want to export it to make it available to
child shells and processes:

$ export MYVAR
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& You can capture the output from a command in an environment variable using back-
ticks:

$ TIME="date"
$ echo $TIME
Fri Jul 18 16:24:31 MDT 2008

Command paths

Other than the built-in shell commands such as declare and set, all the commands you exe-
cute are located in various directories on your system. Table 3-2 lists the principal directories
containing commands.

S /bin is a symbolic link to /usr/bin, but /sbin is an independent directory from
/usr/sbin.

You can execute commands by providing an absolute path or a relative path. With an absolute
path, the shell looks for the command in the given path. With a relative path, bash tries to
find it in one of the directories specified in your PATH environment variable. The PATH is a
colon-separated list of directories in the order they should be searched. The first match is the
one that is executed.

& Use the which command to see which version of a command you are executing
based on your path:

$ which grep
/usr/gnu/bin/grep
$ which xterm
/usr/X11/bin/xterm
$ which which
/usr/bin/which

The user created by the installer is set up with the following path:

$ echo $PATH
/usr/gnu/bin:/usr/bin:/usr/X11/bin:/usr/sbin:/sbin

Note that /usr/gnu/bin is first. If there are two versions of a command, one in
/usr/gnu/bin and one in /usr/bin, the GNU version is executed by default.

The working directory (.) is not in the path for security purposes. If it were,
% an attacker could place a malicious program with the same name as a standard
command somewhere in a writable directory such as /tmp. If you happened to be in the /tmp
directory and you tried to execute the command, you would actually execute the malicious
program. To execute something in your working directory, you must specify it explicitly with
. /. Therefore, using absolute paths to commands is generally safer because you know exactly
which version of a command you’re executing. Administrators should generally use absolute paths,
although for brevity this book uses mostly relative paths. See Chapter 11 for more security topics.
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TABLE 3-2

OpenSolaris Command Directories

Directory Description

/usr/bin The default directory for commands; contains utilities such as grep and
tr, applications such as firefox and thunderbird, shells such as
bash and zsh, and myriad other commands

/usr/ccs/bin Traditionally System V development tools, but these have mostly moved
to /usr/bin

/usr/gnu/bin The GNU versions of commands; slightly different versions of many of
them are also found in /usr/bin

/usr/sbin The system tools, commands, and daemons, such as zfs, dumpadm,
in.routed, and others. These are generally privileged commands.

/usr/sfw/bin Traditionally the Sun Freeware (mostly GNU) tools, but almost all of
these have been moved to /usr/bin, with symlinks left here; or
symlinks have been added to /usr/bin

/usr/uch Traditionally the BSD tools, but these have been moved to /usr/bin,
with only a few symlinks left here

/usr/X11/bin X11 commands, such as xterm, xhost, and others

/usr/openwin/bin; Aliases for /usr/X11/bin
/usr/X/bin;

/usr/X11IR6/bin

/usr/xpgd/bin Versions of some of the tools that adhere to the POSIX standard, where
the versions in /usr/bin don't

/bin Alias for /usr/bin

/sbin System tools and utilities required for booting and possibly recovering
the system if /usr is not mounted. These are generally privileged
commands.

To change your path, set the PATH environment variable. If you just want to add a directory to
the path, be sure to include the old version of the PATH on the right-hand side of the assign-
ment. For example, use the following to add the Sun Studio Express directory to the end of your
path:

$ PATH=$PATH:/opt/SunStudioExpress/bin
$ echo $PATH
/fusr/gnu/bin:/usr/bin:/usr/X11/bin:/usr/sbin:/sbin:/opt/SunStudioExpress/bin
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As mentioned earlier, however, setting an environment variable in this manner is not persistent
across sessions. To set your PATH persistently, set it in .bashrc, discussed later in this chapter.

F Sun Studio Express and other development tools are covered in detail in Chapter 24.

The MAN PATH environment variable works similarly to the PATH, specifying where the man
command should look for manual pages. The MANPATH in the user created by the installer is as
follows:

$ echo $MANPATH
/usr/gnu/share/man:/usr/share/man:/usr/X11/share/man

You can set the MANPATH in .bashrc as well, but OpenSolaris now contains an enhancement
to the man command that enables it to find man pages based on the PATH, without an explicit
MANPATH.

& The man pages for many of the common commands are not included in the
“ OpenSolaris distribution for legal reasons, but you can find them online at
http://docs.sun.com/app/docs/col11/40.17.

Managing files

As on most UNIX-like systems, each user on OpenSolaris has a home directory. Your home
directory path is stored in the HOME environment variable. You can also use the tilde character
(~) to navigate to your home directory or to another user’s home directory. The tilde alone
implies the current user’s home directory. The following code shows how to navigate to home
directories:

$ cd ~

$ pwd
/export/home/nsolter
$ cd ~test

$ pwd
/export/home/test

This example also demonstrates that the pwd command shows your current working directory.

As usual, you can use regular expressions when referring to files on the file system. For example,
to list all the files in the current directory starting with file, use the following:

$ 1s file*
filel file2 file3

Files on OpenSolaris have an owner, a group, and traditional UNIX permissions associated with
them.

The concepts of users and groups are discussed later in the section “System Adminis-
tration.”
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Each file can be assigned an owner and a group, and read, write, and execute permissions on
the basis of owner, group, and all. Use 1s -1 to see the permissions:

$ 1s -1 filel
-rw-r--r-- 1 nsolter staff 0 2008-07-17 14:43 filel

This output shows that the file owner is nsolter and the file group is staff. The 10-character
string on the far left shows the permissions. From left to right, the first character indicates
whether the file is special in any way, such as a directory or link. The - means it’s a regular

file. The next three characters are the read, write, and execute permissions for owner. The three
following characters are the three permissions for group, and the final three are the permissions
for all users. A - means the permission is not granted. In this case, you can see that the owner
is granted read and write access on filel, group and all are granted read access, and no one is
granted execute permissions. Note that execute permissions for a directory actually means list
permissions.

You can change the owner and group of a file with the chown command, although by default
users lack the file_chown_self privilege that allows you to change the ownership. Thus, the
following example is run as the root role (see the section “Running privileged commands” later
in this chapter for details):

# chown test:mygroup filel
# 1s -1 filel
-rw-r--r-- 1 test mygroup 0 2008-07-17 14:43 filel

You can change permissions on a file with the chmod command. Although chmod can take a
symbolic permissions argument, it’s typically used with an octal (or base eight) representation
of the permissions. To understand what that means, consider each permission flag as a single
bit, either on or off. The combined read, write, and execute permissions for each of user, group,
or all are thus composed of three bits. Three bits in binary can represent the decimal numbers
0 through 7, which can be represented by a single octal digit. The permissions are always rep-
resented, left to right, as read, write, and execute, in that order. Considering execute the least
significant bit, you can translate any configuration of these three permissions to a single octal
digit according to Table 3-3.

Each octal number represents the permissions for one of user, group, or all. The chmod
command sets the permissions for all three at once, with three octal numbers representing, from
left to right, user, group, and all. For example, to set the permissions of file2 to read, write,
and execute for owner, to read and execute for group, and to just read for all, use the following
command:

$ chmod 754 file2
$ 1s -1 file2
-rwxr-xr-- 1 nsolter staff 0 2008-07-17 15:10 file?2
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When you create a new file or directory, the permissions are 666 (read and write) for a file
and 777 (all permissions) for a directory, minus the permissions specified in your user file
creation mode mask (“umask” for short). You can view your umask value by running the umask
command:

$ umask
0022

TABLE 3-3

OpenSolaris File Permissions

Permissions Binary Octal
--- 000 0
--X 001 1
-w- 010 2
WX 011 3
r-- 100 4
r-x 101 5
rw- 110 6
rwx 111 7

A umask value of 0022 specifies write permissions for both group and all. Recall that the umask
permissions are subtracted from the full permissions, so with a umask of 0022, when you create
a file it will have read/write permissions for owner, and read-only permissions for group and all.
For example, you can create a file called umasktest and examine its permissions:

$ touch umasktest
$ 1s -1 umasktest
-rw-r--r-- 1 nsolter staff 0 2008-07-20 13:01 umasktest

You can set the umask value for the current shell with the umask command:

umask 022

To set it persistently, add it to your .bashrc file (described later).

i) k = OpenSolaris also supports finer-grained access control lists (ACLs) on files. Consult
St Chapter 11 for details.
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Redirection

As with most shells, bash supports redirection of command input and output and piping of
command output with the usual symbols:

64

command > file directs the standard output of the command to a file, overwriting the
contents of the file if it exists.

command >> file directs the standard output of the command to a file, appending the
contents to the file.

file < command gives the contents of file to command as standard input.

commandl | command2 gives the standard output of commandl to command?2 as its stan-
dard input.

Here are some examples of command redirection and piping:

$ date > test.out

$ cat test.out

Fri Jul 18 16:43:26 MDT 2008
$ date >> test.out

$ cat test.out

Fri Jul 18 16:43:26 MDT 2008
Fri Jul 18 16:43:36 MDT 2008
$ 1s -1 | we -1

5

& The > symbol redirects only standard output, not standard error. As shown in the fol-
“ lowing example, you can redirect standard error with 2>, because standard error is

always represented by file descriptor 2.

$ 1s notfound > test.out

notfound: No such file or directory

$ 1s notfound > test2.out 2> test2.out
$ cat test2.out

notfound: No such file or directory

Job control

The bash shell provides job control functionality similar to the C Shell. To run a job in the
background, add an ampersand (&) to the end of the line:

$

./long-running &

[1] 1018
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The [1] means that this is job number 1 in your shell. If you start another job, it receives a dif-
ferent number:

$ ./myjob &
[2] 1021

You can list all the current jobs with the jobs command:

$ jobs
[1]- Running ./long-running &
[2]+ Running ./myjob &

To bring a job to the foreground, use fg. To suspend the running foreground job, press Ctrl+Z.
To put a suspended job in the background, use bg:

$ fg %1

./long-running

~Z

[1]1+ Stopped ./long-running
$ bg %1

[1]J+ ./long-running &

The fg and bg commands without arguments apply to the job most recently acted on, denoted
with a + next to it in the output from jobs.

Customizing Bash

You can customize your bash shell persistently by adding configuration settings to the .bashrc
file in your home directory. The initial user created by the installer has a .bashrc that sets

the PATH, MANPATH, and command prompt, which are the three most typical things to set in a
.bashrc. PATH and MANPATH were discussed earlier in the section “Command Paths.” Here’s
what the settings look like in the .bashrc:

export PATH=/usr/gnu/bin:/usr/bin:/usr/X11/bin:/usr/sbin:/sbin
export MANPATH=/usr/gnu/share/man:/usr/share/man:/usr/X11/share/man

To set the command prompt, set the PS1 environment variable. You can use what-
ever text you want, plus some special character macros that expand to specific values
depending on context. Table 3-4 lists a few of these macros. For a complete list, see
http://fags.org/docs/bashman/bashref_74.html#SEC81

For example, to set your prompt to username:working directory $, you could use the fol-
lowing:

PSI="\u:\W\$ '
Now your prompt might look like this if you're in your home directory:

nsolter:~$

65



Using OpenSolaris

Bash Command Prompt Macros

Macro Meaning

\d Current date

\h Hostname

\t or \T Time in 24-hour or 12-hour format

\u Username

\W Current working directory

\W Base name of the working directory

\$ $, unless effective ID is O (root), in which case #

§ The .bashrc file is not executed for all login shells, specifically not for remote ses-
sions. If you want to execute it in all cases, create a .bash_profile in your home
dlrectory that looks like this:

if [ -f ~/.bashrc ]; then
. ~/.bashrc
fi

You can, of course, add configurations other than these three to .bashrc, such as setting a
CLASSPATH environment variable for Java programming.

The /etc/profile file is executed for all users for each new shell before the
.bash_profile and .bashrc. Among other things, /etc/profile sets a default umask

for all users.

Text editors

OpenSolaris includes the vim text editor, which is an improved version of the original vi text
editor. You can use vim directly, or run vi, which launches vim in vi-compatibility mode.

In addition to vim, OpenSolaris includes the standard utilities cat, more, and Tess for quickly
viewing file contents. Consult their man pages, all in section 1, for details.

& If you're an emacs fan, you can install it from the package repository. Install the
® SUNWgnu-emacs-gtk package for the graphical version or SUNWgnu-emacs-nox
for the basic tty text-based version. See the section “Adding Software”’ later in this chapter for
details on installing additional software from the package repository.
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The remainder of this section focuses on vim.

If you're a regular UNIX or Linux user, it's pretty hard to avoid using vi or vim at least once

in a while, so you're probably already familiar with at least its basic functionality. However,

if you're coming from a different computing environment or if, like one of the authors, you
stubbornly use emacs whenever possible, you might not be completely comfortable with vi and
vim. Thus, this section provides a basic tutorial on the vim editor. Most of the commands, with
the exception of the visual mode, apply to vi as well.

This tutorial on vim is not comprehensive. A good cheat sheet can be found at
http://fprintf.net/vimCheatSheet.html.

You can launch vim with one or more filenames:
$ vim vimtest

You'll then see something like this:

¥ If vim displays errors about “terminal entries” or “terminal capabilities,” your TERM
“ environment variable is probably set incorrectly. If you don’t know your terminal
type, setting TERM to vt100 is usually a safe bet. See the terminfo(4) man page for all the
gory details.

The first point to understand about vim is that it is a modal editor. When editing a file, you are
always in one of command, insert, or visual mode. You start in command mode, from which
you can execute various commands such as searching, cutting and pasting, saving, and quitting.
To enter insert mode, use 1, a, or another similar command, after which anything you type will
be inserted into the file. To return to command mode press the Esc key. Esc is the only com-
mand that works in insert mode.

Similarly, to enter visual mode, use the v command. In visual mode you can select text to cut or
copy. Return to command mode with the Esc key.

General commands

Table 3-5 lists some of the commands for working with files in vim.
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TABLE 3-5

vim General Commands

Command Description

W Saves file. Use :w! to override read-only settings, if you have appropriate
permissions.

:q Quits the editor. Use :q! to exit without saving changes to the file.

A Saves changes and exits

u Undoes the previous action

Esc Enters command mode

Ctr14G Displays the filename, modification status, and current line number

Inserting text

As mentioned earlier, you insert text primarily in input mode. There are a few different ways to
enter input mode, as described in Table 3-6. You can also search and replace text.

Navigating and searching

In command mode you can quickly get where you want in a file. vim’s navigation commands
are described in Table 3-7.

Cutting and pasting

vim, of course, provides mechanisms for cutting and pasting text. Table 3-8 describes the
commands.

Repeating commands

The vim editor allows most commands to be preceded with a number. The command is then
repeated that number of times. For example, to delete the next 10 lines, enter 10dd.

Running privileged commands

Traditionally, UNIX has two access control levels: regular users and the privileged user, also
called superuser, with login name root. The root user is always assigned user ID 0, and can do
essentially anything he or she wants. Regular users are restricted from performing system and
administrative actions.

If you're coming from the Linux world you might be familiar with sudo, which allows regular
users with appropriate privileges to access privileged commands. OpenSolaris has a similar
model, implemented with Role-Based Access Control (RBAC).
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vim Insertion Commands

Command Description

r
R
:g/stri

TABLE 3-7

Inserts text starting to the left of the cursor. Enters insert mode.
Inserts text starting to the right of the cursor. Enters insert mode.

Inserts a newline below the cursor and inserts text starting in
that newline. Enters insert mode.

Inserts a newline above the cursor and inserts text starting in
that newline. Enters insert mode.

Replaces the current character with the next character typed
Enters input mode, but overwrites characters instead of inserting

ng/s//newstring/g Replaces every occurrence of string in the file with
newstring. Without the trailing g, substitutes only the first
occurrence on each line. Without the s in the middle, replaces
string only on the current line.

vim Navigation Commands

Command Description

Arrow Ke

$

Ctrl+D,

/string

?string

nG

repository,

a5

ys Moves the cursor around the file one character/line at a time
Moves the cursor to the beginning of the current line
Moves the cursor to the end of the current line
Ctr1+U Moves down and up in the file, one-half page at a time

Searches forward for the occurrence of the string. Enter to search again. You
may use regular expressions in the string.

Searches backward for the string

Jumps to line number n in the file. G alone jumps to the last line in the file.

& If you prefer sudo, you can install it from the network package repository. See the
“ “Adding Software” section later in this chapter for details on the network package
and Chapter 11 for more information on sudo.
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vim Cutting and Pasting Commands

Command Description

X Deletes the current character

dd Deletes the entire line

v Enters visual mode to select text by moving the cursor
y Copies (““yanks”) text selected in visual mode

d Deletes (cuts) text selected in visual mode

p Pastes text most recently deleted or copied

Esc Exits visual mode (returns to command mode)

If you created a user during OpenSolaris installation, the installer configured your system such
that root is a role instead of a regular user. The implication of that change is that you can no

longer log in as root. Instead, if you really want the power of root, you can assume the root
role by first logging in as a user who has been assigned that role and then su-ing to root. To

check whether your user has been assigned the root role, use the roles command:

$ roles
root

$ su
Password:

#

However, there’s an easier and safer way to administer the system. The user created by the
installer is assigned the Primary Administrator profile, which means that she can perform
most administrative actions. The trick is that she can’t execute them directly. Like on Linux with
sudo, you must explicitly indicate that you want to execute a privileged command by prefixing
the command with pfexec. If you forget the pfexec, you'll be warned that the operation is
privileged. Here’s an example:

$ usermod -s /usr/bin/bash test

UX: usermod: ERROR: Permission denied.
$ pfexec usermod -s /usr/bin/bash test
$

To check your profiles, use the profiles command.

i [l e To avoid showing pfexec repeatedly, the examples in the rest of this book run priv-

=5 ileged commands from a root shell. In those examples, the prompt is shown as the
pound sign (#) instead of the usual dollar sign ($). Generally, however, avoid adopting the root
role if possible because it can lead to accidentally doing something harmful to the system.
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If you didn’t create a user in the installer, then root is not a role, and no user is assigned the
Primary Administrator profile. Thus, you'll need to explicitly log in as root, or su to root, to
administer the system.

=8 Chapter 11 covers RBAC, pfexec, and other security features of OpenSolaris in
* much more detail.

Switching Languages and Locales

Although most of the examples in this book show OpenSolaris using American English and the
American formats for dates and such, OpenSolaris includes comprehensive internationalization
support. If you live in a region other than the United States or natively speak a language other
than American English, you might be more comfortable working in a different locale. The locale
is more than just the language. It also includes the formats for date and time, monetary conven-
tions, decimal formatting style, and other location-specific items.

There are a few different ways to switch locales in OpenSolaris. First, as shown in Chapter 2,
you select the default language and locale during installation. After installation, you can select

a locale for each GNOME session, set the locale for each terminal session, or change the default
system locale.

Changing locale in GNOME

You can select a different language before logging in to GNOME. On the login screen, click the
Options button on the lower left, and then click Select Language from the pop-up menu. Select
the language you want and click the Change Language button (see Figure 3-4).

The first time you select a different language, you're asked if you want to restart the login
screen with the chosen language. Subsequent changes automatically restart the login screen.
You then see the login screen in the new language. Figure 3-5 shows the screen in Simplified
Chinese.

When you log in, you're asked (in the new language) if you want to make this language
setting your default. Select this option if you do indeed want this language to be that user’s
default.

18 Selecting the language as your default sets it for that user only. Logging in as a differ-
% ent user uses the system default language, so the login screen always starts in the sys-
tem default language. Also, setting the per-user default language this way applies only to GNOME.
If that same user logs in via ssh or another text-based mechanism, she will use the system default
language.

You'll also be asked if you want to change the names of the standard folders in your home
directory to use the new language.
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FIGURE 3-4

GNOME lets you select a language from the login screen.

Select the language for your session to use:

m

System Dafault Default
Chinese [China Mainland) i (dEx5) zh_CN UTF-8
Chinase (Hang Kong) B () zh_HK.UTF-8
Chinese (Taiwan) i (&) zh_TW.UTF-8
English (USA) American English ~ en_US.UTF-2
French Frangais fr_FR.UTF.2
German Deutsch e DE.UTF-8
Italian Italiana it_IT.UTF-8
Japanese B+ jaIRUTF-2
Korean fusv | ko_KR.UTF-2
Portuguese (Brazilian) Portugués do Brasil pt_BR.UTF-8
Fussian pyceruit ru_RU.UTF-8
Spanish Espafial es ES.UTF-8

€3 Cancel J [chanweiamw]

The GNOME login screen in simplified Chinese.

opensoans
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Changing locale in a terminal session

The locale in each terminal session is controlled by several environment variables, which are
listed in Table 3-9.

TABLE 3-9

Locale Environment Variables

Environment Variable Description

LANG General language specification; when in doubt, set this one
LC_ALL Language setting; overrides LANG and other LC_ variables
LC_COLLATE Specifies the character collation sequence

LC_CTYPE Specifies character width and other character settings
LC_MESSAGES Specifies the message database to use

LC_MONETARY Specifies symbols and formats related to money
LC_NUMERIC Specifies the delimiter for decimals and thousands
LC_TIME Specifies date and time formats

Each of these variables can be set to a language specification. For example, the language specifi-
cation for German looks like de_DE.UTF-8. You can see all the locales available on your system
by looking in /usr/1ib/locale:

$ 1s /usr/1ib/locale

C en_GB.UTF-8 es_CR.UTF-8 es_SV.UTF-8 fr.UTF-8 ru_RU.UTF-8
common en_IE.UTF-8 es_EC.UTF-8 es_UY.UTF-8 1is0_8859_1 ru.UTF-8

de AT.UTF-8 en MT.UTF-8 es_ES.UTF-8 es VE.UTF-8 it _IT.UTF-8 sk _SK.UTF-8
de_CH.UTF-8 en_NZ.UTF-8 es_GT.UTF-8 es.UTF-8 it.UTF-8 sv_SE.UTF-8
de_DE.UTF-8 en_US.UTF-8 es_MX.UTF-8 fr_BE.UTF-8 ja_JP.UTF-8 sv.UTF-8
de_LU.UTF-8 es_AR.UTF-8 es_NI.UTF-8 fr_CA.UTF-8 ko_KR.UTF-8 zh_CN.UTF-8
de.UTF-8 es_BO.UTF-8 es_PA.UTF-8 fr_CH.UTF-8 ko.UTF-8 zh_HK.UTF-8
en_AU.UTF-8 es CL.UTF-8 es_PE.UTF-8 fr_FR.UTF-8 POSIX zh_TW.UTF-8
en_CA.UTF-8 es_CO.UTF-8 es_PY.UTF-8 fr_LU.UTF-8 pt_BR.UTF-8 zh.UTF-8

Each directory name listed is a valid setting for the environment variables listed in Table 3-9.
You can use the Tocale command to check your current locale:

$ locale

LANG=en_US.UTF-8

LC_CTYPE=""en_US.UTF-8""
LC_NUMERIC=""en_US.UTF-8""
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LC_TIME=""en_US.UTF-8""
LC_COLLATE=""en_US.UTF-8""
LC_MONETARY=""en_US.UTF-8""
LC_MESSAGES=""en_US.UTF-8""
LC_ALL=

To set the overall locale, change the LANG variable. The following example shows the changed
output of the date command after changing locale:

$ date

Tue Jul 29 13:11:10 MDT 2008

$ LANG=fr_CH.UTF-8

$ date

mardi, 29 juillet 2008 13.12:02h MDT

You can, of course, set any of the LC_ variables individually to different language settings if you
want, but it’s usually best to set just LANG.

& Setting LANG or another environment variable at the command line is not persistent
“ across login sessions. To set your locale persistently, set the environment variable in
your .bashrc file.

Changing the default system locale

You can set the default system locale, which then applies to both GNOME sessions and
terminal sessions, unless the user explicitly sets a different locale. The system locale is set in the
/etc/default/init file. That file sets the LANG environment variable to the locale you speci-
fied in the installer. Simply change the LANG variable to the locale you want as the new default.
For example, to set the default system locale to German, set LANG in /etc/default/init as
follows:

LANG=de_DE.UTF-8

& You must reboot the system in order for the LANG setting in /etc/default/init to
take effect.

Changing keyboard layout and input languages

The default keyboard layout is based on the default system locale that you selected during instal-
lation. However, if you write in more than one language, it’s useful to be able to switch between
different input languages. To configure this feature, first select System » Preferences » Input
Methods. On the dialog’s General tab, make sure that Use Input Method Switcher Application is
selected as the Input Method Status and switcher placement. Also, under the Languages/Scripts
tab, add all languages you plan to use from the Available Languages/Scripts to the right-hand
Languages/Scripts to Input.

Once you've set up your preferences, you can switch your keyboard layout/input language at any
time by selecting the desired language in the language switcher, which shows up on the right
side of the top panel, directly to the left of the power monitor.
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Installing additional languages

If your preferred locale isn’t one of the default languages installed, you can install additional
languages from the pkg.opensolaris.org package repository by following the instructions
in “Adding Software” later in this chapter. The easiest way to install a language is to install the
package named SUNWTang-<language>. For example, Polish language support package is
SUNWTang-pT.

Getting Online

Unless you're planning on traveling back in time a few decades, you probably want to connect
your OpenSolaris box to some sort of network. OpenSolaris includes the Network AutoMagic
(NWAM) service to configure your computer’s network interfaces automatically, but if you want
more control, you can configure your network connections manually.

Network AutoMagic

NWAM starts automatically when your system boots and attempts to connect your computer to
a network using DHCP.

= If you're new to UNIX networking, see Chapter 9 for details about network inter-
* faces, DHCP, NWAM, and other networking topics.

NWAM attempts wired connections first, if available. If it connects successfully, it provides a
notification telling you the name of the interface configured and the 1P address obtained from
the DHCP server. There’s nothing you need to do to connect to a wired network that supports
DHCP; NWAM takes care of everything automatically.

& NWAM often connects to the network before you’ve logged in to the GNOME desk-
¥ top, so you usually won’t see this notification.

If no wired interface is available and your computer has a wireless network interface, it attempts
to connect to a wireless network. In that case, NWAM presents a list of detected wireless
networks and you can select the one to which you want to connect, entering the security key if
required.

Manual network configuration

Although NWAM is quite convenient for getting your system online quickly and without
complicated configuration, the service is somewhat limited in its capabilities. For example,
you can't easily configure static IP addresses. Thus, for advanced administration, you need to
use manual methods to configure your networking. To switch to manual configuration, select
System » Administration » Network. A pop-up window will inform you that the system is
currently configured to manage the network automatically. Click the Manual button to change
the configuration. A Network Settings dialog similar to the one shown in Figure 3-6 will

appear.
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Use the networking configuration GUI to configure your interfaces manually.

& 47 Network settings BE=8

Location: l *. J

Connectians | General | DNS [ Hosts |

Ethernet connection lJ-_EmﬂJ
@Activate
b @QEBEHVME

s The interface e1000g0 is not configured

Default gateway device:

©@Hep € Cancel| | @ OK

i

§ This section covers the OpenSolaris networking GUI. For details on the commands
and configuration files, see Chapter 9.

CROSS-RI

By default, none of the interfaces are active. To activate an interface, select it in the box and
then click the Properties button on the right. The dialog shown in Figure 3-7 will appear.

Check Enable This Connection; and if you want the connection to be persistent, check Activate
on Boot. Then, in the Connection Settings section, choose either DHCP or Static 1P address for
the configuration. If you select Static IP, fill in the IP address and the Gateway address, which is
usually the address of the external-facing router on your LAN. The subnet mask should be filled
in automatically. If this is a wireless interface, fill in the Wireless settings information as well.
Finally, click OK. Your network connection should now be configured.

Depending on the information — if any — that OpenSolaris was able to obtain from the DHCP
server on your network, you may need to fill in other networking information. You specify the
hostname and domain name on the General tab, and Domain Name Servers on the DNS tab. On
the Hosts tab, you fill in hostname/IP address mappings for files-based resolution. Consult your
network administrator or Internet service provider (ISP) for the domain and DNS settings. You
generally shouldn’t need to modify the hostname and files-based host mappings.

i Chapter 9 explains DNS and the uses of the other settings mentioned here.

If you ever want to switch back to NWAM, you can select System > Administration » Network
again. The dialog that appears will give you the option to switch back to automatic network
configuration. Alternatively, you can run the following two commands:

# svcadm disable network/physical:default
# svcadm enable network/physical:nwam
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Activate an interface via the Interface Properties dialog.

b4 ‘" Interface properties [ X]

Connection
Interface name: e1000g0
() {Enable this connection

[] Activate on boot

Connection settings

Configuration: Static IP address T J

1P address:

Subnet mask:

Gateway address:

l eﬂelp J l £ Cancel J 3 0K

Troubleshooting network connections

To determine whether your network connection is working, open a Firefox browser and try to
connect to your favorite web page. If it's not working, and you're using NWAM, try restarting
the NWAM service:

# svcadm restart nwam

This action should force NWAM to try to disconnect from and reconnect to the network. Give it
a few minutes, especially if connecting over a wireless network.

If the network connection still isn’t working, run ifconfig -a to determine whether your
interface has an assigned IP address:

# ifconfig -a

pcn0: flags=201004843<UP,BROADCAST,RUNNING,MULTICAST,DHCP,IPv4,CoS>
mtu 1500 index 4
inet 192.168.1.101 netmask ffffff00 broadcast 192.168.1.255
ether 0:c:29:a2:4:9

If no 1P address is shown for your interface in the inet field, give NWAM a bit more time to
work. If nothing happens after restarting NWAM, switch to manual networking, as previously
described.
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If ifconfig shows an IP address but the connection still isn’t working, you'll need to use some
of the more sophisticated debugging techniques discussed in Chapter 9.

If your network interface isn’t shown, OpenSolaris might not have drivers for it. To check, run
the driver detection tool by selecting Applications » System Tools » Device Driver Utility. This
tool quickly tells you whether you have the drivers for your particular network interface cards.

i Chapter 5 explains where you might find missing drivers for your network interfaces.

Adding Software

The OpenSolaris distribution included on the LiveCD provides a comfortable desktop environ-
ment, but because of space limitations necessarily omits a multitude of useful software. However,
the new OpenSolaris Image Packaging System (IPS) enables you to install additional applications
from the OpenSolaris network package repositories quite easily.

As mentioned in Chapter 2, OpenSolaris has replaced the old System V packaging with IPS.
The new packaging system is based on the concept of a network package repository. If you're
familiar with APT or Yum from the Linux world, you should feel right at home with IPS. As
with other network-based packaging systems, in IPS the packages are served from various
network repositories. Instead of downloading software in gzip format or the like, unpacking it,
and installing it, installing from IPS is a simple one-step process. You interact with IPS by using
the new pkg command.

Finding and installing software

Before searching for or installing software, always refresh your local copy of the software catalog
from the repository first:

# pkg refresh

Next, you can search for software you want using pkg search. This command enables you to
search for the names of packages containing specific binaries or files, so you must know the
name of at least one of the files in the package if you want to find it.

By default, pkg search searches only the software installed on your system. To search the net-
work repositories, use pkg search -r.

For example, to find Open0ffice.org, you can search for the file named openoffice:

# pkg search -r openoffice

INDEX ACTION  VALUE PACKAGE

basename  dir opt/openoffice.org/share/registry/res/en-US/org/openoffice
pkg:/openoffice@0.5.11-0.79

basename  dir opt/openoffice.org2.4/share/registry/modules/org/openoffice

pkg:/openoffice@2.4.0-0.86
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basename  dir opt/openoffice.org2.4/share/registry/modules/org/openoffice
pkg:/openoffice@2.4.0-0.86

These results from pkg search are somewhat confusing because there appears to be more

than one package containing OpenOffice.org, such as pkg:/openoffice@0.5.11-0.79 and
pkg:/openoffice@2.4.0-0.86. However, the different packages are actually just different
versions of the same package. Everything after the @ in the package name represents the version.
When you want to install the package, you usually don’t need to worry about the version. IPS
automatically uses the version that matches the rest of your system. Just reference the part of the
package name before the @ You can omit the pkg:/ as well.

i IPS package versioning is discussed in Chapter 6.

CROSSLH
To ensure that the openoffice package is the one you want, use pkg info. Like pkg search,
pkg info takes a -r option to indicate that you want the information from the repository:

## pkg info -r openoffice
Name: openoffice
Summary: OpenOffice.org 2.4
State: Not installed
Authority: opensolaris.org (preferred)
Version: 2.4.0
Build Release: 5.11
Branch: 0.86
Packaging Date: Wed Jul 9 08:35:00 2008
Size: 420.6 MB
FMRI: pkg:/openoffice@2.4.0,5.11-0.86:20080709T7083500Z

The Name field in the pkg info output is the package name, not the filename that you searched
for with pkg search. In this example, the package name and the filename are identical, but
that’s not always the case.

When you're sure you have the package you want, you can install it with pkg install:

# pkg install openoffice

DOWNLOAD PKGS FILES XFER (MB)
Completed 1/1  4220/4220 420.64/420.64
PHASE ACTIONS
Install Phase 4798/4798
PHASE ITEMS
Reading Existing Index 9/9
Indexing Packages 1/1

To uninstall software, use pkg uninstall:

# pkg uninstall openoffice
PHASE ACTIONS
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Removal Phase 5290/5290
PHASE ITEMS
Reading Existing Index 9/9
Indexing Packages 1/1

Alternative repositories

IPS enables you to specify the package authority from which you want to install software.
The default authority is opensolaris.org, which is served by the repository at the URL
http://pkg.opensolaris.org/release. You can list the authorities with pkg authority:

## pkg authority
AUTHORITY URL
opensolaris.org (preferred) http://pkg.opensolaris.org/release/

Although pkg.opensolaris.org/release/ contains quite a bit of software, it doesn’t have
everything you might need or want. For example, as of this writing, it doesn’t include the X
Multimedia System (XMMS) media player. A few additional repositories with useful software
include the following:

B Sunfreeware: http://pkg.sunfreeware.com:9000

B OpenSolaris development repository: http://pkg.opensolaris.org/dev

B OpenSolaris Contrib repository: http://pkg.opensolaris.org/contrib

Sun also provides additional repositories that include software that can’t be included

“ with pkg.opensolaris.org for legal reasons or that is available only to customers
with support contracts. Consult opensolaris.com for current information on these options.

To add an authority, use pkg set-authority, specifying the URL of the repository and the
authority name by which you want to refer to it. In addition, always run pkg refresh after
adding an authority:

#f pkg set-authority -0 http://pkg.sunfreeware.com:9000 sunfreeware.com
# pkg refresh
# pkg authority

AUTHORITY URL
opensolaris.org (preferred) http://pkg.opensolaris.org/release/
sunfreeware.com http://pkg.sunfreeware.com:9000/

Now pkg search and pkg install will search and install from both repositories. You don’t
need to specify a specific authority to search or install from in each command. Here’s an
example:

f# pkg search -r xmms
INDEX ACTION VALUE PACKAGE
basename file opt/sfw/bin/xmms pkg:/IPSFWxmms@0.5.11-5.7
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After confirming with pkg info that IPSFWxmms is the package you want, you can install it:

## pkg info -r IPSFWxmms
Name: IPSFWxmms
Summary: xmms - X MultiMedia System
State: Not installed
Authority: sunfreeware.com
Version: 0.5.11
Build Release: 5.11
Branch: 5.7
Packaging Date: Wed May 7 04:13:32 2008
Size: 5.1 MB
FMRI: pkg://sunfreeware.com/IPSFWxmms@0.5.11,5.11-5.7:20080507T0413327
# pkg install IPSFWxmms

PHASE ITEMS
Indexing Packages 579/579
DOWNLOAD PKGS FILES XFER (MB)
Completed 2/2 135/135 6.30/6.30
PHASE ACTIONS
Install Phase 307/307
Reading Existing Index 9/9
Indexing Packages 2/2

& As of this writing, the IPSFWxmms package is dependent on the SUNWGtk package
but it doesn’t declare that dependency. In order to use xmms, you also need to install
the SUNWGtk package with the following command:

# pkg install SUNWGtk

DOWNLOAD PKGS FILES XFER (MB)
Completed 2/2 50/50 0.63/0.63
PHASE ACTIONS
Install Phase 135/135
PHASE ITEMS
Reading Existing Index 9/9
Indexing Packages 2/2

After installing both packages, xmms can be run from /opt/sfw/bin/xmms.

@ E 8 In the rest of the book, the output from pkg install is generally omitted for brevity.
e AT 7
You can remove an authority with pkg unset-authority:

# pkg unset-authority sunfreeware.com
## pkg authority

81



Using OpenSolaris

AUTHORITY URL
opensolaris.org (preferred) http://pkg.opensolaris.org/release

= The Image Packaging System and OpenSolaris software management are covered in
detail in Chapter 6.

Developing on OpenSolaris

OpenSolaris provides a comprehensive development environment for anything from systems
software to web applications, using languages from Java to Fortran to Python.

To get started with Java development, you need the JDK, available in the SUNWj6dev package:
# pkg install SUNWj6dev

To get started with C and C++ development, you want either the Sun Studio compiler collec-
tion or the GNU compiler collection (GCC). Install ss-dev to obtain the Sun Studio compiler
collection:

#f pkg install ss-dev
The Sun Studio compilers and tools are now available in /opt/SunStudioExpress/bin.
To obtain GCC, install the gcc-dev package:
# pkg install gcc-dev
The GNU compilers and tools are now available in /usr/bin.
To code using an integrated development environment (IDE), install NetBeans:
## pkg install netbeans

Launch it with /usr/netbeans/bin/netbeans, or select Applications » Developer
Tools » NetBeans IDE.

‘S,_ ,EF Chapter 24 describes Sun Studio, NetBeans, and the other development and debug-
As=ASa=== ging tools available on OpenSolaris for a variety of languages in much more detail.

Connecting Remotely

OpenSolaris employs a secure-by-default configuration, such that the only way to connect to the
system remotely is with the Secure Shell (ssh).

Sase We recommend that you maintain the secure-by-default configuration and do not
“ attempt to enable other network services, because they can expose your system to
security threats.
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From another OpenSolaris, UNIX/Linux-based system, or Mac OS X, you should be able to just
type ssh at the terminal, providing a hostname or IP address. The first time you connect to a
system, you'll see a warning about host authenticity, which you can safely ignore:

$ ssh 192.168.1.101

The authenticity of host '192.168.1.101 (192.168.1.101)" can't be established.
RSA key fingerprint is ac:36:67:dd:d0:7d:fe:76:c8:56:42:ff:db:df:ca:34.

Are you sure you want to continue connecting (yes/no)? yes

Warning: Permanently added '192.168.1.101" (RSA) to the Tist of known hosts.

Password:

Last login: Thu Jul 31 13:38:01 2008 from 192.168.1.105

Sun Microsystems Inc. Sun0S 5.11 snv_93 January 2008
$

To connect from Windows, you can download and install an open source ssh client, such as
PuTTY, which is available from http://chiark.greenend.org.uk/~sgtatham/putty.

i Chapter 9 covers the various network services available, and Chapter 11 explains the
secure-by-default settings and the ssh service in more detail.
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System Administration

The material in this chapter so far has focused on the use, rather than the administration, of
OpenSolaris. A crash course on the system, however, wouldn’t be complete without a look at
the system from an administration perspective. Although you can perform some administrative
tasks using a GUI, to really understand the system, you need to get down-and-dirty with the
command line. Thus, this section focuses on CLI administration.

System information

OpenSolaris provides some useful tools for discovering information about the hardware and soft-
ware of your system. A good starting place is uname -a, which provides, in order, the operating
system name, the hostname, the operating system release level, the operating system version, the
machine hardware class, the processor type, and the platform name. Here is the uname -a out-
put of OpenSolaris build 99 on a 32-bit Intel machine (050805 is the hostname):

$ uname -a
Sun0S 0S0805 5.11 snv_99 i86pc 1386 i86pc Solaris

The operating system release and version information that uname provides is listed in the
/etc/release file:

# cat /etc/release

OpenSolaris 2008.11 snv_99 X86
Copyright 2008 Sun Microsystems, Inc. All Rights Reserved.
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Use is subject to license terms.
Assembled 08 October 2008

_g:"i, For an overview of your system’s hardware and peripherals, run the Device Driver
¥ utility (System > Administration > Device Driver Utility).

For more details on the hardware, use the prtconf command:

# prtconf

System Configuration: Sun Microsystems
Memory size: 512 Megabytes

System Peripherals (Software Nodes):

i86pc

The isainfo command prints further details about the instruction set architecture of the
system:

# isainfo -v
32-bit 1386 applications
ahf sse3 sse2 sse fxsr mmx cmov sep cx8 tsc fpu

For processor information, run psrinfo:

# psrinfo -pv
The physical processor has 1 virtual processor (0)
x86 (Genuinelntel 6E8 family 6 model 14 step 8 clock 1600 MHz)
Intel(r) CPU T2050 @ 1.60GHz

The prtdiag command gives detailed information about hardware, including diagnostic infor-
mation when appropriate.

For more detailed fault information, run fmadm faulty.

For live information about process resource usage, use prstat. This command gives you a con-
tinuously refreshing snapshot of system activity, as this example shows:

PID USERNAME SIZE ~ RSS STATE PRI NICE TIME CPU PROCESS/NLWP

1213 root 5684K 3104K cpu0 59 0 0:00:00 0.2% prstat/1

690 root 9248K 4444K sleep 59 0 0:00:00 0.1% sshd/1

641 nsolter  135M  24M sleep 59 0 0:00:06 0.0% gnome-panel/1
676 nsolter 79M  18M sleep 59 0 0:00:03 0.0% clock-applet/1
668 nsolter 7708K 4000K sTeep 59 0 0:00:03 0.0% gvfsd-trash/1
644 nsolter  153M  39M sleep 49 0 0:00:07 0.0% nautilus/1
692 nsolter 8648K 2348K sleep 59 0 0:00:01 0.0% sshd/1

1036 nsolter  138M  23M sleep 59 0 0:00:06 0.0% users-admin/1
223 root 7804K 3756K sleep 59 0 0:00:02 0.0% nscd/33

1073 root 5532K 2564K sleep 59 0 0:00:00 0.0% bash/1

424 root 5096K 1948K sleep 59 0 0:00:00 0.0% automountd/4
543 root 53M  36M sleep 59 0 0:00:21 0.0% Xorg/1
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1196 root 9232K 4436K sleep 59 0 0:00:00 0.0% sshd/1
1189 root 9232K 4440K sleep 59 0 0:00:00 0.0% sshd/1
631 nsolter 9404K 5268K sleep 59 0 0:00:01 0.0% xscreensaver/1
1198 newuser 8648K 2332K sleep 59 0 0:00:00 0.0% sshd/1
9 root 12M 11M sleep 59 0 0:00:17 0.0% svc.configd/20
92 root 4788K 1544K sleep 59 0 0:00:00 0.0% dhcpagent/1
110 daemon  8880K 4456K sleep 59 0 0:00:00 0.0% kcfd/3
368 daemon  2908K 1868K sleep 59 0 0:00:00 0.0% avahi-daemon-br/1
570 root 5868K 2008K sleep 59 0 0:00:00 0.0% sendmail/l
Total: 77 processes, 213 Twps, load averages: 0.01, 0.02, 0.02

Processes and services

As with most operating systems, running programs in OpenSolaris are called processes. Open-
Solaris also adds a higher-level abstraction called a service, which can be a collection of related
processes. You'll generally manage your system at the service level, but sometimes you'll need to
deal with the actual processes.

Processes

Each process is assigned a unique numeric 1D, called the process ID (PID). You can view the
currently running processes with the ps command. The e option tells ps to list all processes,
not just the processes owned by the user executing ps, while the f option instructs ps to give
the “full” listing, including the owner, parent PID, and start time:

# ps -ef
UID PID PPID C STIME TTY TIME CMD
root 0 0 0 10:38:57 7 0:01 sched
root 1 0 0 10:38:58 ? 0:00 /sbin/init
root 2 0 0 10:38:58 ? 0:00 pageout
root 3 0 0 10:38:58 7 0:03 fsflush
root 403 1 0 10:39:41 7 0:00 /usr/1ib/inet/inetd start
root 7 1 0 10:39:02 ? 0:04 /1ib/svc/bin/svc.startd
root 9 1 010:39:03 7 0:12 /1ib/svc/bin/svc.configd
root 134 1 010:39:22 7 0:00 /usr/1ib/picl/picld
root 488 1 0 10:39:44 7 0:02 /usr/1ib/fm/fmd/fmd
root 23 1 0 10:39:09 ? 0:00 /1ib/inet/nwamd
dladm 14 1 0 10:39:07 ? 0:00 /sbhin/dImgmtd
root 559 1 0 10:39:57 7 0:00 /usr/1ib/sendmail -bl -qglbm
daemon 126 1 010:39:20 ? 0:01 /usr/Tib/crypto/kcfd
root 412 1 0 10:39:42 ? 0:00 /usr/1ib/utmpd
smmsp 556 1 010:39:52 7 0:00 /usr/Tib/sendmail -Ac -qlbm
nsolter 578 569 0 10:45:52 ? 0:01 /usr/bin/gnome-session
root 511 1 0 10:39:45 7 0:00 /usr/perl5/bin/perl /usr/1ib/intrd
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The ps command can provide additional information, such as process priority, process state,
and so on. Consult the man page for details.

REF Chapter 14 covers tools and utilities related to processes.

Signals

You'll occasionally need to terminate a process that is stuck or misbehaving. To kill a running
process, use the ki1l command to send it a signal. Most processes will die with SIGTERM, sig-
nal number 15, which is the default signal sent by ki11. Here’s an example:

#f ps | grep sleep
986 pts/3 0:00 sleep
# ki1l 986
[1]+ Terminated sleep 400
# ps | grep sleep

However, occasionally you might need to send SIGKILL, which is signal number 9:

$ ps | grep killtest

755 pts/3 0:00 killtest
$ kill 755
$ ps | grep killtest
755 pts/3 0:00 killtest
$ kill -s SIGKILL 755
$
[11+ Killed ./killtest

$ ps | grep killtest

Many system processes restart with STGHUP, signal number 1. To restart a process that accepts
SIGHUP, send it signal number 1.

B Run ki11 -1 for a complete list of signals and their numbers:

# ki1l -1

1) SIGHUP 2) SIGINT 3) SIGQUIT 4) SIGILL

5) SIGTRAP 6) SIGABRT 7) SIGEMT 8) SIGFPE

9) SIGKILL 10) SIGBUS 11) SIGSEGV 12) SIGSYS

13) SIGPIPE 14) SIGALRM 15) SIGTERM 16) SIGUSRI
17) SIGUSRZ 18) SIGCHLD 19) SIGPWR 20) SIGWINCH
21) SIGURG 22) SIGIO 23) SIGSTOP 24) SIGTSTP
25) SIGCONT 26) SIGTTIN 27) SIGTTOU 28) SIGVTALRM
29) SIGPROF 30) SIGXCPU 31) SIGXFSZ 32) SIGWAITING
33) SIGLWP 34) SIGFREEZE  35) SIGTHAW 36) SIGCANCEL
37) SIGLOST 38) SIGXRES 41) SIGRTMIN 42) SIGRTMIN+1

43) SIGRTMIN+2 44) SIGRTMIN43 45) SIGRTMAX-3 46) SIGRTMAX-2
47) SIGRTMAX-1 48) SIGRTMAX

To kill a job running in the foreground, press Ctrl+C. That sends the TERM signal to the
process.
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& Don’t kill random processes on your system just because you don’t know what
they’re doing. Many arcane-sounding processes are actually imperative for the
correct functioning of OpenSolaris.

Proc tools

The proc tools, or ptools, are a useful collection of utilities for working with processes. pgrep
returns the process ID of processes matching the search criteria provided. pki11 works just like
pgrep but also sends the resultant processes a signal, as shown in the following example:

# pgrep init

1
## pkill sleep
[1]+ Terminated sleep 100

& The pkill command matches every process containing the string supplied, so in this
example all processes with the string “/sleep” will be sent the signal.

The remaining proc tools provide information about running processes. For example, p1dd
shows the dynamically linked libraries used by the running process:

f# pldd “pgrep syslog’

469: /usr/shin/syslogd

/1ib/1ibc.so.1

/1ib/1ibnsl.so.1
/usr/1ib/locale/en_US.UTF-8/en_US.UTF-8.s0.3
/usr/1ib/locale/common/methods_unicode.so0.3
/1ib/1ibscf.so.1

/1ib/1ibuutil.so.1

This example also demonstrates how pgrep is often used in conjunction with the other ptools.
Recall that the backticks cause the expression inside to be evaluated and return the standard
output from that expression.

Other useful proc tools include pstack, pflags, and pfiles. Consult the proc(1) man page
for more details.

- | §1EF See Chapter 14 for more discussion about the proc tools.

Resource management and scheduling classes

Like in all modern multiprogramming operating systems, the physical processors, memory, and
other resources are shared among the various processes running on the OpenSolaris system.
OpenSolaris provides many capabilities to customize the way in which these various resources
are shared, including six different scheduling classes, projects, resource caps, resource pools,
processor sets, and others.

. 53:5’%’5': Chapter 18 covers OpenSolaris resource management, including scheduling classes.

= e N
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Services

Most operating systems use the concept of processes, and most have tools similar to those men-
tioned so far in this section. OpenSolaris is unique in the UNIX world, however, in its addition
of the service concept, called the Service Management Facility (SMF). While a service in OpenSo-
laris is generally anything that can be started or stopped, it’s usually a process or a collection of
processes that work together to provide a service. OpenSolaris provides a common mechanism
for defining, starting, and stopping services, replacing the UNIX rc scripts, and for managing the
services, obviating the need to manage them at the process level. The service concept also allows
for unified property management, theoretically replacing ad hoc text-based configuration files.
However, you'll find that OpenSolaris is still replete with text-based configuration files.

You can view the services on your system with the svcs command:

## svcs
STATE STIME FMRI
legacy_run 11:27:41 Trc:/etc/rc2_d/S20sysetup

legacy_run 11:27:41 Trc:/etc/rc2_d/S47pppd

online 11:27:14 svc:/system/power:default

online 11:27:14 svc:/system/picl:default

online 11:27:15 svc:/network/ipsec/policy:default
online 11:27:15 svc:/milestone/network:default
online 11:27:16 svc:/network/npiv_config:default
online 11:27:17 svc:/system/device/fc-fabric:default
online 11:27:17 svc:/milestone/devices:default
online 11:27:18 svc:/network/initial:default

The state of Tegacy_run indicates that the service is started by the old init mechanism. svcs
without arguments lists only online services. To view all services, use svcs -a.

Most of the system daemons you're accustomed to using on UNIX are now represented by ser-
vices. For example, sys1ogd is now the system-1og service:

J svcs system-log
STATE STIME FMRI
online 11:27:39 svc:/system/system-log:default

o }!PL\ & The -x option to svcs shows services that are degraded in some way:
AR

# svcs -x
svc:/network/device-discovery/printers:snmp (Hardware Abstraction
Layer network attached device discovery)
State: maintenance since Thu Jul 31 12:35:45 2008
Reason: Start method failed repeatedly, Tast exited with status 1.
See: http://sun.com/msg/SMF-8000-KS
See: /var/svc/log/network-device-discovery-printers:snmp.1log
Impact: This service is not running.
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The output from svcs -x gives you a log file in /var/svc/1og, where you can look for further
detail.

Services go through a life cycle, starting in the disabled state. You can enable a service with the
svcadm enable command. For example, to enable the ftp daemon, run the following:

# svcadm enable network/ftp

# svcs ftp
STATE STIME FMRI
online 12:39:14 svc:/network/ftp:default

Similarly, you disable a service with svcadm disable

# svcadm disable network/ftp

## sves ftp
STATE STIME FMRI
disabled 12:40:04 svc:/network/ftp:default

Restart a service with svcadm restart:

# pgrep syslogd

965

# svcadm restart system-Tog
## pgrep syslogd

986

You can change property values of a service with svccfg. After setting a property, you always
need to refresh the service with svcadm refresh, and sometimes restart it with svcadm
restart, as the following example shows:

# svcefg -s system-log setprop config/log_from remote = true
# svcadm refresh system-log

#f svcprop -p config/log _from remote system-log

true

# svcadm restart system-log

Users, groups, and roles

OpenSolaris, like most UNIX and Linux variants, employs the concept of a user, which is an
account that provides access to the system. Each user has a login name, a password, and other
attributes. A group is basically a collection of users. When you install OpenSolaris, the installer
gives you an option to create an initial user. Using either the GUI or the command line, you can
easily add additional users, delete users, or modify user attributes.

= In organizations, user accounts are generally stored in a network naming service such
“as NIS or LDAP. See Chapter 10 for details on these options. The examples in this
chapter apply only to local users.
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As described in the section “Running Privileged Commands” earlier in this chapter, the root user
is made a role on OpenSolaris if you create a user account in the installer. A role can be thought
of as a special kind of user. The main difference between a user and a role is that you cannot log
in directly as a role. You must first log in as a user who is assigned that role, and then you can
su to that role. (Roles and other security topics are described in greater detail in Chapter 11.)

Configuration files

Each user and role has a username, password, default shell, home directory, rights profiles,
and other properties. The user and role information is divided between /etc/passwd,
/etc/shadow, and /etc/user_attr. The group information is stored in /etc/group.

= Chapter 11 describes the user configuration files in more detail.

The users and groups GUI

OpenSolaris provides a GUI tool for managing users and groups. Select System » Administration
» Users and Groups, and you'll see a dialog similar to the one shown in Figure 3-8.

FIGURE 3-8

You can manage users and groups in this OpenSolaris GUI.

[+ & Users and Groups s=28
Users | Groups |
User name contains | 2 Clear
| User | Home | User details
nobody  / NF5 Anonymous Access User
noaccess / No Access User
nobody4 / 5un0S 4.x NS Anonymous Aci

nsolter  fexport/home/nsolter nsolter

[+ J o]

|_] Show all users and groups

@ Help © Cancel|| @OK

With this utility, you can add users and groups, delete users and groups, and modify properties
of users and groups, including assigning rights profiles (called user privileges in the GUI). You
cannot manage roles with the GUI.
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Managing users, groups, and roles with the command line

You can add a user with usermod, supplying attributes with various flags. You must explicitly
create the home directory and assign the password in separate commands. For example, to cre-
ate a user newuser with shell /usr/bin/bash and home directory /export/home/newuser,
execute the following commands:

# mkdir /export/home/newuser
# useradd -s /usr/bin/bash -d /export/home/newuser newuser
## chown newuser:staff /export/home/newuser
# passwd newuser
New Password:
Re-enter new Password:
passwd: password successfully changed for newuser
Similarly, you create a role with roleadd.
The usermod and rolemod commands modify the properties of users and roles, respectively:
# usermod -s /usr/bin/csh newuser

Finally, userdel and roledel delete users and roles.

Similarly, groupadd, groupmod, and groupdel manage groups.

TG N B § Chapter 11 describes rights profiles, roles, and their interaction with users in more
H G@J}QW\A—\:@E@ detail.

Utilities
A few utilities enable you to see who's currently online on the system, and who has recently
been online. The who command shows you who’s logged in:

# who

nsolter console 2008-07-31 11:32 (:0)

nsolter pts/3 2008-07-31 11:39 (192.168.1.105)
test pts/2 2008-07-31 13:38 (192.168.1.105)
newuser pts/4 2008-07-31 13:38 (192.168.1.105)

The w command gives a bit more information:

#w
1:38pm up 2:12, 4 users, load average: 0.02, 0.02, 0.02
User tty login@ 1idle JCPU PCPU what
nsolter console  11:32am 26:53 /usr/bin/ctrun -1 child -i none
nsolter pts/3 11:39am 9 W
test pts/2 1:38pm 1 -bash
newuser pts/4 1:38pm 1 -csh
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Finally, the Tast command shows you a history of logins:

# last

newuser pts/4 192.168.1.105  Thu Jul 31 13:38 still logged in
newuser sshd 192.168.1.105  Thu Jul 31 13:38 still logged in
test pts/2 192.168.1.105  Thu Jul 31 13:38 still logged in
test sshd 192.168.1.105  Thu Jul 31 13:38 - 13:38 (00:00)
nsolter pts/3 192.168.1.105  Thu Jul 31 11:39 still logged in
nsolter sshd 192.168.1.105  Thu Jul 31 11:39 - 13:38 (01:58)
reboot system boot Thu Jul 31 11:26

reboot system down Wed Jul 30 12:11

Storage and file systems

The OpenSolaris directory structure is set up much like the standard System V configuration,
which should be somewhat familiar to you if you've used other System V, BSD, or even Linux
systems. The main difference between OpenSolaris and these other systems is that OpenSolaris
uses ZFS, the innovative file system first introduced in Solaris 10.

Disks and ZFS

In OpenSolaris, disk device names show up in the file system under /dev/dsk, for block-level
access, and /dev/rdsk, for raw byte-level access. The names are created by the disk device
driver, and usually follow the format c#t#d#s#. As in most operating systems, you rarely need
to modify the disk devices directly. Instead, you use the abstraction of the file systems that are
built on top of the devices.

OpenSolaris is the first operating system to make ZFS available as the root file system. ZFS has
two primary concepts: pools and datasets. A ZFS storage pool, called a zpool, is a collection of
physical storage from which you carve out datasets, which are either file systems or volumes.
ZFS volumes are called zvols. The OpenSolaris installer creates a single pool, called rpool (for
“root pool”), using the disk space you configure during installation. You can see this pool with
zpool list:

# zpool 1ist rpool
NAME SIZE USED AVAIL CAP  HEALTH ALTROOT
rpool 7.44G 3.73G 3.71G 50% ONLINE -

The installer also creates several ZFS file systems out of the rpooT, including the following:

M The root file system, mounted at /

B The home directories, mounted at /export/home

You can view all the ZFS file systems with zfs Tist.

/var, /usr, and /opt are part of the root file system; they are not separate file
systems.
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The installer also creates separate swap and dump zvols from the rpool. Both /tmp and
/var/run are mounted on swap. You can view the partitions using the interactive format
command.

= See Chapter 7 for general information on disks and file systems, and Chapter 8 for
% details on ZFS.

Mirroring the root pool

One unique feature of ZFS is its built-in support for providing data redundancy through mirror-
ing. A data mirror is simply a copy of the data on another device. If any block on either of the
physical devices fails, you can still access the data from the other device. Because the root file
system is so important, consider mirroring it so that you can still use your system even if your
primary physical hard drive fails.

Mirroring in ZFS occurs at the zpool level. In the installer, you specified the disk device on
which OpenSolaris should be installed. In this example, the rpool zpool was created on slice
€3d0s0, which you can see in the output of zpool status:

# zpool status rpool
pool: rpool
state: ONLINE
scrub: none requested

config:
NAME STATE READ WRITE CKSUM
rpool ONLINE 0 0 0
c3d0s0 ONLINE 0 0 0

errors: No known data errors

B A slice in OpenSolaris is another name for a partition. See Chapter 7 for details on
“ slices and partitions.

Suppose you have another physical disk on which you can access slice 0 with the name c3d1s0.
You can add this disk slice as a mirror on rpool with a single command:

f# zpool attach -f rpool ¢3d0s0 c3d1s0

§ ZFS boot does not work with EFI labeled disks. Before adding the new disk as a mir-
ror, use fdisk -B to create a single fdisk partition and then use format to create

VTOC slices inside the fdisk partition. Here’s what the partitions of the disk used in this example
look like:

format> fdisk
Total disk size is 4095 cylinders
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Cylinder size is 4096 (512 byte) blocks

Cylinders
Partition Status Type Start End Length %
1 Active Solaris? 1 4094 4094 100

partition> print
Current partition table (original):
Total disk cylinders available: 4092 + 2 (reserved cylinders)

Part Tag Flag Cylinders Size Blocks

0 root wm 257 - 4091 7.49GB (3835/0/0) 15708160
1 unassigned wm 0 0 (0/0/0) 0
2 backup wu 0 - 4091 7.99GB  4092/0/0) 16760832
3 unassigned wm 0 0 (0/0/0) 0
4 unassigned wm 0 0 (0/0/0) 0
5 unassigned wm 0 0 (0/0/0) 0
6 unassigned wm 0 0 (0/0/0) 0
7 unassigned wm 0 0 (0/0/0) 0
8 boot wu 0 - 0 2.00MB (1/0/0) 4096
9 alternates wm 1 - 2 4.00MB (2/0/0) 8192

If you give ZFS the whole disk it will relabel it with EFI labeling, so give it only a single slice, as
shown here. (Chapter 7 explains disk labels, partitions, slices, and names.)

After adding a mirror, ZFS automatically starts a resilver operation, which is just a sync of the
data from the original disk to the new mirror:

#f zpool status
pool: rpool
state: ONLINE
status: One or more devices is currently being resilvered. The pool will
continue to function, possibly in a degraded state.
action: Wait for the resilver to complete.
scrub: resilver in progress for 0hOm, 0.03% done, 4h43m to go

config:
NAME STATE READ WRITE CKSUM
rpool ONLINE 0 0 0
mirror ONLINE 0 0 0
c3d0s0 ONLINE 0 0 0
c3d1s0 ONLINE 0 0 0

errors: No known data errors
After the resilver completes, youw'll have a mirror of your root file system:

#f zpool status
pool: rpool
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state: ONLINE

scrub: resilver completed after Ohlém with 0 errors on Tue Aug 5
21:48:41 2008

config:
NAME STATE READ WRITE CKSUM
rpool ONLINE 0 0 0
mirror ONLINE 0 0 0
c3d0s0 ONLINE 0 0 0
c3d1s0 ONLINE 0 0 0

errors: No known data errors

In order to be able to boot from the new mirror when the primary disk fails, you need to run
installgrub (on x86 systems) or installboot (on SPARC systems) to install the boot infor-
mation. On an x86 system, this would look like the following:

# installgrub -mf /boot/grub/stagel /boot/grub/stage2 \
/dev/rdsk/c3dls0

stagel written to partition 0 sector 0 (abs 4096)

stage? written to partition 0, 265 sectors starting at 50 (abs 4146)
stagel written to master boot sector

F Chapter 8 describes ZFS mirroring and other, more efficient, techniques for increasing
it

“ the availability of your ZFS storage system.

File system layout

Table 3-10 shows the important directories on your system.

TABLE 3-10

System Directories

Mountpoint Description

/ The root of the file system

/bin Symbolic link to /usr/bin

/boot Boot files and utilities

/dev Provides file system access to devices. See Chapter 7 for details

/etc Contains system configuration files; discussed in various chapters throughout
the book

/export/home User home directories; on a separate file system from root

/1ib Libraries needed for boot, before /usr might be mounted
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TABLE 3-10 (continued)

Mountpoint Description

/opt Location for extra or third-party software

/proc procfs; provides file system access to live process information. See Chapter
7 for details.

/rpool/boot/grub Contains the GRUB menu and splash screen. See Chapter 6 for details.

/sbin Administrative commands needed for boot, before /usr might be mounted
/tmp Mounted on swap device; contents not persistent across boots
/usr Contains most commands and shared object libraries. See Table 3-2 earlier

in this chapter for details of command locations within /usr.

/var Typically used for live runtime information such as logs, statistics, and core
files. Both the system and applications use /var.

Log files

As a system administrator, it’s imperative to be able to find the log files that you need.
Table 3-11 lists the locations of some commonly used log files.

TABLE 3-11

Log Files
Name Location
System log /var/adm/messages and /var/log/syslog
SMF logs /var/svc/l1og/
su log /var/adm/sulog

See Chapters 11 and 14 for more information on OpenSolaris logs.

dAIESE

Booting and shutting down

There are a few different commands to shut down or reboot the computer from the shell,
including shutdown, init, and reboot. These commands are all privileged, so they must be
run by the root role or by a user with the required privileges using pfexec.

The most polite way to shut down or reboot is with the shutdown command because it broad-
casts a shutdown warning message to all users. shutdown takes an init state argument, which
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is a number from 0 to 6, s, or S. The states 1-4 correspond to the old run levels, while s or S
goes to single-user mode. Use 5 to shut down, and 6 to reboot. Here’s an example:

# shutdown -i 5
Shutdown started. Sat Jul 19 17:21:30 MDT 2008

Broadcast Message from root (pts/6) on 0S0805 Sat Jul 19 17:21:30
The system 0S0805 will be shut down in 1 minute

Alternatively, you can use init, which also takes an init state argument, and immediately tran-
sitions to the requested state:

# init 6

Finally, to reboot quickly and without notice to users, you can use the reboot command. This
command is generally not recommended on a multi-user system.

Managing boot environments

The combination of ZFS and the Image Packaging System on OpenSolaris provides a powerful
mechanism for upgrading and rolling back your system. OpenSolaris uses the concept of a boot
environment, which is a complete image of the system. When you upgrade your system, Open-
Solaris automatically creates a new boot environment so that you can roll back to the old image
in case anything goes wrong. You manage the boot environments with the beadm command. For
example, to list your available boot environments, run beadm Tist:

# beadm 1ist

BE Active Mountpoint Space Policy Created
opensolaris NR / 2.36G static 2008-12-01 17:03
opensolaris-1 - - 57.0K static 2008-12-01 17:55

=

. §R’EE Chapter 6 describes boot environments and beadm in great detail.

Managing GRUB and the OpenSolaris boot archive

OpenSolaris on an x86-based system uses the GNU GRand Unified Bootloader (GRUB) as its
bootloader, as described in Chapter 2. You can use GRUB to manage multiple operating system
installations on the same physical machine.

& Instead of setting up bare-metal installations of multiple operating systems on the
same machine, install a single host operating system, such as OpenSolaris, and
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use VirtualBox or some other virtualization technology to run the other operating systems as
virtual machines. Part V of this book details the various virtualization technologies available on
OpenSolaris.

Because GRUB is well-documented elsewhere, this book does not cover it in detail. However,
you should know a few things about OpenSolaris and GRUB. First, the OpenSolaris GRUB menu
can be found in /rpool/boot/grub/menu.1st. Second, you must use the version of GRUB
that comes with OpenSolaris to boot OpenSolaris. The Linux GRUBs do not know how to boot
OpenSolaris.

You can use the bootadm command to set the location of the GRUB menu. See the man
page for details. (Chapter 2 discusses some of the new OpenSolaris GRUB enhancements, and
Chapter 6 provides additional information on GRUB.)

When GRUB launches OpenSolaris, it loads into memory a ramdisk image of the key kernel
modules and data called the OpenSolaris boot archive. You won't usually need to do anything
with the boot archive directly, but if the system is not shut down cleanly, sometimes it can
become corrupted. OpenSolaris provides no failsafe boot mode, but sometimes you can get a
shell in system maintenance mode. You'll then need to use the bootadm command to update
the boot archive. Generally, to fix a corrupted boot archive from system maintenance mode, run
the following:

# svcadm clear system/boot-archive
## bootadm update-archive

If you can’t even get a shell in system maintenance mode, you'll need to boot into a different
boot environment and run the following commands (substituting the name of your corrupted
boot environment for opensolaris in the first and last command):

# beadm mount opensolaris /mnt
# bootadm update-archive -R /mnt
# beadm unmount opensolaris

Then reboot your system.

& If that still doesn’t fix the problem, repeat the three commands in the previous
example but remove the files /mnt/platform/i86pc/boot_archive and
/mnt/platform/i86pc/amd64/boot_archive before running bootadm to force it to recreate
the entire boot archive.

Consult the bootadm(1M) man page for more details on the bootadm command.

& Booting on SPARC-based systems is somewhat similar to x86 in that it uses a boot

% archive that is maintained with bootadm. However, SPARC does not use GRUB or
supply an interactive menu to select the OS to boot. Instead, you can discover the bootable
OpenSolaris instances using boot -L from the Open Boot Prom (OBP). Consult the boot (1M)man
page for more information.
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Resources

Most of the topics in this chapter are discussed in further detail elsewhere in the book, so this
section provides just a sampling of the resources available.

A great reference for the UNIX command line is UNIX System V: A Practical Guide by Mark G.
Sobell (Addison-Wesley, 1994).

References for Bash abound. Most Linux books contain a section, and there is plenty of informa-
tion online. Here are a few pointers:

B The Bash Manualisat http://fags.org/docs/bashman/bashref.html.
B The Linux Bible, 2008 Edition by Christopher Negus (Wiley, 2005).
B [Learning the Bash Shell by Cameron Newham (O'Reilly, 1998).

For vim, try these:

B www.fprintf.net/vimCheatSheet.html
B Learning the vi and vim Editors by Arnold Robbins, et al. (O'Reilly, 2008).

For internationalization, see the article at
http://docs.sun.com/app/docs/col1/767.371=en.

The OpenSolaris man pages can be found at http://docs.sun.com/app/docs/col1/40.17.

The SMF Quickstart Guide is located at
http://sun.com/bigadmin/content/selfheal/smf-quickstart.jsp.

The ZFS Administration Guide
(http://opensolaris.org/os/community/zfs/docs/zfsadmin.pdf) covers ZFS
boot and mirroring the root zpool.

A good article about Solaris and GRUB can be found at
http://sun.com/bigadmin/features/articles/grub_boot_solaris.jsp.

The OpenSolaris Virtual Console project details are available at http://opensolaris.org/
os/project/vconsole.

Summary

This chapter provided a crash course in the OpenSolaris distribution. By reading this chapter
you familiarized yourself with the GNOME desktop and the OpenSolaris command line, specifi-
cally the bash shell and the vim text editor. You learned how to use pfexec to run privileged
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commands, how to switch languages and locales, how to connect your OpenSolaris machine to
the network, and how to install additional IPS-based packages from the network repositories.
You took a peek at some of the features OpenSolaris offers as a development platform and
learned how to connect to OpenSolaris with the secure shell. The chapter concluded with an
overview of OpenSolaris system administration, including system information, processes and
services, users and groups, storage and file systems, ZFS, GRUB, and other topics related to
booting and shutting down your system.

This chapter concludes Part I of this book, but it is hoped that it has whetted your appetite for
more information about OpenSolaris. Part II dives into the details of using the OpenSolaris desk-
top, attaching printers and peripherals, and adding software.
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he crash course in Chapter 3 provided a brief introduction to the

OpenSolaris desktop environment, which is based on the GNOME

desktop project. If you're not already familiar with GNOME, at
least skim through the desktop section of Chapter 3 before reading this
chapter, which explores the desktop further. This chapter describes the
applications included in the desktop on the OpenSolaris distribution’s Live
CD. Additional applications are provided in the pkg.opensolaris.org
package repository, so if you are interested in an application that isn’t
already on your desktop, check the repository to see if it’s available.

. While the OpenSolaris distribution includes GNOME,
other desktop environments can be used with

OpenSoIarls The most prominent alternative to GNOME is the KDE desktop.

If you're interested in KDE, you may want to try the BeleniX distribution
covered in Chapter 2, which is similar to the OpenSolaris distribution but
replaces GNOME with KDE.

Desktop Customization

Chapters 2 and 3 introduced the basics of the GNOME desktop, including
how to log in, log out, shut down the system, switch between workspaces,
and navigate the menus. To make your desktop really work for you,
though, you'll want to customize it.

Desktop session

The set of desktop programs that you have running at any given time is
known as a session. When you log in, GNOME starts a session (Chapter 3
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describes the programs in the default session, which is what you use initially). Use the Sessions
preferences dialog to display and modify the programs that are part of your session. Open the
dialog by selecting System>» Preferences» Sessions. You can configure your GNOME session to
operate in one of two modes:

B Start a specific set of programs every time you log in. This is the default behavior.

B Restore the set of programs that were running when you logged out of your previous ses-
sion. You can select this behavior from the Session Options tab by checking the box for
Automatically Remember Running Applications When Logging Out.

If you choose to have a specific set of programs started at login, you can customize that set of
programs in two different ways:

B Start the desktop programs you normally like to use, and then click the Remember Cur-
rently Running Applications button on the Session Options tab of the dialog. This saves
the current state of the desktop as your default session.

B Use the Startup Programs tab in the Sessions dialog to add to or delete from the session
startup list. This can be useful if you have non-GNOME desktop programs that you'd like
to run when your desktop session starts, as only desktop programs can be recognized and
remembered by the first option.

One common program you may want to add to your session is ssh-add, which
stores your decrypted ssh private key with the ssh-agent daemon. Using
ssh-agent, you can log in via ssh to other systems without re-authenticating yourself directly
to each system. To add this program to your session, click the Add button on the Startup
Programs tab. In the dialog that appears, provide a name such as ssh-add, and specify
/usr/bin/ssh-add as the command to run. Click OK. The next time you log in, a dialog will
prompt you to enter your ssh passphrase to decrypt your ssh private key.

Locking the session

One important security feature of the desktop is its capability to lock your session while you're
away from the system, which helps prevent a malicious user or prankster from creating havoc in
your name. It’s especially important to lock your desktop if your login has any privileged access
to the system because the potential damage is obviously much greater. Desktop session locking
on OpenSolaris is provided by the xscreensaver (1) command. Normally this starts when you
log in and runs in the background, automatically locking your session after it’s been idle for a
while, but you can also manually lock the session using the desktop menu item System>»Lock
Screen. Once the session is locked, you must enter your password to unlock the session and
resume work.

You can also enter the root password to unlock a user’s locked session. This provides
“ administrators with an emergency override should a locked desktop need to be

accessed.
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In addition to locking your session, xscreensaver also includes functions to manage the
display’s power consumption and can run a variety of screensaver programs. (If you use a CRT
display, a screensaver helps prevent an image of your desktop from being permanently burned
into the display, thus saving your screen. Now that LCDs have largely replaced CRTs, this
function is unnecessary, but many users like their screensavers and use them to personalize their
systems.)

To configure xscreensaver’s behavior, select System>» Preferences)» Screensaver. Consider
shortening the period of idle time before the screen is automatically locked because the default
is 15 minutes, a rather long time for your system to be idle and unattended.

Customizing the panel

The default desktop session contains two panels. The panel across the top of the screen includes
the Applications, Places, and System menus, launchers for commonly used applications such as
the Firefox web browser, the Thunderbird e-mail client, Package Manager, and Terminal, and a
notification area at the far right with icons for power management, volume control, and so on.
The panel at the bottom provides the workspace selector at the far right, with most of the space
used by a window list that enables you to switch between active windows by clicking buttons
for each window on the panel.

Each panel is configurable; you access its configuration options by right-clicking on the panel
and selecting Properties. The Properties dialog enables you to change the edge of the screen to
which the panel is attached and to increase or reduce its size. You can choose the Autohide
option, which keeps the panel hidden unless you move the mouse pointer to the edge of the
screen, at which time the panel is made fully visible; this is most useful on systems with limited
screen real estate, such as a laptop. You can also configure the panel to display hide buttons,
which enables you to manually hide the panel when it isn’t needed. The Background tab enables
you to customize the panel’s color and opacity, or select a background image for it to display.

More interesting than configuring the panel properties is the capability to customize the items
displayed on it. Right-click on the panel and select Add to Panel to open a dialog offering a
selection of GNOME panel applets, or miniature applications, that can be added to the panel.
Some of these are quite useful, such as displaying a clock, monitoring the system or network,
showing the weather for a chosen location, or providing an electronic version of a Post-It note.
You can also add a custom launcher, which is an icon on the panel that directly launches a
specified application when you click it. The Firefox and Thunderbird icons on the standard
panel are launchers; you may want to add launchers for other applications that you fre-
quently use.

You can add or delete panels by right-clicking on a panel and then selecting New Panel or
Delete This Panel, respectively. You can add as many panels as you want; they are automatically
spread around the edges of the screen. Deleting a panel is allowed unless it is the last panel.
The right-click context menu of any item enables you to remove it from the panel, modify its
properties, or, if it is a menu, edit the menu items.
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Customizing your desktop’s appearance

All X Window-based desktops require the use of a window manager to provide basic window
behaviors such as switching focus, resizing, stacking, minimizing, maximizing, and terminating
an application window. As discussed in Chapter 3, the OpenSolaris GNOME desktop uses
Metacity as its default window manager. Metacity is a relatively simple window manager with
limited configuration options; as a result, it performs well on older systems and new GNOME
users find it easy to get started with the desktop.

The configuration options for Metacity can be accessed via System>Preferences>Windows. The
item most commonly configured is the Window Selection behavior; the default configuration
requires you to click the left mouse key in a window to assign focus to that window. By check-
ing the box labeled Select Windows When The Mouse Moves Over Them, you can change this
behavior so that you only need to move the mouse pointer within the boundary of a window to
assign focus to it.

OpenSolaris includes an additional window manager, Compiz, that you may want to use. Com-
piz relies on hardware acceleration of 3D graphics operations to provide a much richer visual
experience than the simple 2D graphics that Metacity uses. However, this means that Compiz

is only usable if your system has a video card that can provide the required hardware accelera-
tion. Fortunately, you don’t need to spend time determining this. If you're interested in trying
Compiz, select System» Preferences»Appearance. Once the Appearance Preferences dialog is dis-
played, select the Visual Effects tab, shown in Figure 4-1.

You can select from four options. None uses Metacity as the window manager; the other options
use Compiz. The difference between the last three options — Normal, Extra, and Custom — is
the specific Compiz behaviors that are configured. To see if your hardware supports Compiz,
just select one of those options. That will start Compiz immediately, which may take a few sec-
onds. If your hardware can support Compiz, a confirmation dialog asks whether you want to
keep the new settings. Otherwise, an error dialog is displayed stating that desktop visual effects
could not be enabled.

Try the Normal, Extra, and Custom options to find the setting you like best. If you select Cus-
tom and click the Preferences button, the CompizConfig Settings Manager starts (also accessed
directly via System» Preferences). You can modify an extensive set of configuration settings for
Compiz to achieve a highly custom desktop experience. Some of these merely customize the
desktop’s appearance, but you can also customize application windows (e.g., you can specify
windows that can’t be minimized or that have a fixed size, and these can use matching rules
based on window attributes to apply to specific types of windows or applications). See the
Compiz Fusion website, http://compiz-fusion.org, for detailed configuration information.

¥ You can use any X Window manager on OpenSolaris; check the various software
: " repositories for others that may already be built for OpenSolaris. You can also see
the X Window manager information site, http://xwinman.org, about other managers. (For an
introduction to the basic concepts of the X Window system, see the X(1) man page.)

106



The Desktop _

The Visual Effects tab of the Appearance Preferences dialog

B Appearance Preferences ﬂ

Theme |Background |Font5 |Inten‘ace ‘ Visual Eﬁe:ts]

None: Provides a simple
(O] @ desktop environment without
any effects,

Normal: Provides improved usability and
) \ good balance between attractiveness and
moderate performance-requirements.

- Extra: Provides more aesthetically pleasing set
(@] ;
of effects. Requires faster graphics-card.

) 'tf" Custom: Uses custom set of effects, hgreferences

0HE|P & Close

Other preferences

This section describes several other aspects of your desktop, such as screen resolution, fonts, and
themes, that you can configure through System» Preferences.

Screen resolution

The display resolution is selectable using System» Preferences>Screen Resolution. By default,
GNOME selects the highest resolution that your display reports it can support. To use a different
resolution, simply adjust the settings in this dialog.

You can also use the xrandr command to adjust screen resolution and other attributes. This
command uses the X server’s Resize and Rotate extension to modify display configuration
on-the-fly. The most likely scenario in which you would use this command is when you plug
an external projector into a laptop, because you normally need to reconfigure the X server to
access the additional display device. Using xrandr, you can reconfigure the X server on-the-fly,
without restarting your X session. You can also use this extension to rotate the display or run
mirror-image displays. See the xrandr (1) man page for details.

8 If your system has an NVIDIA display adapter, you can use the device-specific tool

“ provided by NVIDIA to configure the features of the display. To access it, select
Applications>System Tools>>NVIDIA X Server Settings. Consult the tool’s online help for assistance
in using it.
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Fonts

To adjust the fonts used by your desktop and applications, select System>» Preferences»
Appearance. In the dialog that appears, select the Fonts tab and choose your preferred font for
each class of font used in GNOME. You can also use the Rendering selections on this tab to
adjust the specific drawing behavior used in rendering the fonts to the screen. Depending on the
specifics of your system, one of the options is likely to be more aesthetically pleasing than the
others. Experiment with the selections to see what fits you and your system best.

& The system’s font configuration is collected into a series of cache files so that

the applications perform well in locating fonts. These caches are updated by the
application/font/fc-cache SMF service; see the fc-cache(1M) man page and the fontconfig
user document at /usr/share/doc/fontconfig/fontconfig-user.html for more information.
Chapter 13 provides more details on SMF.

Themes

The GNOME desktop uses a theme to configure its visual appearance. A theme specifies the

way in which controls and window borders are drawn, the colors used for the desktop and
window elements, the set of icons, and the style of mouse pointer displayed. OpenSolaris
defaults to a theme called Nimbus, which is custom-designed to give OpenSolaris a distinctive
appearance. However, several other themes are available; select System» Preferences>Appearance
and open the Theme tab. Some of the themes are designed for users with specific accessibility
requirements, such as higher contrast or larger print. You can also acquire additional themes
and add them to the system, or even design your own, either by combining elements from the
installed themes or by building your own from scratch. The GNOME Artwork and Themes
website at http://art.gnome.org is a good resource for additional themes.

Desktop Sharing

One useful X Window feature is the capability to direct an application’s display to a remote sys-
tem. The OpenSolaris desktop can remotely display the entire desktop as well, using the VNC
(Virtual Network Computing) protocol. You might use this feature to remotely troubleshoot a
system problem, or to demonstrate a program to colleagues who work in different locations.

To enable and configure desktop sharing, select System> Preferences» Desktop Sharing. The
Remote Desktop Preferences dialog, shown in Figure 4-2, opens.

Check the Allow Other Users To View Your Desktop option to share your desktop display. You
can share it in a view-only mode, or you can allow remote users to control the desktop. You can
also configure the security settings, such as confirming any attempts to access the desktop, and
a password that must be used to access the desktop remotely. The Advanced tab enables you to
configure the network port used to access the display, some additional security settings, and the
notification display when this feature is active.
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Enable desktop sharing via the Remote Desktop Preferences dialog.

[¥] [ Remote Desktop Preferences m
General Advanced|
Sharing

.| ]iAllow other users to view your desktopi

r'_’ || Allow other users to control your desktop
Users can view your desktop using this command:

http:/fdminer-laptop:5800

Security
— ‘When a user tries to view or control your desktop:
] Ask you for confirmation

|| Require the user to enter this password:

Passward:

OHE‘D ) Close

Once desktop sharing is enabled, you can connect to the display using the web browser

on a remote system by entering the URL displayed in the Preferences dialog. This requires

that the remote system have a Java runtime installed because the remote display from a

web browser uses a Java applet. Alternatively, you can connect directly to the desktop with

a VNC client such as vncviewer (1), which is included in OpenSolaris and most other

UNIX and Linux operating systems. A free Windows VNC client can be downloaded at
http://realvnc.com/products/free/4.1/winvncviewer.html. To connect using a VNC
viewer, use the system’s name or IP address and O for the display number — for example, the
following connects to a desktop shared by the system krissy:

$ vncviewer krissy:0

In addition to the desktop sharing capability of GNOME, OpenSolaris includes the Xvnc server,
which is a virtual X server that is accessed using the VNC protocol. You might want to use

this if you install OpenSolaris on a system that doesn’t have a graphics display, like many
rack-mounted server systems. You can use the Xvnc server to run a desktop session on such a
system, and access it from your laptop or desktop system’s VNC client.

The default OpenSolaris installation provides the Xvnc server in the package SUNWxvnc. Two
configuration steps are required to enable the Xvnc server and configure GNOME to use it:

& Be aware that if you restart gdm while logged into a GNOME session on the system,
“* your session will be terminated, so it’s usually a better idea to ssh into the system to
perform these steps.
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1. Configure the GNOME Display Manager, gdm, to provide login services over
TCP sessions by adding the following four lines to the gdm configuration file,
/etc/X11/gdm/custom.conf:

[xdmcp]
Enable=true
[security]
DisallowTCP=false

2. Enable the xvnc service and restart gdm (re-read the cautionary note preceding these steps
first):

# svcadm enable xvnc-inetd
# svcadm restart gdm

Now, assuming the system is named krissy, you can use the following vncviewer command
to connect to Xvnc and log in to your GNOME desktop:

$ vncviewer krissy:5900

OpenSolaris also provides the rdesktop(1) client for the Remote Desktop Protocol,
“ which is used to remotely display a Microsoft Windows desktop. rdesktop can

also be used to remotely access VirtualBox virtual machines when the VM is configured for RDP
access. See Chapter 22 for more information about VirtualBox.

Internet Applications

The most common use for a computer today is to access Internet services. OpenSolaris provides
applications for the most popular Internet services — web browsing, e-mail, and instant
messaging — as well as for Internet telephony and video conferencing.

See Chapter 5 for information on using the Ekiga telephony and video conferencing
application.

Web browsing with Firefox

OpenSolaris provides Firefox as its standard web browser. Figure 4-3 shows the openso-
Taris.com home page rendered in Firefox 3.

Firefox is available for all major operating systems and works nearly identically on each one. If
you've used it before, you'll find it quite familiar on OpenSolaris.

Firefox bookmarks are populated initially with content related to OpenSolaris, including the fol-
lowing:

B The OpenSolaris community site, opensolaris.org

B A feed of community members’ blog postings
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B Documentation and screencasts for common tasks on OpenSolaris
B The OpenSolaris defect tracking website, defect.opensolaris.org

B The OpenSolaris source code browser, src.opensolaris.org

FIGURE 4-3

Firefox is the standard web browser for OpenSolaris.

B monAug 4, 935PM Ky @

nlApincations Places System E
- — = B

[[]" & Firefox =
Fle Edit \iew History Bookmarks Tools Help
% '& ¥ E@ @ @ & ‘ http:/fwww.opensolaris.comf ball [T+ [coogle
[ Most Visited - 05 OpenSolaris.org [i|Planet OpenSolaris~  OpenSolaris* ~ Sun Microsystems =
ry
00 i
Oie® -
#© gpensoLaris
|
|
Get Share Learn
O S l 2 Welcome to the new OpenSalaris com website! Adestination for users of the new OpenSolaris
De n O a rl S- CO m release to start conversing, creating, and collaborating on the innovative apen source OS. Over
time this site will expand to become the center for OpenSolaris users o share and showcase
theirinnovations on OpenSaolaris
Why use the OpenSolaris OS you ask? It's pretty simple, you'll find it full of unigue features like
the new Image Packaging System (IPS), ZFS as the default filesystem, DTrace enabled £
Done A

Firefox is a tremendously extensible browser, which is one reason for its popularity, and

its addons.mozilla.org website offers a remarkable list of extensions for customizing its
behavior and adding functionality. If you use Firefox on multiple systems, one extension you
may want to try is the Foxmarks bookmark synchronization extension, which can synchronize

your bookmarks across all of your systems.

On OpenSolaris, your Firefox settings are stored in the .mozi11a subdirectory of
your user account’s home directory.

A couple of GNOME desktop preferences relate to web browsing: If you need to use a
network proxy for Internet access, configure that in the Network Proxy Preferences dialog
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(System» Preferences»Network Proxy). While Firefox has its own configurable network proxy
settings, its default is to read this from the desktop preferences. Configuring proxies in the
desktop preferences makes them available to all desktop applications, which is usually more
desirable.

In addition, if you prefer to install and use a different web browser such as Opera, you can
configure the GNOME desktop to use it anytime you attempt to access a website from a
GNOME application. Select System» Preferences» Preferred Applications, and configure a custom
web browser command to invoke instead of the default use of Firefox.

Because Firefox is so well known and there is little about it that is unique to OpenSolaris, it is
not covered further here. See the “Resources” section at the end of this chapter for additional
materials on Firefox.

E-mail and calendar

Electronic mail (e-mail) has long been one of the most important applications for the Internet,
and many e-mail clients have been developed over the years, including text clients, graphical
clients, and clients embedded in other programs such as the Emacs text editor. OpenSolaris
includes two graphical e-mail clients in the distribution, Evolution and Thunderbird. They
provide similar features:

B Access to e-mail accounts using POP (Post Office Protocol) or IMAP (Internet Mail Access
Protocol)

Sending e-mail using SMTP (Simple Mail Transfer Protocol)
Mail filtering, including junk mail filters

Local and web-based calendars

Local and LDAP address books

Encrypted connections using SSL or TLS

Display and composition of both plain text and HTML messages

B Disconnected operation

Choosing one is mostly a matter of personal taste, likely to be influenced by secondary factors
such as availability on other platforms.

Thunderbird development is managed by the same community as Firefox, and its look and feel

is similar to that of Firefox. Many of the add-ons for Firefox can also be used with Thunderbird,
which can be appealing to those who make extensive use of add-ons. Thunderbird is also avail-

able on Linux, Windows, and Mac OS X. To start Thunderbird, either click its icon on the main
panel or select Applications» Internet>» Thunderbird Mail and News.

Evolution is the official e-mail client for the GNOME desktop, so you can expect to find it on
other platforms that use GNOME, whereas Thunderbird isn’t necessarily included in the default
installation of those platforms. However, current versions of Evolution are not available for Mac
OS X or Windows. Evolution’s appearance was designed to be quite similar to the Microsoft



The Desktop

Outlook e-mail client, so if you have a Windows background, you may find it comfortingly
familiar. To start Evolution, select Applications»Internet>Evolution Mail and Calendar.

§ ¢ \ N For what it’s worth, all three of the authors primarily use Thunderbird.

If you aren’t familiar with either mail client, then just try each one for a few days. The setup
process for each client is similar: The first time you start it you are taken through a configu-
ration wizard to set up access to an e-mail account. The example that follows demonstrates
configuring Evolution to access a Google Gmail account using IMAP and SMTP. Many people
use the web interface to Gmail quite happily, but if you have other e-mail accounts, such as for
your workplace, that you'll be accessing using a desktop client, you may find it more convenient
to use it with a public mail service such as Gmail as well.

¥ You can get help with configuring many mail applications for use with Gmail at the
Gmail Help Center, http://mail.google.com/support.

Evolution’s setup assistant greets you with a welcome screen that doesn’t require entering any
data. Click Forward. The next screen offers to restore a saved configuration if you have one.
Assuming you don’t, click Forward. The next screen, shown in Figure 4-4, enables you to
configure your name and e-mail address. You can make this your default account, or, if you'll
have multiple accounts and want to use a different account as your default, just uncheck the box
and configure a subsequent account as your default.

FIGURE 4-4

You can choose your default account on Evolution’s Identity configuration screen or later.

(] [, Evolution Setup Assistant B3

Please enter your name and email address below. The
“optional" fields below do not need to be filled in,
unless you wish te include this information in email
you send,

Required Information

Full Name: Dave Miner

Email Address: | dave minerl@gmail.com

Optional Information

|| Make this my default account

Reply-To:

Organization:

€3 Cancel J [ @Eack J l%ﬁmardJ
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FIGURE 4-5

Configure how you receive incoming mail.

[~] 7, Evolution Setup Assistant [X]

Receiving Email

Please select ameng the following options

Server Type: l\MAD | :J

Description:  For reading and storing mail on IMAP servers.

Configuration

Server: imap.gmail. com

Username: dave.minerl

Security

Use Secure Connection: | SSL encryption &

Authentication Type

Password % ] l Check for Supported Types J

|| Rermember password

[ € Cancel J [ Back J [@EcrwardJ

Use the next screen to configure how you'll receive e-mail for the account. Figure 4-5 shows the
settings for using IMAP.

Many servers require the use of encryption to access your e-mail to ensure that the contents are
not subject to interception in transit from the mail server to your mail client. If you can’t access
your e-mail after creating the account and authenticating with your password, the most likely
problem is an incorrect encryption setting, so be sure to select the correct option for your mail
server. Most mail servers support Password authentication, but it’s a good idea to use the Check
for Supported Types button to have Evolution contact your IMAP server and attempt to deter-
mine which types of authentication it allows.

i = See Chapter 11 for information on TLS and SSL encryption.
hAmid

The next screen in the setup assistant, shown in Figure 4-6, enables you to configure Evolution’s
behavior regarding e-mail retrieval.

You'll almost certainly want Evolution to check for new messages periodically; if your mail
server has server-side filtering that places new messages into mailboxes other than your Inbox,
you'll also want to have it check for new messages in all folders, rather than just the Inbox. The
other settings here are not often changed from their defaults. With junk mail such a common
problem, you might be wondering why the Check New Messages For Junk Contents box isn’t
enabled. That’s recommended by Google, which does server-side junk mail filtering for you.
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Decide how often you want to get new messages and other receiving options.

ﬁ [T Evolution Setup Assistant m

Receiving Options

Checking for New Mail

|| Check for new messages every 10 minutes

|| Check for new messages in all folders
Connection to Server

|_| Use custom command to connect to server

Command; ssh -C -l %u %h exec fusr/shinfimapd
Folders

|| Shew only subscribed folders
|| override server-supplied folder namespace

Namespace:

Options

|_JiApply filters to new messages in INBOX on this server

|| check new messages for Junk contents
only check for jJunk messages in the INBOX folder

] Automatically synchronize remote mail locally

| @cancel | | @egack | | corward |

The other important piece of configuration for an e-mail account is sending mail, shown in
Figure 4-7.

SMTP is the standard protocol for sending e-mail on the Internet. Many providers require
encryption for sending mail, and you’ll need to authenticate using Password or some other
form of authentication. As with receiving mail, Evolution can contact the server and display
the supported authentication types. The encryption type can differ between receiving mail and
sending mail.

The final two steps of the wizard enable you to configure a name to be used for this account in
Evolution’s account list, and the time zone in which you reside. After completing the wizard,
Evolution displays its main window, where you are prompted for your password to access the
e-mail account and view the contents of your mailbox.

Once you've decided on your e-mail client, ensure that it’s selected as your mail reader in the
Preferred Applications settings (System> Preferences>Preferred Applications) so that it's used
automatically when a mailto link is selected in Firefox or other applications. Each client, when
started, offers to configure itself as the preferred mail client if it’s not already.
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FIGURE 4-7

Configure your options for sending e-mail here.

n [, Evolution Setup Assistant (%]

Sending Email

Please enter information about the way you
will send mail. If you are not sure, ask your
system administrator or Internet Service
Provider,

Server Type: | SMTP | :J

Description:  For delivering mail by connecting to a
remote mailhub using SMTP.

Server Configuration

Server:  smtp.gmail.com
] Server requires authentication

Security

Use Secure Connection: | TLS encryption | =

Authentication

Type: éPLA\N | CJ lchgck for Supported Types

Username: dave.minerl

[} Remember password

€ Cancel J l @Eack J I c%ﬁorward J

Instant messaging

One of the most popular applications on the Internet is instant messaging (IM), also called text
chat, chat rooms, or IRC (Internet Relay Chat). Instant messaging and chat rooms enable you to
carry on real-time conversations with one or more people, providing a more immediate inter-
action than is possible with e-mail. Instant messaging applications also provide an option that
reflects “presence,” which enables you to set a status that others can see to determine whether
you're available for a conversation. The OpenSolaris desktop provides the Pidgin client, which

can be used with many instant messaging services, including AOL, Google, MSN, and Yahoo,
among others.

¢ If you’re interested only in IRC, the xchat application is available in the
pkg.opensolaris.org repository as the package SUNWxchat.

To start using Pidgin, select Applications»Internet>Pidgin Instant Messenger. The first time you
run Pidgin, you are prompted to add an account for a messaging service. Figure 4-8 shows cre-
ating an account for the irc.freenode.net public IRC service.

Once you've created an account, Pidgin displays the Buddy List window (see Figure 4-9).
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Create an account on Pidgin’s Add Account dialog.

A Add Account (%]

Basic I Advanced |

Login Options
Protocol: ;'Jjﬁlﬁc =
Username: sampul
Server; irc freenode . .net
Password:
|| Remember password

User Options

Local alias:

" £ Cancel &gave

FIGURE 4-9

Pidgin’s main menu is at the top of the Buddy List.

A Buddy List E E ﬂ

Buddies Accounts TJools Help

l-:-ofﬂine =

This window has the main menu for Pidgin across the top, the center section displays your
saved chat rooms and IM buddies, while the bottom section contains a drop-down control for
setting your status, and a display for your buddy icon (see Pidgin help for information on that).
To connect to your IM accounts, click on the status drop-down and select Available. You'll be
automatically connected to your IM accounts; and if any of them requires a password, you'll be
prompted for it. You can select other statuses from this drop-down too (e.g., you can let others
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know that you're away from the computer or don’t want to be bothered, or you can add your
own custom status messages).

Once you've connected to an IM or IRC service such as irc.freenode.net, you can join a
chat room, such as ffopensolaris, which is dedicated to general discussion of OpenSolaris.

To join a chat room, select Buddies»Join a Chat in the Pidgin menu, select your IRC account,
and then enter the room name, if you know it, or click the Room List button to get a list of chat
rooms and select the one you want to join. You'll then see a conversation window like the one
shown in Figure 4-10.

FIGURE 4-10

The largest pane in Pidgin’s conversation window displays the ““chat.”

=) [ #opensolaris B5E=6

Conversation QOptions Send To

@ #opensolaris
Latest builds: SXCE 94, ON 94, IPS 94 || Clipboard: http://opensolaris. pastebin.ca

(22:44:50) The topic for #opensolaris is: Latest builds: SXCE A 230 people in room
94, ON 94, IPS 94 || Clipboard: http://opensolaris.pastebin.ca M

7 alanc-away

=

L asyd
{ bda
%% brendang
H 7.1 ChanServ
5.4 flyingparchment
“: galt-sb100
1 Gman

T jamesd

< \a

. Ternpt ¥

T /Font =k Insert (=) Smile!

The window is divided into four sections. Below the menu bar, the top area provides the name
of the chat room and the room’s current topic. Below that, the left side of the screen displays
the conversation, while the right side displays a list of people currently in the room. The bottom
portion of the display is a text area where you enter any messages you want to post into the
room’s conversation. Just type your message into this area, press Enter, and your message
appears in the conversation window. You can use the formatting buttons immediately above

the text area to format your text or insert special content such as links or smileys (also called
emoticons).

.

The menus in the Buddy List window provide access to additional features of Pidgin. You can
configure buddies for IM accounts, or chats that you'd like to save in your configuration and

¥ Private conversations with buddies use a similar conversation window; the main dif-
“ ference is that it lacks the list of people in the room.
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automatically join, using the Add Buddy and Add Chat items on the Buddies menu. Manage
your IM accounts through the Accounts menu — create additional accounts and enable or
disable existing accounts as needed. Use the Tools menu to configure various aspects of Pidgin,
including your preferences, privacy, and security features, and to enable and configure plug-ins,
which extend the functionality of Pidgin and enable you to customize it to your liking.

This section has provided only a brief introduction to Pidgin. For more information consult its
online help and its project home page, http://pidgin.im.

Media Applications

A popular use for computers these days is to listen to music or watch videos. Like other oper-
ating systems, the OpenSolaris desktop includes applications for accessing and managing digital
audio and video.

Digital Media Codecs

he main problem with using media applications on OpenSolaris and other free operating
Tsystems is obtaining the proper software, known as a codec (short for coder/decoder), to
decode the media files you want to use. The OpenSolaris GNOME desktop includes a framework
called GStreamer for media encoding and decoding, and all codecs are written as plug-ins for this
framework.

OpenSolaris includes plug-ins for raw formats such as WAV and AU, as well as the free compressed
file formats FLAC and Ogg Vorbis; and video decoding for the Theora format. However, most
commercial audio is distributed in MP3 format, and video is usually distributed in the MPEG-2,
MPEG-4, or WMV format. Because each of these formats is controlled by a patent holder that
requires royalties for each decoder distributed, OpenSolaris cannot include those plug-ins in the
freely redistributable base OS. As of this writing, you can either build your own plug-ins from source
code or purchase them from a commercial supplier. The only commercial supplier for OpenSolaris
codecs is Fluendo (www. fluendo. com).

If you’re interested in building your own codecs, the source is available through the spec-files-extra
project at Sourceforge (http://pkgbuild.sourceforge.net/spec-files-extra). Experience
with building software on OpenSolaris should be considered a prerequisite for pursuing this path,
though, because it’s fairly complex.

Audio

The primary audio application for the OpenSolaris desktop is Rhythmbox (select Applications>
Sound and Video»Rhythmbox Music Player). Rhythmbox can manage and play all of your
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digital audio — you can think of it as the GNOME version of iTunes. Figure 4-11 shows the
main window of Rhythmbox.

FIGURE 4-11

Rhythmbox is the OpenSolaris desktop’s principal audio application.
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The pkg.opensolaris.org software repository also includes the Songbird music player,
in the package SUNWsongbird.

Immediately below the menu and toolbar is a display area showing the currently playing
track, including a slider control showing the track’s progress. Drag this slider to move forward
or backward within the track. Use the controls in the toolbar to pause, move forward and
backward between tracks, or enable the repeat and random play modes.

The left side of the window is called the side pane; you can control its visibility using View> Side
Pane. It provides access to various sections of your music library, organized by sources: Music,
Podcasts, and Radio. The Play Queue shows any items you've queued for playing. This pane
also provides access to any playlists, including those that it automatically maintains: tracks that
you've rated highly, recently added tracks, and recently played tracks. Below the playlists, any
removable music devices, such as your MP3 player or a CD, are displayed. If your device is
connected but not displayed, select Music>Scan Removable Media to have Rhythmbox rescan
for the device.
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& If your MP3 player still isn’t recognized after a rescan by Rhythmbox, you may need
¥ to add a file to the MP3 player’s storage in order for Rhythmbox to recognize it. See
the Rhythmbox FAQ at http://1ive.gnome.org/Rhythmbox/FAQ for specific instructions.

The right side of the main window is used to browse or search the portion of your music library
that you selected in the left pane. You can select tracks to play immediately, add to your play
queue, and copy to your MP3 player, or you can reorganize your music library.

By default, Rhythmbox is configured to look for your music files in the Music directory under
your home directory. If you stored them in a different path, select Edit>Preferences and in the
Music tab, enter the correct location. You can also specify how the library should be structured
and how tracks are named. Once you close the Preferences dialog, Rhythmbox will scan that
directory and load all of the music files into its browsing display.

Rhythmbox can be used to import (rip) tracks from your music CDs into your library as audio
files. The tracks on commercial CDs are automatically identified using an Internet CD identifica-
tion database known as MusicBrainz (http://musicbrainz.org). Right-click the CD in the
side pane and select Copy To Library to have the CD ripped directly into your music library.
Select the details of the encoding format used in the import process using the Preferred Format
item on the Music tab of the Preferences dialog.

Any of the audio codec formats installed into the GStreamer framework mentioned earlier can
be used with Rhythmbox, which means you can choose a variety of lossy or lossless encoding
formats when ripping CDs. Rhythmbox defaults to the Ogg Vorbis format to provide more com-
pact music files, but because storage capacities have climbed in recent years, many users now
prefer to use lossless formats such as FLAC. You can also create audio CDs using Rhythmbox by
right-clicking on a playlist and selecting Create Audio CD.

& OpenSolaris also includes a specialized CD ripping application called Sound Juicer
% (accessed via Applications>>Sound & Video>CD Ripper). While it offers a few addi-
tional options for ripping specific tracks, the functionality of Rhythmbox is typically all you need
to rip CDs.

AE

To access Internet radio stations, select Music»New Internet Radio Station, enter the URL of the
station, and then select the station in the browsing pane to listen to it.

Rhythmbox can also be used to download and play podcasts. Select Music»New Podcast
Feed, and enter the URL of the podcast’s XML feed. Rhythmbox checks the podcast feeds at

a frequency you specify in the Podcasts tab of its Preferences dialog, and displays any new
episodes. You can select an episode you want to hear, have Rhythmbox download it, and then
listen.

OpenSolaris includes two other audio applications: the sound recorder and the volume control.
Use the sound recorder to record audio using your computer’s built-in microphone (if it has
one) or an external microphone such as on a USB headset. It can record in any of the audio
formats for which you have GStreamer plug-ins. The volume control application provides
functionality to mix multi-track audio if your hardware supports it, as well as control the output
volume. Access both via Applications»Sound & Video.
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Video

OpenSolaris includes the Totem Movie Player application as its primary video player. As dis-
cussed earlier, essentially all of the commercial video formats are proprietary and require that
you obtain additional GStreamer plug-ins to display video.

Once you have the necessary plug-ins, Totem is easy to use. Inserting a DVD into your DVD
drive causes Totem to start and attempt to play the DVD. Similarly, video files you download
from the Internet should automatically start Totem for playback.

Graphics Applications

OpenSolaris includes several desktop applications that can be used to create, view, edit, and
organize images.

Screenshots

It’'s common to take a snapshot of a window or an entire desktop to illustrate a program or

to provide data for diagnosing a problem. The GNOME desktop provides a tool for capturing
screenshots, which can be accessed via Applications»Graphics»Save Screenshot. In the dialog
that appears, select whether to capture the entire desktop or just a single window. You can
specify a delay before the screenshot is taken, which enables you to select the correct window
or perhaps display a specific menu item or other artifact of the program that can’t be statically
displayed before selecting the screenshot application. Once the screenshot is taken, another
dialog shows a thumbnail image of the screenshot and enables you to save the screenshot to a
file in PNG (Portable Network Graphics) format.

& You can bypass hunting through the GNOME menus and take a screenshot directly
“ using keyboard shortcuts. Pressing the Print Screen or PrtSc key captures the full
desktop, while Alt+PrtSc captures the current window. The exact label for this key varies among
system vendors. If your keyboard doesn’t have this key, you can use the Keyboard Shortcuts
preferences tool (accessed via System>>Preferences>Keyboard Shortcuts) to configure a different
shortcut.

The authors made heavy use of this tool to create the figures used throughout the book.

Viewing images

For simple image browsing and viewing, you can use the Eye of GNOME (eog) image viewer.
Select Applications>Graphics»Image Viewer, or type the eog command in a terminal. Once
you've opened an image, you can zoom in, flip, or rotate it, and save the resulting image. For
more advanced manipulation of the image, select File>»Open With>»GIMP Image Editor or
File>»Open With»Image Organizer. (There’s more information about these tools a little later in
the chapter.)

When you open an image in eog, it also makes any other images in the same directory available
as an image collection; you can move from image to image within the collection using the
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left and right arrow buttons in the eog toolbar. Eog displays small thumbnail images of each
image in the collection if you select View>»Image Collection. That enables you to skim through
the images and find ones you'd like to display. Finally, select View> Slideshow to have eog
display the images as a slideshow. The parameters for the slideshow are configured in the eog
Preferences dialog, accessed via Edit»Preferences.

Organizing and editing images
If you have an interest in digital photography, you'll rapidly accumulate photos and need a way

to organize them. OpenSolaris includes the gThumb image organizer program, which can be
started by selecting Applications» Graphics»Image Organizer.

Once you've started gThumb, it functions as a specialized file browser for image files. The left
pane in the interface displays directories, and the right pane previews images in the current
directory. Figure 4-12 shows gThumb browsing a directory with several images.

Using gThumb, you can do many basic photo editing tasks. For example, double-click on an
image and the display changes to show only that image. Use the items on the Image and Tools
menus to perform tasks such as rotate or scale the image, edit the color map, or convert the
image to a different format. You can also add comments to each image.

FIGURE 4-12

Organize your photos with the gThumb image organizer program.
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A photo album created in gThumb.
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Done

You can organize your photos in multiple ways using gThumb. You can assign multiple cate-
gories to each image, and you can create catalogs, which function like playlists on MP3 players.
You can search based on the image filename, comment, date, place, and any categories you've
assigned.

Select Create Web Album to create web albums of your photos to publish. Figure 4-13 shows an
example.

gThumb can also import images from your camera, similar to the functionality of the gtkam
digital camera browser; just select the File>Import Photos menu item. You can create copies of
images on a CD as well by selecting File»Write to CD. Finally, gThumb can be used to display
slideshows (select View» Slide Show).

ey,

?—“?;4'\-:.%.-:-’

MRS

= See Chapter 9 for information on using the gtkam digital camera browser program
“ with your digital camera.

CRO

For advanced image editing and drawing, the OpenSolaris package repository includes the
GNU Image Manipulation Program (GIMP). It’s a full-featured image editing application
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developed by the open source community as an open source equivalent to proprietary pro-
grams such as Adobe Photoshop that are usually available only on Windows and Mac OS.
Once you have installed the SUNWgnome-img-editor package, start GIMP by selecting
Applications»Graphics»GIMP Image Editor. You can edit existing graphics files or create
new ones from scratch. It provides a multi-layer model for image manipulation that enables
you to perform virtually any type of transformation to an image and to merge images into
composite images. Graphic manipulation and photo retouching are specialized topics beyond
the scope of this book; for more information, we recommend starting with the resources at
http://gimp.org to develop skills in this area.

System Administration

Currently, most system administration tasks in OpenSolaris are performed using command-line
tools, but a few graphical configuration and monitoring tools are included with the desktop.

& Additional graphical management tools are being developed by the Visual Panels

"

“ project (http://opensolaris.org/os/project/vpanels).

Users and groups

As mentioned in Chapter 3, the Users and Groups tool is used to manage user accounts and
UNIX group identities (select System>»Administration>Users and Groups). To add a user, click
the Add User button. The dialog shown in Figure 4-14 appears.

The Account tab displayed is quite similar to the user account creation step in the OpenSolaris
installer. The main difference is that the program can generate a random user password if
requested. To customize the user, select the Advanced tab, shown in Figure 4-15.

The Advanced settings are based on the profile that’s selected; each profile specifies the user’s
home directory, shell, group, and privileges, as well as the numeric range to use in generating
the user ID. You can modify any of these values as necessary, but the profile provides initial set-
tings that should be appropriate for most users.

i See Chapter 11 for details about the user privileges available for assignment in the
tool, which are properly known as execution or rights profiles.

CROSS-RI

You can create, modify and delete the user profiles used in the Users and Groups tool by click-
ing the Edit User Profiles button. If you frequently create users with similar attributes, such as
default group membership or home directory path, you'll likely want to create additional user
profiles to consistently define those attributes.

You can manage group memberships by selecting the Groups tab, where you can add, modify,
or delete groups, including the users who are members of each group.
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FIGURE 4-14

Add a user account here.
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FIGURE 4-15

Advanced settings for user accounts
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Keyring Manager

One problem all computer users face today is how to remember a plethora of passwords, as
many services require entering a password to gain access. Ideally, you want to use separate
passwords for each application or service, but it’s impractical for a person to remember more
than a few unique passwords. For your convenience, the desktop offers the Keyring Manager
application, which other applications can use to store and retrieve passwords. It's modeled as
keys on a keyring and is secured with a single password that must be provided to read any of
the passwords stored in the keyring. This enables you to use unique passwords per service,
reducing the risk of disclosure of any single service password, but it requires you to choose an
especially strong and secure password to secure the keyring.

& Firefox can store website passwords for you, but it uses its own key store, rather than
* the GNOME keyring.

Usually, you won’t need to interact directly with the Keyring Manager application; instead,
keyring-enabled applications store and retrieve the passwords on your behalf — you only need
to provide your keyring password to authorize the operation. This is how Pidgin, for example,
saves any passwords for your IM service if you allow it to do so. However, you may occasionally
need to perform maintenance on the keyring, perhaps to change an obsolete password (although
applications using the keyring usually do that on your behalf). If so, run the Keyring Manager
by selecting System>Administration>Keyring Manager.

& Surprisingly, the current version of Keyring Manager included in OpenSolaris

% doesn’t include an option to change the master password for a keyring, so

don’t forget your master password. If you do, your best option is to remove the keyring file,
~/.gnome2/keyrings/default.keyring, so that it will be recreated when you store
passwords in it, but be aware that this also deletes all of the passwords stored on the keyring.

Disk Usage Analyzer

The Disk Usage Analyzer tool can be used to provide a graphical display of your disk space
usage. To start it, select Applications»System Tools»Disk Usage Analyzer. Once the main
window appears, use the toolbar icons to select a folder or file system to scan. After the scan,
the window will look similar to the one shown in Figure 4-16.

The left pane in the window displays a table of the folders within the selected folder or file
system (in this case, /usr was selected). You can sort the table by any column in ascending

or descending order by clicking on the column’s heading. The right pane displays a usage

map for the selected folder; as you select different folders within the table, the map changes to
display the usage within that folder. If you hover the mouse pointer over any colored area of
the map, it displays a tooltip identifying the folder corresponding to the map segment, along
with the folder’s size. The map’s center section represents the folder at the top level of the scan,
with folder subtrees extending out radially. This can help you quickly find the major space
consumers within a directory tree.
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FIGURE 4-16

The Disk Usage Analyzer has a sortable table in the left pane and a usage map in the right.
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Currently, the Disk Usage Analyzer is not aware of ZFS. Because each file system in
ZFS shows free space within the pool as its own free space, the Disk Usage Analyzer
can greatly overestimate the total file system capacity. The ZFS pool containing the /usr file sys-
tem in Figure 4-16 actually had only 6.6GB of free space when this example was generated, but
it contained approximately 40 datasets, so the free space was multiplied many times over its true
capacity. In addition, the dataset containing /usr in this example has compression enabled, which
is not reported by the Disk Usage Analyzer. Be aware of this when estimating space usage if you
move data from a compressed dataset to a noncompressed dataset. See Chapter 8 for more infor-
mation on ZFS.

Log File Viewer

The Log File Viewer application (Applications»System Tools>Log File Viewer) enables you to
browse the various system and service log files, displaying and filtering the messages recorded
in them. The window’s left pane displays a list of the various log files on OpenSolaris; once
you select a file, its contents are displayed in the right pane. You can use the calendar in the
lower-left pane to display messages from a specific date, and select the View>Filter menu item
to filter any log messages to those that are of interest.
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System Monitor displays system performance information.

[+] [Z] system Monitor = =83

Monitor Edit View Help
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CPU History

| crul sanm
Memory and Swap History
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[ | used swap: Obytes of 20GB 0.0%

Network History

E_ Received: 0O bytes/s Total: 18.2 MiB

| sent: 0 bytesfs  Total: 7.8 MiB

I;‘c :Qf}:ja’} ﬁf‘ See Chaptet‘ 14 for i.nformation on the system logs, and Chapter 13 for information
- =% on the service logs listed under /var/svc/log.

Performance Monitor

The Applications»System Tools>Performance Monitor menu item starts the System Monitor
application, which provides information about the processes running on your system, usage
of CPU, memory, and networking, and space usage of your file systems. The data available
through this application is essentially the same as you'd obtain using the prstat, vmstat,
mpstat, netstat, and df commands, presented in a more attractive and understandable
format. Figure 4-17 shows a sample display from this application.

I; (u i) er:_}l}ﬁr‘ See Chapter 14 for more information on system monitoring.
%

—d-

Power management and statistics

Power consumption of computer systems is a hot topic, and the OpenSolaris desktop includes
the GNOME Power Manager to assist you in managing your system’s power consumption. Power
Manager is started as part of the default session, and the notification area on the right side of
the panel includes an icon for power management status; hover the mouse pointer over the icon
to check battery charge status if you're using a laptop. You can configure Power Manager using
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System» Preferences»Power Management, controlling display brightness and CPU performance
when on battery and AC power, as well as the behavior when closing the lid of a laptop. You
can also configure the icon displayed in the notification area and behavior of the system when
the power button is pressed.

& If you're running OpenSolaris on a desktop system that does not have CPU frequency
* scaling capability, you may want to remove Power Manager from your session
because it has no function to perform. You can check this using the following command:

$ kstat -m cpu_info -i 0 -s supported_frequencies_Hz

If the output shows only a single value for supported_frequencies_Hz, then CPU frequency
scaling is not available.

Power Manager also provides graphical displays of the system’s power behavior, which can be
accessed by selecting Applications»System Tools»Power Statistics; you may need to enable this
menu item using the menu preferences, accessed by selecting System» Preferences»Main Menu.
See the tool’s online help for explanation of the different graphs available.

= See Chapter 5 for more information on OpenSolaris power management.

Other Applications

The OpenSolaris desktop includes several other tools for specific tasks, which can be found on
the Applications>Accessories menu:

B Archive Manager — Enables you to archive groups of files into a single file, or extract
files from an archived file, including compressed archives

B Calculator — A desktop calculator with scientific and financial modes

B Character Map — A graphical interface for entering characters from other scripts into
your documents

B PDA Synchronization — A tool for synchronizing calendar, contact, and e-mail data
with a personal digital assistant (PDA)

B Text Editor — A graphical text editor with extensions that can help with viewing and
writing code in a variety of languages

OpenSolaris also includes several accessibility features in the base OS that enable the system to
be used by those with physical or visual impairments. Accessibility is a major area in which Sun
has contributed to the GNOME community, so these features work well on OpenSolaris. The
accessibility features include an onscreen keyboard, predictive text entry, and a screen reader
and magnifier application. An Accessibility community group was recently created in the Open-
Solaris community to provide a forum for advancing this work further.
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Troubleshooting

There are two phases of desktop startup problems you might run into: X server startup prob-
lems, which prevent you from seeing a graphical login screen, leaving you at a text console login
prompt, and GNOME session startup problems, whereby you see the graphical login screen and
your password is authenticated, but the GNOME session doesn’t start and returns you to the
login screen. This section describes some basic troubleshooting steps you can take to determine
what's wrong.

N { =S8 Unlike Linux and BSD UNIX systems, OpenSolaris does not by default enable multi-

SRS ple virtual consoles. Therefore, after the GNOME login screen has started, you can’t
switch back to a text console login with keystrokes such as Ctrl+Alt+F1. The OpenSolaris Virtual
Console project at http://opensolaris.org/os/project/vconsole is working to add this fea-
ture to OpenSolaris. See the project web site and the vt(7l) man page for information on virtual
console support.

X server startup

Unlike some operating systems that use X, OpenSolaris does not create a configuration file for
the X server, instead relying on the X server’s auto-configuration capability to find and load the
correct display driver and configure it to use your monitor at its optimal resolution. However,
this auto-configuration process can fail, so you may need to resort to examining the X server
logs and creating a configuration file.

The X server log is located at /var/1og/Xorg.0.10g; the log from the previous startup is
automatically renamed to /var/1og/Xorg.0.10g.01d, so you can compare them to help
identify any problems. One common source of problems is using an older monitor that doesn’t
provide Extended Display Identification Data (EDID) settings for the X server to use. If you're
not getting the resolution you expect from auto-configuration, this is very likely to be the
problem, and you need to create a configuration file.

The X server configuration file you create must be placed at /etc/X11/xorg.conf. Con-
figuring X is fairly complex, so the best way to start is to use the server’s auto-configuration
capability to generate a configuration file. First, log in to a text console session because X cannot
already be running. If you're already logged into an X desktop, you can disable the GNOME
Display Manager:

# svcadm disable gdm

This immediately terminates your X session and returns you to the console login prompt. From
there, log in and start X using the following;

# /usr/X11/bin/Xorg -configure
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This command creates the file /xorg.conf.new. You can then edit this file to customize your
configuration and then copy it to /etc/X11/xorg.conf when you're ready to use it. Finally,
you need to re-enable GDM to start a new X session:

# svcadm enable gdm

& If your system has an NVIDIA graphics interface, you can use the NVIDIA X Server
¥ Settings tool (Applications> System Tools) to create a configuration file that can
exploit the NVIDIA driver’s unique features.

GNOME session startup

If you see the graphical login screen and your username and password are accepted, but you
can’t log into your desktop, there are a few steps you can try to identify the problem.

First, select a different session from the login screen. Click the Options button and then choose
Select Session. In the dialog that appears, you can choose from several sessions. The default is
your last session, normally the GNOME session, which is also shown in the list, so choosing
either of these options usually provides the same result.

& Your last session is stored in the file .dmrc in your home directory.

The other selections on the Sessions dialog enable you to try various troubleshooting options.
The Failsafe GNOME session starts GNOME but does not use any of your session customiza-
tions, so if you suspect that something you've configured in your session preferences is the
problem, try this option to help you confirm that. The Failsafe Terminal session doesn’t start
GNOME at all, but instead starts the X server and then starts only an xterm terminal, with no
window manager. This is a good fallback if the failsafe GNOME session fails because it allows
you to work around problems with GNOME components such as the session manager or the
window manager. The final session you can select is one that runs an Xclient script; this is
often useful for those who want to use older X window managers that aren’t integrated into the
GNOME desktop structure.

Once you log in to one of the failsafe sessions, examine the .xsession-errors file in your
home directory to determine what might be causing the error. This file captures the standard
error stream from all of the programs started by the GNOME session manager, so the cause of
a failure to start the GNOME desktop is likely be found here.

Resources

General information on GNOME can be found at its home page, http://gnome.org.

Information on the X.org X server used in OpenSolaris is available at http://x.org.
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Information on the Compiz window manager can be found at two sites, http://compiz.org
and http://compiz-fusion.org.

A comprehensive directory of X window managers is available at http://xwinman.org.
Additional GNOME themes can be downloaded from http://art.gnome.org.

The GIMP image editor documentation is available at http://gimp.org.

The Pidgin instant messaging client project is hosted at http://pidgin.im.

Information on both Firefox and Thunderbird is available through http://mozilla.com.

Summary

In this chapter you learned how to configure the OpenSolaris GNOME desktop, explored many
of the more prominent applications, and learned how to troubleshoot basic X and GNOME
problems. You should now have a comfortable OpenSolaris desktop configuration and be ready
to move on to exploring the rest of OpenSolaris in greater depth.
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f your computer system consisted solely of a CPU, disk drive,

keyboard, and display, it would be useful, of course, but many other

devices can be used to extend the tasks your system is capable of
performing. The generic term used in the computer industry for these
devices is peripherals.

Printers and scanners enable you to convert between electronic and paper
documents. Digital cameras enable you to record and share images of

all types. Webcams and audio headsets enable you to use the Internet

for cheap video conferencing and telephony. When equipped with all of
these devices, your computer system becomes an essential tool for many
parts of your life. In this chapter, you'll learn how to use these and other
peripherals with OpenSolaris.

CRO S o = Storage devices are discussed in Chapter 7.

Printing

Printers are among the oldest type of peripherals for computer systems.
During the era of mainframes and batch processing, users didn’t directly
interact with computer systems often; instead, programs were submitted
on media such as tape or punch cards, executed, and the results written
to other media or printed on a line printer. Modern computer systems are
interactive, of course, and mostly use printers that are based on laser or
ink-jet technologies that can produce high-resolution graphics and color
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not imagined with the old line printers. However, the terminology associated with line printers
persists in UNIX-type systems with commands such as 1p, 1pr, and 1pg. OpenSolaris retains
the legacy printing system designed in the days of line printers, updated to provide improved
ease of use and support for a wide range of printing devices.

Automatic printer configuration with Presto

The most recent work in OpenSolaris printing comes from the Presto project, http://
opensolaris.org/os/project/presto/, which is developing automatic printer configu-
ration capabilities. You may have already encountered it if you've booted the OpenSolaris live
CD on a system with an attached printer.

Configuring locally attached printers

Figure 5-1 shows the dialog that is displayed when an attached printer is detected by Presto.

FIGURE 5-1

Presto printer configuration dialog
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When OpenSolaris detects that a printer is attached to the system, this dialog enables the user
to configure the printer. In this case, the printer is attached to the system via the USB interface,
and OpenSolaris is able to use USB’s device description properties to determine its manufacturer
and model number. OpenSolaris has a driver for this printer model, so that is supplied as the
suggested configuration for the printer queue, but you can select an alternative manufacturer or
model if necessary. See the section “PPD (PostScript Printer Description) management” later in
this chapter for more details on OpenSolaris printer driver support. You can also specify a dif-
ferent name for the printer and provide a description that will be useful to you and your users
in identifying the printer’s characteristics. Finally, you can specify that this queue should be the
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default queue for your system, meaning that any print jobs not sent to a specific printer queue
will be directed to this one.

Once you're satisfied with the configuration of the printer, click the Add button to configure
the queue.

= The Add Printer Queue dialog shown in Figure 5-1 is provided by the ospm-applet
=% application, which is part of the default GNOME desktop session. See Chapter 4 for
more information on the GNOME desktop.

&= If your printer is attached using the older parallel port technology, Presto will not
“ automatically detect it. See the section ‘“Manual printer configuration” later in this

chapter.

Configuring network-attached printers

Presto works very well for configuring USB printers, which is now the technology used to attach
virtually all printers directly to computer systems. However, an increasing number of printers
now sold can be attached to wired or wireless networks and accept print jobs directly from any
system on the network. If you have this type of printer on your network, Presto can automati-
cally configure it as well, although the configuration process operates somewhat differently from
that of an attached USB printer.

In the case of USB, Presto receives a notification from the kernel as soon as a printer is plugged
into the system; this triggers a query of the device properties from the printer, the results

of which are then used to populate the Add Printer Queue dialog shown in the previous
section. Most systems have only one or two printers directly attached, so these dialogs are not
distracting. However, a large number of network printers can be detected, so displaying the Add
Printer Queue dialog when each is found would likely be annoying to users. In addition, most
network printers do not announce their presence; to detect them, Presto must use a polling
mechanism to query the network. It is not desirable to have every system on your network
polling the network constantly to detect printers, as this generates some load on the network
and the printers.

To detect network printers, Presto supplies an SMF service, svc:/network/device- discov-
ery/printers:snmp, which implements polling for network-attached printers. This service is
disabled by default on OpenSolaris but can be enabled using the following command:

# svcadm enable printers:snmp

= Chapter 13 describes SMF service management.

Aol
Once enabled, this service sends a broadcast SNMP message to the local network; most
network-attached printers will respond to this message. OpenSolaris print servers do not
normally respond to this message because they are not configured to advertise printers via

137




m Using OpenSolaris

138

SNMP. Presto automatically creates a print queue for each printer that responds, and displays

a notification icon in the GNOME message tray. The SNMP discovery service continues to
broadcast messages periodically and add queues as additional responses are received. The
default interval between messages is 60 seconds, but you can control this by modifying the
config/interval property of the service. For example, to modify the interval to five minutes,
use the following commands:

# svccfg -s printers:snmp setprop config/interval=integer: 300
# svcadm refresh printers:snmp
f# svcadm restart printers:snmp

Manual printer configuration

If your printer is one that can’t be configured automatically using Presto, perhaps because your
print server doesn’t advertise its printers using SNMP, or you have more complex printing needs
than the automatic configuration tools support, then you'll need to configure your printing
manually. OpenSolaris provides two printing subsystems, including graphical and command-line
tools for managing printers in each printing system; this section provides guidance in selecting
and using a printing system on OpenSolaris.

Before you begin, it's helpful to understand a few basic concepts in the OpenSolaris printing
model. Each printer is attached to a port, which can be USB, a parallel port, a serial port, or

an address on the network. Each printer has one or more queues associated with it; you can

use multiple queues to offer different options, such as single-sided or duplex printing, print
quality, or size of paper. In this chapter, the term “printer” is generally used because most of the
time a printer has only a single queue associated with it, but a queue is in fact the object that is
configured. You can also group related printers into a class, enabling them to behave as a virtual
print service.

i Printer classes are not discussed in this book; consult the OpenSolaris documentation
“ for specific information on configuring printer classes.

To print a document, a user must submit a job to a queue, which may transmit the job to a
remote system if the printer is not directly attached to the local system. In processing the job,
the print server will apply one or more filters, which convert the document into a format that
the printer can understand and apply to paper. Finally, each printer has a driver associated with
it, which is used by the operating system to communicate with the printer.

Selecting a print service

Your first decision in setting up printing is to select the print service your system will use.
OpenSolaris continues to offer the traditional System V UNIX LP subsystem, which has been a
part of Solaris since the early 1990s. More recently, the CUPS (Common UNIX Printing System)
printing system has been added to OpenSolaris. The CUPS system has been ported to most
UNIX-like platforms and is now sponsored by Apple.
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The two print systems offer similar capabilities; both have graphical or web-based interfaces for
configuration, and share similar, though not identical, command-line interfaces. The principal
difference between them at this writing is that the automatic configuration capabilities of Presto
work only with the LP system, not CUPS, though it’s expected that CUPS will be supported in
the future. Which one should you choose? Most likely, your choice is best based on familiarity:
If you have used CUPS on Linux (and found it acceptable), then using CUPS on OpenSolaris
will offer a similar experience. If your background is primarily with earlier versions of Solaris,
then the LP system may be more to your liking. If you're not familiar with either one, then we
recommend CUPS, as its web-based administrative interface is more comprehensive than the
graphical utilities included for the LP system, and it provides better support for setting options
such as duplex printing on print queues. In addition, the knowledge that youll gain will be
more portable to other systems, such as Linux and Mac OS X.

If you decide to use CUPS, you may need to first install it from the OpenSolaris package reposi-
tory using the following command:

# pkg install SUNWcups

You can check, and select, the print service configured for your system using the
print-service command. Use the following to query the currently configured service:

# print-service -q
active print service: 1Ip

The preceding means that the traditional SVR4 LP system is configured as the print service.
The -s option is used to select the print service:

# print-service -s cups
disabling LP services ...
enabling CUPS services ...
f# print-service -s 1p
disabling CUPS services ...
enabling LP services ...

The print-service command disables the SMF services associated with the print service that
is no longer being used, and enables those associated with the selected service; you cannot run
both systems simultaneously, as they will attempt to use the same network ports, and the con-
flicts can result in a system that behaves strangely.

If you already have print queues configured in the currently active print system, the -m option
can migrate them when you switch the services:

f# print-service -s cups -m

disabling LP services ...
enabling CUPS services ...

i The queue migration performed by print-service is only a basic migration of
printer names and ports. If you have configured special printing options on the
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queues in the old service, you will likely need to edit the queue configuration in the new service
to replicate the same options.

The print-service command also offers the -e option to export the printer queue configu-
ration to a file, and the -1 option to import an exported configuration file. Again, this is only a
basic migration of printer names and ports, and may require modification.

The following sections provide information on configuring and operating printers for each print
system.

Using the LP system

If you've chosen the LP system for printing, the easiest way to begin configuring your printer
is with the Solaris Print Manager, which is run using the command /usr/sbin/printmgr
or by selecting System » Administration > Print Manager from the GNOME desktop menus.
Figure 5-2 displays a screenshot of the initial display for printmgr.

FIGURE 5-2

Print Manager initial display

Naming Service: =

| OK | ‘ Reset ‘ | Cancel | ‘ Help ‘

OpenSolaris can share print queue configuration information across multiple systems using
naming services, but unless you already have a naming service set up, select files, which means
that your actions in printmgr will affect only the local system. The printers you configure with
printmgr will be listed in /etc/printers.conf.

& Naming services are discussed in Chapter 10.

Once you've selected the naming service, printmgr’s main window is displayed, as shown in
Figure 5-3.

From the printmgr main screen, you can configure options to the program using the Print
Manager menu; add, modify, and remove printers using the Printer menu; and use the Tools
menu to search for printers. The Print Manager default options — Use PPD Files and Use Local-
host For Printer Server — usually should not be modified because they offer the best results.

& One useful option that isn’t selected by default is the Show Command-Line Console
“ option. If you select this option, printmgr will display, in a separate window, the
actual commands it is using to perform printer configuration; this can help you learn how to use
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the Tp commands. All commands are recorded in the console automatically, even if the window is
not being displayed, so you can display it after the operations have completed to see the detailed
record.

FIGURE 5-3

Print Manager main window

(+] < Solaris Print Manager E=8
Print Manager Printer Tools Help
Printer Name | Printar Server | Description

Default Printer: Host: m93

Configuring a local printer
To configure a local printer with printmgr, select Printer » New Attached Printer. This will dis-
play the dialog shown in Figure 5-4.

In this example dialog, the printer is attached to the parallel port (/dev/ecpp0), and a generic
PostScript printer is being used. Parallel ports are accessed using the ecpp(7D) driver; if you
have a printer attached to a serial port, select from the serial devices listed, which will have
names such as /dev/term/a or /dev/term/b, because serial printers are accessed using
terminal devices. See the section “Serial ports” later in this chapter for more information on
serial devices.

Select the Printer Make first, and then the Printer Model selections will be filtered to those that
are within that make. Once you select the Printer Model, a driver will automatically be filled

in as recommended; if other drivers correspond to this model, they are offered as additional
selections in the Printer Driver menu. See the section “PPD management” later in this chapter for
more details on how printer drivers are selected.

One selection you may want to customize is the Banner field; this controls whether an identify-
ing banner is printed for each print job. If you are sharing the printer in an office with multiple
users, you'll probably want to always print a banner so that users can identify their documents,
but for a private printer in your home or office, disabling the printing banners saves paper and
ink or toner.

Usually, leave the Fault Notification selection as Write to Superuser, because that causes printer
faults to be displayed on the system console and in the main system log, /var/adm/messages.
Alternatively, you can have fault notifications e-mailed instead, or disable notification entirely.

The Default Printer selection is important. If you specify this printer as the default, then any
print jobs not specifically directed to another printer will be sent to this printer.
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You can also customize the user access list. By default, all users have access to a newly added
printer, but if you want to restrict this printer to specific users, then select the All item in the
User Access List and press Delete. Then type the username of a user who is allowed access and
click Add; repeat this for each user who should have access.

FIGURE 5-4

New Attached Printer dialog

(+] -3: Solaris Print Manager: New Attached Eri!E =8

Printer Name: \pust |
Printer Server: mwa3
Description: \A generic Postscript printer
Printer Port:
Printer Make:
Printer Model: ‘Generin PostScript Printer ‘ - |
Printer Driver: ‘SL i Fi ipt (reco... | - ‘
Fault Notification:
Options: Default Printer
Banner: ‘.Nmm Print Banner ‘ - |
all
User Access List:
| |
| Add | ‘ Delete ‘
[ox || mopy || Reset || cancel || Hew |

When you're satisfied with the printer configuration, click OK to add the printer. If you display
the command-line console, it shows the commands that correspond to this operation:

# /usr/sbin/1padmin -p post -s localhost -v /dev/ecpp0 -m standard foomatic
-A write -n /usr/share/ppd/SUNWfoomatic/Generic/Generic-PostScript_Printer-
Postscript.ppd.gz -o banner=always -I postscript -u allow:all

f# /usr/sbin/1padmin -p post -D "A generic postscript printer”
# /usr/sbin/Tpadmin -d post

f# /usr/bin/enable post
# /usr/sbin/accept post
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The Tpadmin command is the primary command used to configure print queues; it configures
the device or connection type, filters, content types, and access control. You can consult the
man page for details on all of the options available in 1padmin. The enable and accept
commands are discussed in the section “Managing print queues and jobs” later in this

chapter.

If all goes well, you'll see the printer listed in the printmgr main window. Test that the printer
is configured correctly by printing a test document; for the printer in this example, a command
such as the following sends a brief text file to the printer:

$ 1p -d post /etc/motd

If the printer is capable of printing PostScript, it’s a good idea to also test printing a PostScript
file to ensure that the filters are operating correctly.

W If you’ve configured a local printer on OpenSolaris and want to configure a Linux

% client to print to it, then configure the Linux print queue to use a printer type of
Generic PostScript. In this configuration, the Linux client will convert its content to PostScript
prior to sending to the OpenSolaris server, which can then convert it to the correct format for the
printer.

Configuring a network printer

OpenSolaris can also use network-attached printers. To configure such a printer, select print-
mgr » Printer » New Network Printer. The dialog displayed is very similar to the New Attached
Printer dialog; the only difference is that the Printer Port field is replaced by two fields, Destina-
tion and Protocol.

There are three protocol options, and the protocol selected determines the format of the
destination:

B BSD — The destination is the hostname or IP address of the printer and the queue name,
separated by a colon. For example, netprinter:default.

B TCP — The destination is the hostname or IP address of the printers and a port number,
separated by a colon. For example, netprinter:515.

B URI — The destination is a URI address for the printer. For example, a printer
that understands the Internet Printing Protocol might be addressed with the URI
ipp://netprinter/printers/default. You can use an smb URI to print to
Windows printers if you have smbspool (1M) installed. This is part of Samba, which
is available as the SUNWsmba package; see its man page for information on the smb URI
format. You can also use an 1pd URI, but that’s exactly the same as specifying the BSD
protocol.
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i See Chapter 10 for more information on OpenSolaris interoperability with Windows
networking.

You can consult the printer’s documentation to determine which protocol it supports and the
port number or queue name. As with a local printer, you should print a test job to verify that
the printer is configured correctly.

Submitting print jobs

Most desktop applications on OpenSolaris include printing their output as a standard menu
item, which is usually the easiest way to submit a print job. Otherwise, you can use the 1p com-
mand to submit files for printing, as shown in examples throughout this section. OpenSolaris
also includes the 1pr command for compatibility with BSD command interfaces; consult its man
page for usage information if you're not already familiar with it.

Checking printer status

The Tpstat command is used to view the status of the print system and queues. When issued
with no options, Tpstat displays the status of any print jobs you have submitted. A system sta-
tus summary is provided by Ipstat -s:

$ Ipstat -s

scheduler is running

system default printer: post
device for post: /dev/ecpp0

You can view the status of a single printer as follows:

$ Tpstat -p post
printer post idle. enabled since Tue Jul 15 00:11:53 2008. available.

To view a printer’s complete configuration, add the -1 option:

$ 1pstat -p post -1
printer post idle. enabled since Tue Jul 15 00:11:53 2008. available.
Form mounted:
Content types: application/postscript
Description: A generic postscript printer
Printer types: unknown
Connection:
Interface: /usr/1ib/1p/model/standard_foomatic
PPD: /usr/share/ppd/SUNWfoomatic/Generic/Generic-
PostScript_Printer-Postscript.ppd.gz
After fault: continue
Users allowed:
(all)
Forms allowed:
(none)
Media supported:
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Letter

A4

11x17

A3

A5

B5

Env10

EnvCh

EnvDL

EnvISOB5

EnvMonarch

Executive

Legal
Banner required
Character sets:

(none)
Default pitch:
Default page size:
Default port setting:
Options:

See the section “PPD management” later in this chapter for information on the Interface, PPD,
and Media supported sections of the 1pstat output.

Configuring a print client

If you already have a print server configured to support the BSD or IPP protocol and want to
configure OpenSolaris as a client to submit print jobs, you can do this easily using printmgr.
Select Printer » Add Access to Printer, and a simple dialog box with three fields is displayed.
You must enter the printer name, and the name or IP address of the print server. You can
supply an optional description, as well as select whether this printer will be the system default.
Viewing the command-line console output, you'll see that this is equivalent to a simple 1padmin
command. For example, to add access to the printer docprint on the server printserv, the
command is as follows:

# 1padmin -p docprint -s printserv -D ''test printer'’'
You can then print to this printer using the following:

$ 1p -d docprint /etc/motd

Managing print queues and jobs

Once you have configured printer queues, several commands are available to manage the queues
and jobs. Table 5-1 summarizes these commands; consult the man page for each for more
information. Note that print queues created by Print Manager or Presto are enabled as part

of the configuration process — you do not need to explicitly enable the queue or accept jobs
unless you disable or reject a queue.
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Print Queue Management Commands

Command Description

accept Allow print jobs to be queued

cancel Cancel a print job

disable Disable a printer

enable Enable a printer

Ipmove Move print jobs between queues
reject Disallow print jobs from being queued

In addition, you can configure the default printer for the system using 1padmin; use the follow-
ing to designate the printer “snoopy” as your default:

# 1padmin -d snoopy

It’s unlikely that you would need to do so, but should you need to restart the LP print service,
its name is application/print/server, and it can be restarted using svcadm:

# svcadm restart application/print/server

Two additional SMF services for LP are application/print/rfcl1179 and
application/print/ipp-Tistener. They receive submitted jobs from other systems
using the RFC 1179 (Ipd) or IPP printing protocols, respectively. These are automatically restarted
if you restart application/print/server.

Using CUPS

If you've enabled CUPS as your printing system, you can manage it using its built-in web
management interface. If you enter the address http://1ocalhost:631 into the location bar of
Firefox, you'll see a page similar to that shown in Figure 5-5.

Because CUPS on OpenSolaris is essentially identical to CUPS on Linux and other systems,
this book does not cover its use; consult its included documentation and the references in the
“Resources” section of this chapter for further information.

The default configuration for CUPS listens only on the loopback interface. Use
the web management interface to enable remote systems to access your CUPS

service.
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CUPS administration page

(+] @ Home - CUPS 1.3.7 - Mozilla Firefox ==
Eile Edit View History Bookmarks Tools Help

@ - - @ (2} |€ nttpiocalhost:631/ [=[#] [[C]-/ Google =Y

#®Getting Started [} Latest Headlines
Common UNIX Printing System 1.3.7
Home | Classes | | Printers |

PRRTNG
SYSTEM

Welcome!

These web pages allow you to monitor your printers and jobs as well as perform system administration tasks. Click on any of the tabs
above or on the buttons below to perform a task.

Add Class Add Printer Manage Classes Manage Jobs Manage Printers Manage Server

If you are asked for a usemame and password, enter your login usemame and password or the "root" usemame and password.

About CUPS
— CUPS provides a portable printing layer for UNIX"-based operating systems. It is developed and
maintained by Apple Inc. to promote a standard printing solution. CUPS is the standard printing system
used on MacOS” X and most Linux” distributions.

m = CUPS uses the Internet Printing Protocol ("IPP") as the basis for managing print jobs and queues and
adds network printer browsing and PostScript Printer Description ("PPD") based printing options to
. support real-world printing.

For Printer Drivers and Assistance

Visit the official CUPS site for printer drivers and assistance:

WWW . CUpS.0Tg

The Commen UNIX Printing System, CUPS, and the CUPS logo are trademarks of Apple Inc. CUPS is copyright 2007-2008 Apple Inc. All rights reserved.

Done

PPD management

Regardless of whether you are using LP or CUPS as your print system, output to your printer
will in most cases be formatted by the foomatic-rip(1) print filter, which is called by the
standard_foomatic interface program shown earlier in the Tpstat example output in the
section “Checking printer status.” This filter program converts PostScript and other file formats
into the printer’s native representation. To convert all forms of data into a variety of printer
output languages, foomatic-rip uses a repository of printer descriptions, known as the
PostScript Printer Description (PPD) repository. Each model of printer is represented by a PPD
file in the repository; the PPD file provides all the information required by foomatic-rip to
produce printable output for that specific printer model.
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If you acquire a printer for which OpenSolaris does not have a PPD file, you may find one on
the manufacturer’s website, or on the OpenPrinting website, http://openprinting.org/
printer_list.cgi. Once you have downloaded the PPD file, you must use the ppdmgr
command to install it into the OpenSolaris PPD repository so that foomatic-rip can use it.
For example, to install the FastPrinter.ppd file into the system, use ppdmgr -a:

# ppdmgr -a FastPrinter.ppd

You can then configure the printer — either manually using printmgr or automatically with
Presto. OpenSolaris maintains a cache of the descriptive information from each PPD, stored

in the file /var/1p/ppd/ppdcache, so these user interfaces can efficiently list the available
PPDs. This cache is automatically updated when you add a PPD file with ppdmgr. Additionally,
because PPD files can be installed directly into the PPD repository by packages, OpenSolaris
provides an SMF service, application/print/ppd-cache-update, which automatically
updates the ppdcache table each time the system is booted. You can restart the service to have
it run without rebooting the system:

f# svcadm restart ppd-cache-update

You may also need to acquire a driver for printers not yet supported by the distribution; you
can contact the manufacturer, check with the OpenSolaris printing community, or check the
OpenPrinting website for information on driver availability.

Scanners

Scanning support for OpenSolaris and many other platforms is provided by the SANE (Scanner
Access Now Easy) project; its main website is http://sane-project.org. SANE supports a
vast number of devices, including parallel, SCSI, and USB scanners, as well as digital still and
video cameras, from a variety of manufacturers. The SANE website provides detailed information
on devices supported by the software.

You can install SANE from the pkg.opensolaris.org software repository using the following
command:

# pkg install SUNWsane-frontend SUNWsane-backend

{ Chapter 6 provides information on installing packages from the OpenSolaris package
repository.

CROSS

Once SANE is installed, you can use the sane-find-scanner command to verify that your
device is recognized, and then use the scanimage command or xscanimage graphical user
interface to retrieve images from your scanner. SANE can also be used as a plug-in to the GIMP
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to provide integrated image capture and editing. See the man pages for these commands for
further details.

USB Devices

The Universal Serial Bus (USB) has become the most common means of attaching peripheral
devices to computer systems. Over the past 10 years, USB has made obsolete the separate
serial, parallel, keyboard, and mouse ports that were found on PCs for many years, resulting in
simpler and more flexible PC designs and reducing cable clutter for users. The original USB 1.1
standard provided for fairly slow data transfer speeds suitable for replacing those devices. The
more recent USB 2.0 standard increased the transfer speed sufficiently for use as an interface
for bandwidth-intensive applications such as disk storage, video transfer, and networking.
OpenSolaris supports a wide variety of USB devices, the details of which are discussed in the
following sections.

& OpenSolaris also includes support for USB’s principal competitor technology, IEEE
1394 (also commonly known as FireWire). However, FireWire is typically found
only in data storage and digital video devices, and is not covered in this book. See Sun’s System
Administration Guide: Devices and File Systems, http://docs.sun.com/app/docs/doc/819-2723,
for more information.

Keyboards and mice

OpenSolaris supports USB keyboards and mice. You can even have multiple keyboards and mice
connected simultaneously, and OpenSolaris will multiplex the input from all of them, a func-
tion provided by the virtualkm(7D) driver. Note that OpenSolaris also retains support for the
older PS/2 standard for keyboard and mouse devices, and virtualkm will multiplex them with
USB devices. You can view the type of keyboard used on your system using the kbd command:

$ kbd -t
USB keyboard

The kbd command supports several configuration options, including the layout. Persistent set-
tings are stored in /etc/default/kbd, from which they are read during system boot. Some

keyboards support auto-detection of their layout, but the inexpensive keyboards on most sys-

tems do not provide this, so you usually need to manually configure the layout.

= See Chapter 3 for more information on configuring keyboard layout.

Mice are usually auto-configured by the X Window System during startup, but can be manually
configured using a /etc/X11/xorg.conf X server configuration file.

149




m Using OpenSolaris

150

=8 See Chapter 4 for information on configuring the X server.

MP3 players

Because MP3 music players support the USB Mass Storage protocol, connecting one to Open-
Solaris will cause it to be automatically mounted under the /media directory, similar to USB disk
drives. After it is mounted, you can access the tracks as files and use the standard file utilities to
transfer tracks to and from the player. This functionality will work with any MP3 player.

If you have an Apple iPod, the gtkpod program provides a more complete interface for
managing its various functions; it is located in the Blastwave package repository, as the package
[PSgtkpod.

= See Chapter 6 for information on installing packages from alternative repositories.

Webcams

One of the more interesting types of USB peripherals is the webcam, a video camera that con-
nects to your computer’s USB port and provides video (and often audio, if the device includes a
microphone) input capabilities. Current USB webcams support the USB Video Class 1.1 specifi-
cation, and OpenSolaris provides the usbvc(7D) device driver to interface with devices compli-
ant with that specification. If your system has a built-in webcam, it’s likely connected internally
via USB and thus usable with OpenSolaris.

The primary application for webcams is low-cost video conferencing over the Internet using

the Session Initiation Protocol (SIP). The OpenSolaris GNOME desktop includes the Ekiga
video conferencing and voice-over-IP (VOIP) application. You can use Ekiga to conduct video
conferences with anyone else on the Internet who also has a webcam and software that supports
the SIP protocol, or you can place Internet phone calls. You may need to first install the Ekiga
application from the OpenSolaris package repository. At this writing, it is found in the package
SUNWgnome-meeting.

Connect your webcam to one of your USB ports and verify that the usbvc driver attaches to it.
You should see a message similar to the following in the system log, /var/adm/messages:

Jul 17 20:28:43 dminer-Taptop usba: [ID 912658 kern.info] USB 2.0 interface-
association (usbhia46d,8cb.configl.0) operating at hi speed (USB 2.x) on
USB 2.0 root hub: video@0, usbvcO at bus address 2

You can also verify that the device links are created:

$ 1s -1 /dev/videoO

Trwxrwxrwx 1 root root 10 Jul 17 20:28 /dev/video0 -> usb/video0
$ 1s -1 /dev/usb/videoO
Trwxrwxrwx 1 root root 66 Jul 17 20:28 /dev/usb/video0 ->

../../devices/pci@0,0/pcill79,1@1d,7/miscellaneous@7/video@0:usbvc
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If all appears well with the devices, you can start Ekiga from the GNOME menu: Applica-

tions » Internet » Video Conference. The first time you run Ekiga, it starts a wizard interface to
walk you through the initial configuration process. As part of the configuration process, Ekiga
offers the option to obtain a free ekiga.net SIP account; by creating an account, you can call,
and receive calls from, other ekiga.net users. This is not required, though, because Ekiga can

be used with any SIP conferencing service.

: SUWS The most well-known Internet telephony and video service is Skype, but unfor-

Bl * tunately Skype is not available for OpenSolaris. Because Skype uses proprietary
protocols, you cannot place calls to (or receive calls from) Skype users with Ekiga.

You can also use Ekiga for direct connection between two systems without a SIP service, if the
two systems can be directly connected to each other, as is often the case on an organization’s
internal network. To use direct connection on the Internet, both systems must have public 1P
addresses, not private addresses used behind firewalls that provide Network Address Translation
(NAT). If your system is connected via NAT, you need to use a service such as ekiga.net for
video conferencing.

! See Chapter 9 for information on NAT and firewalls.

L UTDILE
Other portions of Ekiga’s configuration process include detecting whether your network is using
NAT and configuring the audio and video devices. Usually, Ekiga detects these automatically and
you only need to confirm the settings it suggests; you can consult its online help for assistance if
you run into trouble. The last step of the wizard is a confirmation screen that displays all of the

settings you'll be using (see Figure 5-6).

FIGURE 5-6

Ekiga configuration

{0 First Time Configuration Assistant SE=8

Configuration complete - page 10/10

You have now finished the Ekiga configuration, All the
settings can be changed in the Ekiga preferences. Enjoy!

Configuration summary:

Username; Dave Miner

Connection type: TL/LAN

Audio manager: SunAudio

Audio player: /dev/audio

Audio recorder: /dev/audio

Video manager: WALZ

Video input: HP Deluxe Webcam KQ246A4
SIP URL: sip:dminer@ekiga.net

| @cancel | | @epack | | O apaly |
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FIGURE 5-7

Ekiga’s main window
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After you apply the configuration, you'll see Ekiga’s main window, which should look similar to
Figure 5-7.

The main menu bar includes Call, Edit, View, Tools, and Help menus. The Call menu includes
commands to place a call, as well as options for setting your status for receiving calls:

B Available — You are available for calls, but are prompted to answer before an incoming
call is connected.

Auto Answer — Incoming calls are connected automatically.
H Do Not Disturb — Incoming calls are blocked.

B Forward — Incoming calls are forwarded to a different SIP host, which is configured in
your preferences.

The Call menu also includes menu items to control calls that are in progress.

The Edit menu includes items to configure Ekiga, configure your preferences, and manage your
SIP accounts. The View menu items can be used to modify the display settings. The Tools menu
enables you to manage your address book, open the Chat window (Ekiga can be used for text
chats, too), view the call and session diagnostic logs, and configure a PC-to-phone account,
which you can use to call a telephone number using Ekiga.

Below the menu bar is a text field into which you enter the address you're calling. Next to it is a
button to initiate the connection after you've entered an address. After you're in a call, you click
this button to disconnect. The left side of the window displays a series of icons — from top to
bottom, they perform the following functions:

M Open the text chat window

B Toggle the display of the tabbed controls at the bottom of the window
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B Open the address book

B Toggle display of the current image from the local camera. When not in a call, you can
click this button to activate the camera, and its stream will be displayed in the center of
the window.

M Mute audio toggle
B Pause video toggle

The center of the main window is used to display the local or remote video, or both, depending
on the settings selected in the View menu; you can also choose to display the local and remote
video in separate windows. The lower part of the main window provides a set of tabs with con-
trols to adjust the audio and video and view statistics for a call in progress, as well as a graphical
dialing pad for dialing phone numbers using the mouse.

& Before you attempt to place or receive any calls with Ekiga, select Edit > Preferences,
* choose Network Settings from the list on the left of the Preferences window, and
ensure that the Network Interface option is set to listen on your actual network interface and not
on the localhost (127.0.0.1) address (because that address won’t allow you to make or receive
calls with another system).

If you don’t have anyone specific to call, you can perform a simple echo test with Ekiga by
calling the address sip:500@ekiga.net. This mirror service reflects back the audio and video
you are sending, enabling you to verify and adjust your camera settings. It also gives you some
idea of the latency between you and the ekiga.net SIP service. If your network is operating
well, there should be very little delay between the sent and received video images. Once you
have your camera adjusted and working, start calling your friends!

You can obtain much more information about Ekiga from its main project site, http://
ekiga.org.

Digital cameras

OpenSolaris supports most digital cameras available today — thanks, in part, to the flexibility
of the cameras. Digital cameras often offer two options for communication over USB: the

USB Mass Storage protocol or the USB Picture Transfer Protocol (PTP). When a camera is
connected as a mass storage device, you see messages similar to the following in the system log,
/var/adm/messages:

Jul 16 22:04:45 dminer-Taptop usba: [ID 912658 kern.infol USB 1.10 device
(usbh4b0,304) operating at full speed (USB 1.x) on USB 1.10 root hub:
storage@l, scsa2usb3 at bus address 2

Jul 16 22:04:45 dminer-Taptop usba: [ID 349649 kern.info] NIKON DSC
COOLPIX L4

Jul 16 22:04:45 dminer-Taptop genunix: [ID 936769 kern.info] scsa2usb3 is
/pci@0,0/pcill79,1@1d,2/storage@l

Jul 16 22:04:45 dminer-Taptop genunix: [ID 408114 kern.info]
/pci@0,0/pcill79,1@1d,2/storage@l (scsa2usb3) online

153



m Using OpenSolaris

154

CROSS-RI

Jul 16 22:04:45 dminer-laptop scsi: [ID 193665 kern.infol sd7 at
scsa2usb3: target 0 Tun 0

Jul 16 22:04:45 dminer-Taptop genunix: [ID 936769 kern.info] sd7 is
/pci@0,0/pcill79,1@1d,2/storage@l/disk@0,0

Jul 16 22:04:45 dminer-Taptop genunix: [ID 408114 kern.info]
/pci@0,0/pcill79,1@1d,2/storage@l/disk@0,0 (sd7) online

When a camera that supports PTP is attached, you see messages such as the following in
/var/adm/messages:

Jul 16 22:08:24 dminer-Taptop usba: [ID 912658 kern.infol USB 1.10 device
(usb4b0,305) operating at full speed (USB 1.x) on USB 1.10 root hub:
image@1l, usb_mid3 at bus address 2

Jul 16 22:08:24 dminer-Taptop usba: [ID 349649 kern.info] NIKON DSC
COOLPIX L4-PTP

Jul 16 22:08:24 dminer-Taptop genunix: [ID 936769 kern.infol usb_mid3 is
/pci@0,0/pcill79,1@1d,2/image@1

Jul 16 22:08:24 dminer-Taptop genunix: [ID 408114 kern.info]
/pci@0,0/pcill79,1@1d,2/image@]l (usb_mid3) online

Jul 16 22:08:24 dminer-Taptop usba: [ID 349649 kern.infol] usba: no
driver found for interface 0 (nodename: 'image') of NIKON DSC COOLPIX L4-PTP

These two examples are the same camera; its setup menu offers a choice between Mass Storage
or PTP mode. In Mass Storage mode, the camera appears to be a pluggable disk drive, similar to
a USB memory stick or a hard drive in a USB enclosure. When attached in this mode, the cam-
era presents itself as a PCFS file system and is automatically mounted into the file system under
the /media directory. The pictures stored on the camera are located in one or more directories
under the camera’s mount point; for example:

$ 1s /media/NO_NAME/DCIM/118NIKON

DSCN1207.JPG DSCN1240.JPG DSCN1266.JPG  DSCN1293.JPG DSCN1319.JPG
DSCN1209.JPG DSCN1241.JPG DSCN1267.JPG DSCN1294.JPG  DSCN1320.JPG
DSCN1211.JPG DSCN1242.JPG DSCN1268.JPG  DSCN1295.JPG DSCN1321.JPG
DSCN1212.JPG DSCN1243.JPG DSCN1269.JPG  DSCN1296.JPG DSCN1322.JPG

You can use image viewing and editing programs to view and edit the files, and copy them from
the camera using standard utilities such as cp and mv.

i See Chapter 4 for information on image viewing and editing tools.

To access a camera that uses PTP, you need to use the gtkam graphical interface or the
gphoto2 command. To start gtkam from the GNOME menus, select Applications » Graphics

» Gtkam Digital Camera Browser. Once started, select Camera » Add Camera; and in the dialog
that displays, click the Detect button to have gtkam automatically detect the camera model. If it
fails, then you can manually select the model and port. Then click OK and gtkam will initialize
the camera, which may take some time. Figure 5-8 shows the display during the initialization
process.
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Once the camera is initialized, you can browse thumbnails of the photos stored on the camera,
view individual photos, and copy or delete the photos. Figure 5-9 shows gtkam’s main

window browsing a camera’s photo storage. See the gtkam man page and online help for more
information.

Once you have transferred photos from your camera to your computer, you will probably want
to create digital photo albums to organize and display them. The gThumb program included

in the OpenSolaris desktop provides a simple photo album capability; see Chapter 4 for more
information on it. For more sophisticated photo albums, we recommend the excellent open
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source JAlbum software (http://jalbum.net), which is a powerful tool for organizing and
sharing digital photo albums.

Audio

Audio support in OpenSolaris has historically been weak, but it’s rapidly improving. In part,
this is because of greater standardization by manufacturers on the interfaces for audio devices;
but OpenSolaris is also, as of this writing, in the process of overhauling its audio framework
by integrating the Open Sound System (OSS) framework. The OSS framework includes a
much richer set of sound interfaces and extensive driver support (see the project page at
http://opensolaris.org/os/project/opensound for information on OSS). If you have
USB audio devices, such as speakers or a headset, you should be able to use them successfully
with OpenSolaris because the USB Audio Class specification is supported by the usb_ac(7D)
driver. If you attach a USB headset, for example, you'll see a series of messages in the system
log, /var/adm/messages, as the USB drivers bind to it. As a result, built-in or USB audio
devices should work automatically.

OpenSolaris provides the simple command-line utilities audioplay (1) and audio-
record(1) for playing and recording uncompressed audio formats such as AU, AIFF, and
WAV. The GNOME desktop also includes a sound recording application. Started by selecting
Applications » Sound and Video » Sound Recorder, it supports additional recording formats,
including FLAC, Ogg, and Speex. You can easily test that your audio devices are working
correctly using these applications.

= Chapter 4 covers the playing of MP3 and other audio and video formats.

Serial Devices and Modems

Before high-speed Internet access over DSL and cable technologies became widespread, a great
deal of Internet traffic was transmitted between systems using phone-line modems connected to
serial ports. These technologies are still used for some low-bandwidth applications such as con-
sole access to server systems.

Serial ports

For many years, it was standard for PCs to include two serial ports, which might be used to dial
in or out with a modem, or to connect a terminal server to provide console access to the PC,
once the operating system was configured to use a serial port as its console. OpenSolaris retains
some legacy configuration from this era, such as the port monitor configuration displayed with
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pmadm(1M), shown here:

# pmadm -1

PMTAG PMTYPE SVCTAG FLGS 1D <PMSPECIFIC>
zsmon ttymon ttya u root /dev/term/a I -
/usr/bin/login - 9600 Tdterm,ttcompat ttya login: - tvi925 y #

zsmon ttymon ttyb u root /dev/term/b I -

/usr/bin/Togin - 9600 1dterm,ttcompat ttyb login: - tvi92b y #

This configuration shows two ports, ttya and ttyb, attached to the serial devices
/dev/term/a and /dev/term/b. With this default configuration, users can log in via

the serial port if a device such as a terminal or terminal server is connected to the serial port
and configured with a speed of 9,600 bits per second. Consult pmadm(1M) and related man
pages for more details on port monitor configuration.

If your system has serial ports, the first port is accessed at the device /dev/term/a,
" the second is /dev/term/b, and so on.

You can also connect out over a serial port using the tip (1) command. The /etc/remote file
defines systems to which you can connect using tip. The most useful entry in the default
/etc/remote is hardwire:

hardwire:&bsol;
rdv=/dev/term/b:brf#9600:e1="C"S*Q"U D:ie=%$:0e="D:

Typing the command tip hardwire will connect you to whatever device is connected to the sys-
tem’s second serial port, which is the device /dev/term/b. If this port is in turn connected via
a cable to the serial console of another OpenSolaris (or Linux) system, then it’s possible to log in
on that system to perform administrative tasks. For example:

$ tip hardwire
connected

badboy console login: dminer

Password:

Last Togin: Thu Jul 10 22:28:03 from krissy
{badboy} ~.

[EOT]

As shown, you can type the character sequence ~. to terminate the tip session. Other special
tilde sequences are available within tip; type ~? during a tip session for help with them.

Consult the tip(1) and remote(4) man pages for more information on connecting over serial
ports.

USB-to-serial converters

While serial ports are disappearing from newer systems, you may still need to connect to an
older system over its serial port. Devices known as USB-to-serial converters are sold by several
manufacturers for this application, and OpenSolaris includes drivers for several common ones.
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Current information on supported devices is available on the Solaris USB FAQ referenced in the
“Resources” section at the end of this chapter. The following example demonstrates connecting
a Keyspan USA-19HS converter, configuring it to connect to the console port of a Sun server,
and starting a console session using tip. First, the system log /var/adm/messages shows the
converter being connected to the system:

Jul 11 19:44:21 dminer-Taptop usba: [ID 912658 kern.info] USB 1.10 device
(usbbcd,121) operating at full speed (USB 1.x) on USB 1.10 root hub:
device@l, usbsksp0 at bus address 2

Jul 11 19:44:21 dminer-Taptop usba: [ID 349649 kern.info] Keyspan, a
division of InnoSys Inc. USA-19H

Jul 11 19:44:21 dminer-Taptop genunix: [ID 936769 kern.info] usbskspO is
/pci@0,0/pcill79,1@1d/device@l

Jul 11 19:44:21 dminer-Taptop genunix: [ID 408114 kern.info]
/pci@0,0/pcill79,1@1ld/device@]l (usbsksp0) online

A device link for the converter is automatically created in devfs, as shown here:

$ 1s -1 /dev/cua/*

Trwxrwxrwx 1 root root 48 Jul 11 19:44 /dev/cua/l ->
../../devices/pci@0,0/pcill79,1@1d/device@l:0,cu
Trwxrwxrwx 1 root root 32 Feb 6 18:08 /dev/cua/a ->

../../devices/isa/asy@l,3f8:a,cu

The device path for /dev/cua/1 corresponds to the device path listed in the system log entry.
To use this device with tip, you must add an entry such as the following to /etc/remote:

cual:dv=/dev/cua/l:br#9600:e1="C-S-Q-U-D:ie=%$:0e="D:

This is just a copy of the hardwire entry shown in the previous section, with the device name
changed to reference the converter. Now it’s possible to connect to the converter port and access
the server’s console:

$ tip cual
connected

netra console login: dminer

Password:

Last Togin: Thu Jul 10 22:28:03 from china
{netra}

If you disconnect the converter, a message similar to the following appears in the system log:

Jul 11 19:51:48 dminer-Taptop genunix: [ID 408114 kern.info]
/pci@0,0/pcill79,1@1d/device@]l (usbsksp0) offline

Disconnecting the converter also automatically removes the /dev/cua link for it.

USB-to-serial converters can also be used as login ports, but to do so you need to add a port
monitor using the pmadm command. Consult the System Administration Guide: Advanced Admin-
istration, at http://docs.sun.com/app/docs/doc/819-2380, for information
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Modems

Unfortunately, OpenSolaris is unable to support the modems that are included in recent desktop
and laptop systems, which are commonly known as softmodems. These modems are designed to
provide only a simple hardware interface to the telephone network, with most of the signal and
protocol processing functions pushed up to the operating system driver. This means that the
manufacturer of the modem generally must either publish the specifications for the hardware
or provide the driver. Few of the manufacturers write drivers for any operating system other
than Windows, so most modern modems work only with that OS (hence, another term for
these modems is Winmodems). If you need to use a modem with OpenSolaris, you may be able
to locate a PC Card modem for a laptop’s PC Card slot that can be used. Otherwise, you need
to find a modem that can work with a serial interface and then connect it to your computer’s
serial port. However, most recent systems have eliminated the serial ports, so you likely need a
USB-to-serial converter as well, and then connect the modem to the converter.

Once you have a hardware modem that will work with OpenSolaris, you can use the PPP soft-
ware to connect to your ISP. The OpenSolaris PPP implementation is not covered in this book.
For assistance, consult the OpenSolaris documentation, specifically the System Administration
Guide: Network Services (see http://docs.sun.com/app/docs/doc/819-1634).

Network Interfaces

Most modern computer systems come with an Ethernet interface as a standard feature, and
laptops usually include an IEEE 802.11 (WiFi) network interface. OpenSolaris includes

drivers for many of the common network interface cards and is continually adding more,

so your system’s interfaces are likely to be supported automatically; you can use the Device
Driver Utility discussed in Chapter 2 to verify this. If they are not supported, you may be

able to locate a third-party driver by checking the manufacturer’s website. Some community
developers have also written drivers that are not integrated with OpenSolaris. The most notable
of these is the free driver collection written by Masayuki Murayama, which can be found at
http://homepage2.nifty.com/mrym3/taiyodo/eng.

If you can’t find a driver for your built-in network interfaces, you can likely purchase a PCI or
PC Card network interface for which a driver is available, either as part of the OS or from other
sources. These are generally not expensive.

Another networking technology for which some support is available in OpenSolaris is the
wireless broadband, or 3G network, technologies provided by the mobile phone networks. The
OpenSolaris Wireless Wide Area Network project, http://opensolaris.org/os/project/
wwan, has developed drivers for several of the USB and PC Card devices that are used to
connect to these networks. They operate somewhat like modems, in that PPP is used to manage
the connection to the provider. You usually need to perform an initial registration and setup
process for these networks using Windows, after which you can use OpenSolaris to connect at
any time.
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One additional characteristic of network interface drivers is that, unlike many other types

of drivers, they often have tunable properties that can be used to alter their behavior to
improve their operation or performance. The Brussels project on OpenSolaris has extended the
dladm(1M) command to provide a standard interface for configuring the interface properties
using the subcommands show-1inkprop, set-1inkprop, and reset-1inkprop. You can
view the tunable properties of your network interfaces using show-1inkprop:

## dladm show-1inkprop

LINK PROPERTY VALUE DEFAULT POSSIBLE
e1000g0 speed 100 - -
e1000g0 autopush -- -- -
e1000g0 zone - - -

e1000g0 dupTlex full -- half,full
e1000g0 state up up up,down
2100090 adv_autoneg_cap 1 1 1,0
e1000g0 mtu 1500 1500 --
e1000g0 flowctrl bi bi no,tx,rx,bi
e1000g0 adv_1000fdx_cap 1 1 1,0
e1000g0 en_1000fdx_cap 1 1 1,0
€1000g0 adv_1000hdx_cap 0 1 1,0
e1000g0 en_1000hdx_cap 0 1 1,0
2100090 adv_100fdx_cap 1 1 1,0
e1000g0 en_100fdx_cap 1 1 1,0
e1000g0 adv_100hdx_cap 1 1 1,0
e1000g0 en_100hdx_cap 1 1 1,0
e1000g0 adv_10fdx_cap 1 1 1,0
2100090 en_10fdx_cap 1 1 1,0
e1000g0 adv_10hdx_cap 1 1 1,0
2100090 en_10hdx_cap 1 1 1,0
wpi0 channel 14 -- --
wpi0 powermode ? of f off,fast,max
wpi0 radio ? on on,off
wpio speed -- -- 1,2,5.5,6,9,11,12,18,24,
36,48,54
wpi0 autopush -- -- -
wpi0 zone -- -- -
wpi0 state down up up,down
wpil mtu 1500 1500 .-

The system in this example has both a wired interface, 100090 (an Intel Gigabit Ethernet
device) and a wireless interface, wpi0 (an Intel WiFi interface). As shown, each has several
properties that can be configured, and show-1inkprop provides a view of the default values, as
well as the possible values, for each one. Configuring these properties is uncommon, however,
so this book doesn’t cover it further, but you can consult the d1adm man page for more
information on link property configuration.

! Additional information on network interface configuration may be found in
Chapter 9.
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Power Management and UPSs

Power management is an increasingly important issue in computing today as electricity costs
continue to increase, and it’s an area of active development in OpenSolaris. The Power Manage-
ment community, http://opensolaris.org/os/community/pm, sponsors several projects to
provide a variety of power management capabilities, including CPU power management, system
suspend and resume, and power management policies for servers.

If you are using a laptop with OpenSolaris, you’re probably most interested in OpenSolaris
support for suspend and resume of the system, so that you can shut your system off for
transport from home to office, for example, and pick up right where you left off when you
turn the system back on. As of this writing, OpenSolaris has only limited support for sus-
pend and resume, due to the need to update device drivers to re-initialize correctly when
the system is resumed. All SPARC desktops, and recent Sun x86 desktops, are capable of
suspend and resume, and support for additional systems, including laptops, is in progress.
The Suspend/Resume project is performing this work, and you can track its progress at
http://opensolaris.org/os/project/suspend-resume. If your system is capable of
being suspended, you can select the Suspend option on the GNOME System Shutdown dialog
(select System » Shut Down in the GNOME menus).

A logical question at this point is how to determine whether your system is suspend-capable.
As of this writing, the best answer is to try it. If you attempt to suspend and it fails, look at
/var/adm/messages to determine which driver(s) rejected the suspend request. If the system
fails to resume after a suspend, you may also be able to use /var/adm/messages to determine
which drivers failed to resume. Beyond that, consulting the OpenSolaris community and project
mailing lists is likely necessary to obtain additional help.

Server power management is also an increasingly important topic, and the OpenSolaris commu-
nity would like its operating system to be known as the most power-efficient on the market. The
Tesla project, http://opensolaris.org/os/project/tesla,is the hub for server power
management development activity in the OpenSolaris community.

Configuring power management

Power management on OpenSolaris is configured using the file /etc/power.conf. Its default
entries are as follows:

device-dependency-property removable-media /dev/fb

autopm default

autoS3 default

# Auto-Shutdown Idle(min) Start/Finish(hh:mm) Behavior
autoshutdown 30 9:00 9:00 noshutdown

cpupm enable
cpu-threshold 1s

161



m Using OpenSolaris

162

The device-dependency-property entry instructs the system to keep any removable media
devices, such as CD drives or memory card readers, powered on if the system’s display device
and monitor (represented by the device /dev/fb) are powered on.

The autopm entry controls whether device power management is enabled; it can have the value
enabled, disabled, or default. If the value is default, the behavior depends on the type
of system. If the system is a desktop or laptop system, devices are power-managed, but if it’s

a server, they are not. See the power.conf(4) man page for details on how the system deter-
mines whether it uses a server or desktop/laptop policy.

The autoS3 entry controls suspend-to-ram capability on x86 systems. As with autopm, the
default value depends on system type. When enabled, this allows the system to automatically
suspend itself if all power-managed devices have gone into their lowest power state, meaning the
system is completely idle.

You can use the autoshutdown entry to have suspend-capable systems suspend automatically
when the system has been idle for a specified period of time during certain periods of the day.
The noshutdown value in the default configuration disables this feature. It’s most useful for
office desktops, which can suspend overnight while idle.

The cpupm entry controls CPU power management. CPU power management is possible on x86
processors that include Intel's Enhanced SpeedStep or AMD’s PowerNow! technologies. The
default configuration enables CPU power management whenever the hardware supports it. You
can also control the threshold time for CPU power stepping using a cpu-threshold entry. The
default configuration uses a one-second threshold. This means that if the CPU has performed no
work in the last second, it is slowed one step, repeating until it reaches its lowest power state.
You can use a threshold value of always-on to always run the CPU at full power.

If you make any changes to /etc/power.conf, you must run the pmconfig(1M) command to
update the running system with the configuration specified in the file.

Uninterruptible power supply (UPS)

Another aspect of power management is ensuring that you don’t lose power at an inopportune
time; or that if you have a power interruption, you can perform an orderly shutdown of your
system to avoid data loss or corruption. OpenSolaris’s use of ZFS as its standard file system
greatly reduces your risk of such problems due to its inherent design characteristics, so this
isn’t as critical an issue as it once was, but allowing a system time to shut down before power
vanishes is certainly still a good idea.

You can use any uninterruptible power supply (UPS) with OpenSolaris to provide protection
against a brief power glitch — to ensure the system doesn’t go down due to a momentary inter-
ruption from events such as a lightning strike, for instance. However, to automatically perform
an orderly shutdown before the UPS battery is drained, you need to connect the system to the
UPS using a USB or serial connection, and then install software that can interface with the UPS
to interpret its signals and initiate a system shutdown. Some manufacturers provide support for



Printers and Peripherals

Solaris and OpenSolaris in their proprietary software; check the Solaris Hardware Compatibility
List (see the link in the “Resources” section at the end of this chapter) and your UPS vendor’s
website for information on vendor support.

The best-known open source project for UPS software is Network UPS Tools (see
http://networkupstools.org). As of this writing, these tools have not been packaged
for OpenSolaris, so download the source and compile them yourself. Consult the project’s
website for further details.

¢ Chapter 24 provides information on developing software on OpenSolaris.

CROSS-RI

Device Drivers

Like most other operating systems, OpenSolaris uses kernel modules known as device drivers to
communicate with both the internal and the peripheral devices attached to the system. Having
the right device drivers is critical if you're going to use all of your computer system’s capabilities.
OpenSolaris strives to have device drivers for as many devices as possible, but not all devices

are supported. Chapter 2 presented several options for determining whether your devices are
supported, so your first step is to run one of those tools if you have a question about device
support.

OpenSolaris uses a special type of file system called the device file system, or devfs, to provide
raw access to the devices on the system. You generally don’t need to interact with devfs, nor
do you often need to delve into the details of device support, but you can use the prtdiag(1M)
and prtconf(1IM) commands to examine this information when necessary.

§ See Chapter 7 for information on devfs, and Chapter 14 for more information on
prtdiag and prtconf.

CROSS-RI

One concept that is useful to understand is the mechanism by which OpenSolaris
associates device drivers with devices. This is controlled by the contents of the file
/etc/driver_aliases. Each device driver on the system registers the identifiers for the
devices it supports into this database when the driver package is installed. This is just an
ordinary text file, so you can view its contents with cat or more. Here’s an excerpt:

npe "pciex_root_complex"
pcie_pci "pciexclass,060400"
pcie_pci "pciexclass,060401"
kb8042 "pnpPNP,303"
mouse8042 "pnpPNP,f03"
vgatext "pnpPNP,900"

vgatext "pciclass,000100"
vgatext "pciclass,030000"
vgatext "pciclass,030001"
bscbus "SVIO101"
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pseudo zconsnex

st "scsiclass,01"
sgen "scsa,08.bfcp"
sgen "scsa,08.bvhci"
mpt "pcil000,30"

mpt "pcil000,50"

& Although /etc/driver_aliases is a text file, do not edit it directly because
if it is corrupted in any way, your system may fail to boot. If modifications to
the driver_aliases file are necessary, they must be made using the add_drv(1M) and
rem_drv(1M) commands.

3 _l;f‘

A more detailed discussion of device drivers is beyond the scope of this book. If the topic is of
interest to you, see the OpenSolaris Device Drivers community at http://opensolaris.org/
os/community/device_drivers for more information and resources.

Resources

A number of printing resources are available:
B The Sun documentation is found in the System Administration Guide: Solaris Printing, at
http://docs.sun.com/app/docs/doc/819-7761

B The OpenSolaris Printing community has more information on a variety of printing topics
athttp://opensolaris.org/os/community/printing.

B Find full information on CUPS at http://cups.org.

M A useful note on how to enable duplex printing is available at http://sun.com/
pigadmin/content/submitted/duplex printing.html.

A primary source of information about using USB devices with OpenSolaris is the USB FAQ,
hosted at http://sun.com/io_technologies/usb/USB-Faqg.html.

The JAlbum software for digital photo albums is available from http://jalbum.net.
The main information page for Ekiga video conferencing is http://ekiga.org.
Details on the Open Sound System (OSS) are available at http://opensound.com.

Sun maintains an OpenSolaris Hardware Compatibility List at http://sun.com/bigadmin/
hcl/search.jsp.

Masayuki Murayama’s collection of open source network interface drivers is hosted at
http://homepage2.nifty.com/mrym3/taiyodo/eng/
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Development of drivers for 3G cellular data networking is hosted at the Wireless Wide-Area Net-
working project, http://opensolaris.org/os/project/wwan.

Additional documentation from Sun related to topics from this chapter can be found here:

B System Administration Guide: Advanced Administration at http://docs.sun.com/app/
docs/doc/819-2380.

B System Administration Guide: Devices and File Systems at http://docs.sun.com/app/
docs/doc/819-2723.

Device driver development activity in OpenSolaris is hosted by the Device Drivers community,
http://opensolaris.org/os/community/device_drivers.

OpenSolaris power management development is managed by the Power Management commu-
nity, http://opensolaris.org/os/community/pm.

Summary

In this chapter, you learned how to set up and manage printers on OpenSolaris, including
switching between the two printing systems offered. You explored the details of device support
for a variety of peripheral devices, including multimedia devices such as webcams, digital
cameras, and MP3 players. You also learned about the OpenSolaris interfaces for manag-

ing traditional serial devices and modems, as well as USB-to-serial converters. Finally, you
were introduced to the power management functions available and under development in
OpenSolaris, and the commands used to explore the system’s device configuration.
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nce you've installed an operating system, you'll most likely need

to add software that wasn't installed initially. It’s also likely that

you'll soon want to upgrade your installed software to obtain new
functionality or fixes for bugs that are causing problems or that present a
security threat. Software management is one of the most common admin-
istrative tasks that you'll perform on your system, so it’s critical to under-
stand the tools available.

As mentioned in earlier chapters, one of the key features of OpenSolaris
is a new software management system: the Image Packaging System
(IPS). Chapter 3 presented a basic introduction to the pkg command; in
this chapter, you'll learn more about IPS and software management on
OpenSolaris.

& IPS can be used on operating systems other than
" OpenSolaris, but such usage is beyond the scope of

this book. See the IPS project site at http://opensolaris.org/os/project/pkg

for information.

Package Management

Like other operating systems, software for OpenSolaris is distributed in the
form of a package. Oversimplified a bit, a package is a bundle of files that
is installed to provide a specific function, such as word processing. Once
upon a time, software packages were large and standalone, which meant
that installing a package was a simple operation of copying the files from
the bundle onto your system.
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However, modern systems contain hundreds or thousands of packages linked together by depen-
dencies, so typically you'll need to install multiple packages to obtain the functionality you want.
Modern package managers understand and follow the package dependencies for you and auto-
matically install any required packages, so this process usually remains a simple operation from
the user’s point of view, even though the underlying process is often quite complex.

IPS concepts

To use IPS effectively, you must understand several important concepts and terms. In IPS, the
components that make up a package are called actions; each action expresses an operation that
IPS applies to the system when installing or removing a package. The actions making up each
package are collected into a manifest. Each package can evolve through a series of versions.
Table 6-1 summarizes the actions supported by IPS.

TABLE 6-1

IPS Package Actions

Action Description

depend Defines a dependency on another package
directory Creates a directory in the file system
driver Registers a device driver

file Creates a file in the file system

group Defines a group in /etc/group
hardlink Creates a hard link in the file system
legacy Defines package data for the SVR4 legacy packaging system
license Stores a license associated with the package
Tink Creates a symbolic link in the file system
set Defines a package attribute

user Defines a user in /etc/passwd

Each IPS package is published by an authority, which is a name associated with a specific URL
you configure. The packages published by each authority are listed in a catalog, and each author-
ity distributes its packages using a repository, which is a server that resides either on a local sys-
tem, on some other system on your network, or on the Internet. Multiple mirrored repositories
can be used to optimize package download performance for users in different networks or geo-
graphical locations.

= See Chapter 3 for examples of installing packages from multiple authorities.

£
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An TIPS package is always installed into an image; each image can contain only a single version of
any one package. An image can obtain packages from multiple authorities, one of which is des-
ignated as the preferred authority, meaning it is the default authority for any pkg commands that
do not specify an authority explicitly. There are several types of images:

B Full — A standalone image typically containing an installed instance of an operating
system. The OpenSolaris distribution’s Live CD is a full image, as is a system installed
using it.

B Partial — Linked to a full image. Partial images are used to install and manage OpenSo-
laris zones.

B User — Dependent on a full image. User images enable users to install their own versions
of packages that differ from the versions installed in a full image.

§ Zones are discussed in Chapter 19.

Each image contains data about the packages installed in it, including an index of the package
information and actions that can be searched using the Package Manager and pkg command.
For full and partial images, the package data is stored in the directory /var/pkg. For user
images, the package data is stored in the directory .org.opensolaris.pkg in the root of the
image.

Unlike most other package systems, a key aspect of the design of IPS is its emphasis on safe
package installation and updates. In IPS terms, safety means that operations can be rolled

back, enabling you to return your system to a prior state should a package operation have
undesirable effects on its stability, performance, or usability. The safety of IPS is accomplished
by leveraging the capabilities of the ZFS file system to create a snapshot of the file system prior
to package operations. If you are updating the system using the pkg image-update command,
a clone based on that snapshot is created and the package operations are applied to the clone,
ensuring that the prior system state can be easily restored by rolling back to the snapshot. The
clone is called a boot environment. A boot environment is also created if a pkg install or pkg
uninstall operation fails. If this happens, pkg displays instructions for reverting your system
to that boot environment. See the section “Boot Environment Management” later in this chapter
for more details.

§ Chapter 8 describes the features of the ZFS file system, including snapshots and
“ clones.

CROSS-RI

Package names and versions

All packaging systems provide some type of a naming and versioning scheme so that users can
identify their software. The naming and versioning provided by IPS is key to its ability to resolve
dependencies and upgrade packages as new versions are released.

The canonical form of a package name in IPS is in the form of a Fault Managed Resource
Identifier (FMRI), which is a naming scheme for system resources introduced as part of the Fault
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Management Architecture in Solaris 10. FMRIs are also used to identify hardware components
and system services in OpenSolaris.

FMRIs and fault management are described in Chapter 12.

The FMRI for an IPS package is of the following form:

pkg://authority/name@version

For example, the full FMRI for a version of the Sun Studio Express package in the openso-
laris.org repository is as follows:

pkg://opensolaris.org/sunstudioexpress@0.2008.5,5.11-0.86:20080430T72110327

Fortunately, you'll rarely need to use the entire FMRI in referring to a package. Usually you
can use just the name portion as an argument to the pkg command to install, uninstall, or
view a package, and IPS will use the correct version (which is usually the newest version when
installing, or the installed version when uninstalling) from your preferred authority. Because it’s
sometimes necessary to specify an exact version if you need to install a package that’s not the
newest, it’s useful to understand the meaning of the version portion of the name. It's defined to
be of the following form:

component_version,build_version-branch_version:timestamp

The version of the sunstudioexpress package just shown is interpreted as follows:

B Component Version. 0.2008.5. This version is based on the component’s project ver-
sion. Many projects provide packages that are portable across platforms, so the version
string defined by that project is normally used as the component version.

B Build Version. 5. 11. This specifies which version of OpenSolaris the package contents
were built on. Because OpenSolaris provides forward compatibility, this version indicates
the oldest version of OpenSolaris on which this package can be expected to run. As of
this writing, all releases of OpenSolaris are based on version 5.11 of the operating system.
Solaris 10 was version 5.10.

B Branch Version. 0.86. The branch is normally used to indicate a development build
number, or a maintenance release number in the case of packages updated to provide
specific fixes, such as a security patch.

B Timestamp. 20080430T211032Z. This specifies the date and time when the package
was published into the repository. Each time the package is published into the repository,
it has a different timestamp, even if other portions of the version are identical.

An IPS package that defines only dependency actions is known as a group package, as it’s used to
provide a shortcut to install a set of otherwise unrelated packages that are needed to provide a
function. An example is the hpc-dev package; its manifest demonstrates what a group package
looks like:

$ pkg contents -rm hpc-dev
set name=fmri value=pkg:/hpc-dev@0.5.11,5.11-0.86:20080504T0746417
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set name=authority value=opensolaris.org

set name=description value="HPC Application Development cluster"
depend fmri=pkg:/SUNWj6dmo@0.5.11-0.86 type=require

depend fmri=pkg:/SUNWsvn@1.4.3-0.86 type=require

depend fmri=pkg:/SUNWj6cfg@0.5.11-0.86 type=require

depend fmri=pkg:/SUNWj6rt@0.5.11-0.86 type=require

depend fmri=pkg:/SUNWcvs@1.12.13-0.86 type=require

depend fmri=pkg:/SUNWj6rtx@0.5.11-0.86 type=require

depend fmri=pkg:/SUNWj6man@0.5.11-0.86 type=require

depend fmri=pkg:/SUNWgmake@3.81-0.86 type=require

depend fmri=pkg:/SUNWj6dvx@0.5.11-0.86 type=require

depend fmri=pkg:/SUNWmercurial@0.9.5-0.86 type=require

depend fmri=pkg:/SUNWsprot@0.5.11-0.86 type=require

depend fmri=pkg:/sunstudioexpress@0.2008.05-0.86 type=require
depend fmri=pkg:/clustertools@7.1-0.86 type=require

depend fmri=pkg:/SUNWj6dev@0.5.11-0.86 type=require

depend fmri=pkg:/SUNWj6dmx@0.5.11-0.86 type=require

IPS defines another type of group package called an incorporation, which is used to tie compat-
ible package versions together, ensuring that the set of all such packages that are installed are
updated in lockstep. As of this writing, an incorporation called entire is used to tie the Open-
Solaris operating system packages together for update purposes. See the pkg(5) man page for
more information on incorporations.

Installing packages with Package Manager

Chapter 3 described the basic procedure for installing a package using the pkg(1) com-
mand, including refreshing the catalog using the pkg refresh command, searching for
a package using pkg search, and installing a package using pkg install. In addition
to the pkg command, OpenSolaris includes a graphical interface for software manage-
ment: the Package Manager. You can start the Package Manager using the GNOME
menu item System » Administration » Package Manager. Its main window is shown in
Figure 6-1.

This window consists of several elements, most of which will be familiar if you've used tools
such as Synaptic on Linux distributions. The menu bar and tool bar items enable you to refresh
the catalog, update all packages, install or update a package, or remove a package. To the right
of the toolbar is a drop-down menu for selecting the repository; opensolaris.org is the
default repository for the OpenSolaris distribution, but other distributions might have a different
default. The left pane and the drop-down menu above it enable you to select the categories of
packages that are of interest, while the right pane displays the packages in the selected category,
including name, status, and description. The Show drop-down menu enables you to further
filter the packages displayed in the right pane: only packages that are installed, not installed, or
that have updates available. The Search box enables you to filter the packages by searching the
package index for specific strings. Finally, the bottom pane displays details about the package
selected in the right pane; tabs organize this information into general information about the
package, its contents, and its dependencies.
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The Package Manager is used to manipulate IPS packages.

| Fle Edit Package Semings Help

o eposiory: | org H

lnl |:J ‘Shm lAIPackagﬂ |,J Search A
S s oo :

2DGraphics B sroMonx e e || Gigabit Ethernet Adapter Driv

Accessories ] FSwientconfig-devel-docs

CLltoals ]  Fsworg-dient-docs 7

Communication [[]  FSWxorg-dient-programs 1

Core ] FsWsorg-dientibs [

Developer Tools ] FSwWxorg-data 7

GNOME ] FSWxorg-devel-docs [

arK [[]  Fswsorg-fonts o/  X.Org Foundation X11 fonts

Games |] ] FSWxorg-headers

Graphics ] FSWoowpft L2 v

Internet —r— = j—;“_

Localization =

Mail BRCMbnx

Office 3 Broadcom NetXtreme || Gigabit Ethernet Adapter Driver

Phaotography

Print Generallnfo | Files Details | Dependences | Licenses |

RasterGraphics Information for installed package: Ta

Sodial Software Description:  Broadcom NetXtreme |l Gigabit Ethernet PCI-¥/PCIE Adapter Driver h

Sound & \ideo Enaqrgf :Z?BA;EXM bnx@0.5.11,5.11-0.99:20081002T153311Z

System Tools Version: 0.5.11-0.99 4
| nersat Access lv| | Packaged:  2008-10-021533:11 v
11379 packages fisted, 620 installed, 0 selected, 0 broken.

To install a package, use the searching and filtering capabilities to display the name of the
package, and then click the checkbox to the left of the package name to select it. Then select
Package » Install/Update, or click the Install/Update icon on the toolbar. Package Manager
then downloads the package and any packages that it depends on, and installs them. You can
also select multiple packages (or all packages, using Edit > Select All) and have them installed
simultaneously.

Removing packages

Of course, you may also want to remove packages. This is just as easy as installing. To remove
a package in the Package Manager, select the package by clicking its checkbox and then select
Package » Remove, or click the Remove icon in the toolbar. From the command line, you can
use pkg uninstall:
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# pkg uninstall SUNWwbsup

Creating Plan \

pkg: Cannot remove 'pkg:/SUNWwbsup@0.5.11,5.11-0.95:20080807T1615532" due to

the following packages that depend on it:
pkg:/SUNWpkgcmds@0.5.11,5.11-0.95:20080807T1607157
pkg:/SUNWswmt@0.5.11,5.11-0.95:20080807T1613117
pkg:/sTim_install@0.1,5.11-0.95:20080807T1632547
pkg:/SUNWgui-install@0.5.11,5.11-0.95:20080807T154707Z
pkg:/SUNWinstall-1ibs@0.5.11,5.11-0.95:20080807T71603132

Clearly, removing a package won't always be simple because many packages have dependent
packages, and IPS blocks the removal of a package that has installed dependents. You can, how-
ever, cause a package and all of its dependents to be removed by adding the -r option:

# pkg uninstall -r SUNWwbsup

In addition, you can use the -n option to simulate an uninstall, and the -v option to obtain
more verbose output from the pkg command; these options can also be used with pkg
install.

Viewing, verifying, and searching packages

As shown earlier, you can use Package Manager to view and search packages, the same capabili-
ties available using the pkg command.

You can easily check the state of a package using pkg 1ist:

$ pkg 1ist SUNWtoo

NAME (AUTHORITY) VERSTON STATE UFIX
SUNWtoo 0.5.11-0.95 installed ----
$ pkg 1list netbeans

pkg: no matching packages installed

If the package is installed, its version and state are displayed,; if it’s not installed, then you see
the preceding error message (you can include packages that are not installed using pkg 1ist
-a). If the package is not associated with the image’s preferred authority, then the package’s
authority is displayed in parentheses next to the package name. The UFIX column provides a
concise display of additional state information for the package. The U column means that the
catalog shows the package is upgradeable to a later version from that authority. F indicates

that the package version has been frozen by the administrator and must remain at the installed
version; this is used to ensure that upgrades that are incompatible with a critical package cannot
be applied to the image. I indicates that the package is part of an incorporation, which means
the package will be upgraded if the incorporation is upgraded. X means that the package has an
exclusion with another package, meaning that the two packages cannot both be installed.

As of this writing, the frozen, incorporate, and exclusion capabilities are not yet
“ implemented in IPS.
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If you enter the pkg 11st command without a package name, then it displays information
about all installed packages, or all known packages if the -a option is specified.

To view the details about a package, use pkg info:

$ pkg info SUNWtoo
Name: SUNWtoo
Summary: Programming Tools
State: Installed
Authority: opensolaris.org (preferred)
Version: 0.5.11
Build Release: 5.11

Branch: 0.95
Packaging Date: Thu Aug 7 16:14:29 2008
Size: 1.2 MB

FMRI: pkg:/SUNWtoo@0.5.11,5.11-0.95:20080807T1614297

Note that the information is broken down from the package FMRI to include Version, Build
Release, Branch, and Packaging Date. You can also display this information for packages that are
not installed by using the -r option to pkg info; this causes the information to be retrieved
from the repository. An additional option to pkg info displays the license for a package (the
output is not shown for brevity):

$ pkg info --Ticense SUNWzfs

You can view the contents of a package using pkg contents (some of the output has been
omitted for brevity):

$ pkg contents SUNWtoo
PATH

usr

usr/bin

usr/bin/amd64
usr/bin/amdé4/elfwrap
usr/bin/amdé4/gcore
usr/bin/amdé4/1d
usr/bin/amdée4/1dd
usr/bin/amd64/plimit
usr/bin/amd64/pvs

The default display shows only the package’s file, directory, hard link, and link actions, which
are the objects that one would traditionally think of as a package’s contents. You can obtain the
complete set of actions for a package using pkg contents -m:

$ pkg contents -m SUNWtoo

set name=fmri value=pkg:/SUNWtoo@0.5.11,5.11-0.95:20080807T1614297

license e9e74f0dd7ealec725fd34c9c371a3c5389269bc Ticense=SUNWtoo.copyright pkg
.s1ze=10824 transaction_id=1218125669 pkg%3A%2FSUNWt00%400.5.11%2C5.11-0
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.95%3A20080807T71614297

set name=authority value=opensolaris.org

set name=description value="Programming Tools"

depend fmri=pkg:/SUNWcs1@0.5.11-0.95 type=require

depend fmri=pkg:/SUNWcs@0.5.11-0.95 type=require

dir group=sys mode=0755 owner=root path=usr

dir group=bin mode=0755 owner=root path=usr/bin

dir group=bin mode=0755 owner=root path=usr/bin/amd64

dir group=bin mode=0755 owner=root path=usr/bin/i86

dir group=bin mode=0755 owner=root path=usr/ccs

dir group=bin mode=0755 owner=root path=usr/ccs/bin

dir group=bin mode=0755 owner=root path=usr/ccs/bin/amd64

dir group=bin mode=0755 owner=root path=usr/ccs/1ib

dir group=bin mode=0755 owner=root path=usr/1ib

dir group=bin mode=0755 owner=root path=usr/lib/abi

dir group=bin mode=0755 owner=root path=usr/1ib/amd64

dir group=bin mode=0755 owner=root path=usr/1ib/1d

dir group=bin mode=0755 owner=root path=usr/1ib/1d/amd64

dir group=bin mode=0755 owner=root path=usr/Tib/Tink_audit

dir group=bin mode=0755 owner=root path=usr/1ib/1ink_audit/amd64

file a7ae9ddfd45463f398ffb9aealed42fd818bb6155 elfarch=1386 elfbits=64 elfhash
=808e638647834d1c02f335c0e6755013a78a1925 group=bin mode=0555 owner=root path
=usr/bin/amd64/elfwrap pkg.size=34096

file 6flaadl188e2f33fecf4e90e88a3f105f3354heb elfarch=1386 elfbits=64 elfhash
=506c3e4353dabch45¢c36770dca895710c034fd12 group=bin mode=0555 owner=root path
=usr/bin/amd64/gcore pkg.size=19256

Again, the output has been abridged for brevity, but you can see that this output provides all
of the actions included in the package, and much more detail about each action, including a

recorded hash for each file action that can be used to verify that the installed file matches the
expected contents. This enables you to check your installed packages using pkg verify:

$ pkg verify SUNWtoo

You can also check all packages by omitting the package name. Any files, directories, hard links,
or links that do not match the recorded hashes are reported, and pkg exits with status 1 if

the package fails to verify cleanly. Verification can be helpful if your system is behaving in an
unusual manner because it enables you to check whether your software has been corrupted or
tampered with. If any errors are reported by pkg verify, you can use the pkg fix command
to correct them.

Support for searching packages is provided through the pkg search command, as shown in
this example:

$ pkg search xvm
INDEX ACTION VALUE PACKAGE
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groupname group xvm pkg:/SUNWxvm@3.1-0.95

basename  dir var/svc/manifest/system/xvm pkg:/SUNWxvm@3.1-0.95
basename  dir var/svc/manifest/system/xvm pkg:/SUNWTibvirt@0.5.11-0.95
username  user Xvm pkg:/SUNWxvm@3.1-0.95

The output displays the packages that contain actions matching the search token. As shown in
the output, multiple action types can match a search token, and all matching values are printed.
Recall from Chapter 3 that you can also search your configured repositories by adding the -r
option. Use -s to search a repository that is not one of your configured repositories:

$ pkg search -s http://pkg.sunfreeware.com:9000 pine

INDEX ACTION VALUE PACKAGE

basename  file opt/sfw/bin/pine pkg:/IPSFWpine@0.5.11-5.7
basename  file opt/sfw/bin/pine pkg:/IPSFWpine@0.5.11-5.7
basename  file opt/sfw/bin/pine pkg:/IPSFWpine@0.5.11-5.7

The pkg.sunfreeware.com repository contains three instances of the IPSFWpine@0.5.
11-5.7 package with different timestamps, which is why the same entry appears three times in
the example output.

Searches on your local system use an index to provide good performance. This index is normally
maintained by IPS automatically; as each package is installed or uninstalled, the index is
updated, which is noted in the output from pkg install and pkg uninstall. If the index is
corrupted, a search request will generate a message instructing you to rebuild the index; you can
do so with the following command:

# pkg rebuild-index
PHASE ITEMS
Indexing Packages 583/583

Rebuilding the complete index normally takes just a minute or two.

The package catalog that is cached by IPS from each authority is normally updated automati-
cally as you install, uninstall, and update packages. It is also updated regularly by the app11i -
cation/pkg/update SMF service. You can update the local catalog cache using pkg refresh:

# pkg refresh

SVR4 Packaging and IPS

rom Solaris 2.0 through Solaris 10, all of the Solaris operating system software, as well as many
Fapplications/ were delivered using a packaging technology known as SVR4 (short for System
V Release 4) Packaging. This packaging system was developed by AT&T and Sun as part of the
System V Release 4 project in the late 1980s. See Chapter 1 for more information on the history of
OpenSolaris.

continued
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continued

OpenSolaris continues to provide this packaging system so that applications that have been packaged
using it can be installed on OpenSolaris. Because an SVR4 package can express dependencies on
other SVR4 packages, IPS provides the Tegacy action so that an IPS package that provides the same
functionality as a legacy SVR4 package can declare this equivalence. When installing a package
that includes a legacy action, IPS creates the same package metadata in the SVR4 package database
that the SVR4 package would have provided, so that SVR4 packages that depend on the package
will install normally. As a result, you can run the SVR4 pkginfo(1) command on a freshly installed
OpenSolaris system to see a list of SVR4 packages. However, you can’t remove those packages. If
you attempt to do so with pkgrm(1M), it fails with an error message that indicates the package is
not correctly installed. SVR4 packages that are installed using pkgadd can be removed with pkgrm,
however.

If you have prior experience with Solaris 10 or earlier releases, you may have encountered the
patching system it used, which was layered on top of SVR4 packages. With IPS, all updates
are delivered as packages, rather than patches — the capabilities that the Solaris patching system
provided are embedded in the IPS design.

Updating Your Software

New versions of software appear with great frequency, and you'll likely want to update your sys-
tem to the latest versions, whether to obtain fixes to bugs you're encountering or to use new fea-
tures. OpenSolaris offers both graphical and command-line update tools.

The availability of updates depends on the authorities you have configured. If the preferred
authority of opensolaris.org is set to the OpenSolaris distribution’s release repository,
http://pkg.opensolaris.org/release, updates are provided for each release, as well as
important free updates, such as security updates. The OpenSolaris distribution also offers the
http://pkg.opensolaris.org/dev repository, which provides each development build of
the distribution, normally at two-week intervals. If you are interested in using the OpenSolaris
development updates, you can reset your preferred repository using pkg set-authority:

# pkg set-authority -0 http://pkg.opensolaris.org/dev opensolaris.org
## pkg refresh

Remember that pkg refresh is necessary to obtain the updated package catalog from the
repository you have configured. Other package authorities provide updates according to
whatever schedules and policies suit their purpose.

You also use the set-authority subcommand to configure access to additional package repos-
itories. For example, the http://pkg.opensolaris.org/contrib repository provides a
collection of open source packages that are not supported by Sun. Other repositories hosted at
http://pkg.sun.com provide access to software that requires registration and support updates
for OpenSolaris and other Sun software products.
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To perform an update, the OpenSolaris desktop includes an Update Manager application (select
System » Administration » Update Manager). Figure 6-2 shows the Update Manager window.

178

The top half of the window shows packages for which updates are available; the bottom half
shows details about the selected package. If updates are available, click Update All to install
them. A new boot environment will be created based on the current one, and the package
updates applied to it. See the section “Boot Environment Management” later in this chapter for

more information.

FIGURE 6-2

Use Update Manager for easy software updates.

L7 | Update Manager

Ay

. Updates are available for the following packages.

" | Click Update All io create a new boot environment and install all packages into it.
|Name Latest Version
BRCMbnx

FSWxorg-client-docs 0.5.11-0.100
FSWxorg-clent-programs 0.5.11-0.100
FSWxorg-clientiibs 0.5.11-0.100
FSWxorg-data 0.5.11-0.100
FSWxorg-devel-docs 0.5.11-0.100
FSWxorg-fonts 0.5.11-0.100
FSWaawpft 0.5.11-0.100
FSWoowrtl 0.5.11-0.100
NVDAgraphics 0.5.11-0.100
0S0Lvpanels 0.5.11-0.100
~ Details.

BRCMbnx

Description: Broadcom NetXireme |l Gigabit Ethernet Adapier Driver

FMRI: pkg/BRCMbnx@0.5.11,5.11-0.99: 20081002T 1533112
Version: 0.5.11-0.99

Packaged on: ThuOcr 2 15:33:11 2008

Size: 1.029 MB

=

=N

|

Cancel Updarte All

You can also check for available updates, and update the system, using the command-line tools.
As discussed earlier, the pkg 11st command lists the packages for which updates are available:

$ pkg list

NAME (AUTHORITY)
BRCMbnx
FSWxorg-fonts
NVDAgraphics
SUNW1394
SUNWDTraceToolkit

VERSION
0.5.11-0.86
0.5.11-0.86
11-0.86
1-0.86

0.5.
0.5.1
0.5.11-0.86

STATE

installed
installed
installed
installed
installed



Software Management _

SUNWPython 2.4.4-0.86 installed u---
SUNWPython-extra 0.5.11-0.86 installed u---
SUNWTcT 8.4.14-0.86 installed u---
SUNWTiff 0.5.11-0.86 installed u---
SUNWTk 8.4.14-0.86 installed u---
SUNWa2ps 4.13-0.86 installed u---
SUNWaac 0.5.11-0.86 installed u---
SUNWacc 0.5.11-0.86 installed u---

You can update just a single package and its dependents to the most recent version using pkg
install; you don’t need to specify a version because the most recent version is the default. To
update all of your packages to the most recent version, use the pkg image-update command.
Here is a sample update session:

## pkg image-update
Checking that SUNWipkg (in "/") is up to date ...

DOWNLOAD PKGS FILES XFER (MB)
Completed 544/544 26632/26632 1560.96/1560.96
PHASE ACTIONS

Removal Phase 7668/7668

Update Phase 22607/22607

Install Phase 12666/12666

PHASE ITEMS

Reading Existing Index 8/8

Indexing Packages 544 /544

stagel written to partition 0 sector 0 (abs 4096)

stage2 written to partition 0, 266 sectors starting at 50 (abs 4146)

A clone of opensolaris exists and has been updated and activated. On next boot
the Boot Environment opensolaris-1 will be mounted on '/'. Reboot when ready to
switch to this updated BE.

NOTE: Please review release notes posted at:
http://opensolaris.org/os/project/indiana/resources/relnotes/200811/x86

S ['@ )i [ 3 As of this writing, you must manually update SUNWipkg (the package that contains
“IPS) to its current version before running pkg image-update. If you don’t, pkg exits
with an error, instructing you to update it. The command to update it is pkg install SUNWipkg.

Be sure to review the release notes listed in the preceding message, especially if you are updating
to a development build of the OpenSolaris distribution, because additional manual steps may be
required to ensure that your system operates correctly after the update.

As shown in the output, a new boot environment is created and activated as part of the update
process. The name of the boot environment is automatically generated, but you can rename it
(see the next section).
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Boot Environment Management

As discussed earlier in this chapter, each time you upgrade the operating system using pkg
image-update, a new boot environment (often abbreviated as BE, hence the name of the
beadm command used in managing them) is created, ensuring that you can easily switch back
to the prior version if necessary. You can also create boot environments for your own uses, such
as configuring a system to run different operating systems and applications with just a reboot.
Thus, you need to know a bit about managing boot environments to fully exploit OpenSolaris’
capabilities.

& Solaris 10 and earlier versions of Solaris also incorporate the concept of a boot
* environment, as part of the Live Upgrade technology that can be used to upgrade
or patch Solaris. The boot environment concept in OpenSolaris is similar to, but different from,
the boot environments used with Live Upgrade. The commands used for each are different, and
currently the Live Upgrade and OpenSolaris boot environments do not interact in any way.

A boot environment consists of one or more datasets in the ZFS root pool; each dataset directly
under the pool’s ROOT dataset is defined as a boot environment. Thus, you should not directly
create your own datasets under this dataset using the zfs command. In addition, on x86 sys-
tems, an entry for each boot environment is created in the GRUB menu, enabling you to select
the desired boot environment during system boot.
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= See Chapter 8 for more information on ZFS.
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Three possible states can apply to a boot environment:

M Active — The system is currently booted from this BE.
M Active on Reboot — This BE will be used to boot the system at the next reboot.

B Mounted — The BE’s datasets are mounted at some path in the active BE.

These states are not exclusive. Most of the time your currently active BE will be active on reboot
as well. The active BE is also mounted, obviously, as the root file system.

When you install the OpenSolaris distribution, the initial boot environment that is created is
named opensolaris; it is also activated, of course. There isn’t anything special about this BE
name, though, and you can name a boot environment virtually anything you want — the only
restriction is that the name must be a valid ZFS dataset name because the boot environment
name is also the name of the root dataset for the boot environment. OpenSolaris creates

a snapshot of the opensolaris boot environment at installation time. (A boot environment
snapshot is just a ZFS snapshot of each file system that’s part of the boot environment.)

Viewing boot environments

You can use the beadm 1ist command to view your boot environments:

$ beadm Tist
BE Active Mountpoint Space Policy Created
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b95 - - 71.5K static 2008-08-22 22:35
opensolaris NR / 2.50G static 2008-08-22 21:53

The BE listing shows the name of each boot environment, whether it is active, its mount point
(if currently mounted), disk space used, retention policy, and creation date. The Active col-
umn denotes the currently active boot environment with an N, and the BE that will be active on
reboot with R. If neither state applies to the BE, a hyphen is displayed in this column. The list-
ing displays all BEs that are present in all ZFS pools attached to the system.

%ML‘.{‘E “ clean up old boot environments and snapshots, but the automatic clean-up feature is
not currently implemented.

& The retention policy information is intended to allow the system to automatically

To list the datasets owned by each BE, add the -d option:

$ beadm 1ist -d

BE/Dataset Active Mountpoint Space Policy Created
b95

rpool/R0O0T/b95 - - 71.5K static 2008-08-22 22:35
opensolaris

rpool/R0O0T/opensolaris NR / 2.50G static 2008-08-22 21:53

Note that this listing doesn’t include all of the file systems and volumes on the system, which
are shown here:

# zfs list -t filesystem,volume

NAME USED AVAIL REFER MOUNTPOINT
rpool 3.34G 7.43G 61K /rpool
rpool/RO0T 2.50G6 7.43G 18K Tlegacy
rpool/R0O0T/b95 71.5K 7.43G 2.49G Tlegacy
rpool/R0O0T/opensolaris 2.50G 7.43G 2.49G legacy
rpool/dump 349M  7.43G 349M -
rpool/export 694K 7.43G 19K /export
rpool/export/home 676K 7.43G 658K /export/home
rpool/swap 512M 7.88G 49.6M -

The /export and /export/home file systems are shared across all boot environments in

the pool; this sharing is also applied to the dump and swap volumes, named rpool/dump
and rpool/swap in the preceding example. This means that no matter which of the boot
environments you are booted from, the same space is used for swap and dump, and /export
and /export/home refer to the same file systems. Therefore, users’ home directories persist
across all BEs.

Your installation of the OpenSolaris distribution may not have swap or dump volumes. Creation
of the swap and dump volumes is dependent on the amount of disk space you allocate for
installing OpenSolaris. If it’s less than the recommended amount, then dump and swap volumes
may not be created, as they are not required for OpenSolaris to operate correctly, and the
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installer’s first priority is to allocate sufficient space for your software. See Chapter 7 for
information about swap space, and Chapter 24 for information about crash dumps.

Usually, you'll want your file systems that contain data to be shared across boot envi-
ronments. If so, then create additional file systems under rpool, rpool/export,

or rpool/export/home. However, if you need to create additional file systems that you do not
want shared across boot environments, create those file systems under the boot environment’s
root file system (e.g., rpoo1/R00T/b95 or rpoo1/R0O0T/opensolaris in the previous example)
so that they will be specifically associated with that boot environment.

You can list just the snapshots for each BE using beadm 1ist -s:

$ beadm Tist -s

BE/Snapshot Space Policy Created
b95
opensolaris
opensolaris@b95s 30.0K static 2008-08-23 22:13

opensolaris@install 2.90M static 2008-08-22 22:22

The opensolaris@b95 snapshot was used as the basis for the b95 boot environment, as shown
by using the zfs command to view the root dataset’s origin property:

$ zfs get origin rpool/R0O0T/b95
NAME PROPERTY VALUE SOURCE
rpool/RO0T/b95 origin rpool/R0O0T/opensolaris@b95 -

The section “Creating and destroying boot environments” later in this chapter provides more
information on snapshots.

Activating and renaming boot environments

You can specify which boot environment will be active on reboot using the beadm activate
command:

J# beadm activate b95

When you activate a BE, the pool's bootfs property is set to the activated BE’s root dataset; and
its ZFS datasets are promoted so that they are no longer dependent on their origin snapshots
and datasets, which allows you to delete the snapshots and datasets associated with the inactive
boot environments if you no longer need them. In addition, on x86 systems the GRUB menu
will be modified so that the activated BE’s menu entry is made the default.

The promotion of the ZFS datasets has an interesting effect: The disk space account-
ing will charge the space for all snapshots to the newly active BE. To see this, com-
pare the listings before and after the BE b95 is activated:

# beadm list
BE Active Mountpoint Space Policy Created
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b95 - - 71.5K static 2008-08-22 22:35
opensolaris NR / 2.50G static 2008-08-22 21:53
# beadm activate b95

## beadm 1ist

BE Active Mountpoint Space Policy Created
b95 R - 2.50G static 2008-08-22 22:35
opensolaris N / 1.75M static 2008-08-22 21:53

As mentioned earlier, boot environments can be renamed; use the beadm rename command:

# beadm rename b95 b95-1
# beadm 1ist -d

BE/Dataset Active Mountpoint Space Policy Created
p95-1

rpool/R0O0T/b95-1 - - 80.5K static 2008-08-23 22:13
opensolaris

rpool/R0O0T/opensolaris NR / 2.50G static 2008-08-22 21:53

As shown, the BE’s root dataset is renamed to the new name. On x86 systems, the GRUB menu
item for the boot environment is renamed to the new name.

You cannot rename the currently active boot environment, as the ZFS datasets mak-
. “ing up the boot environment must be remounted to be renamed, and that is not pos-
sible while the system is booted from them.

Creating and destroying boot environments

You can create additional BEs using beadm create:

J# beadm create altbe
# beadm 1list

BE Active Mountpoint Space Policy Created

altbe - - 72.5K static 2008-08-23 21:53
b95 R - 2.50G static 2008-08-22 22:35
opensolaris N / 1.91M static 2008-08-22 21:53

Unlike a BE created automatically by pkg image-update, this newly created BE is not acti-
vated; either append the -a option to beadm create or use beadm activate to make it active
on the next reboot. Remember that a snapshot of the current BE is taken to serve as the basis
for the clones making up the new BE. This snapshot is named using the name of the new BE, so
creating a new BE named testbe will create a snapshot of the current BE called @testbe.

Keep in mind that a snapshot is a read-only copy of a file system at a point in time,
whereas a clone is a writable copy of a snapshot.
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You can create a boot environment in a ZFS pool that is different from the current BE’s pool by
adding the -p option to beadm create. If you have a second pool named bigpool, you can
create the new BE as follows:

f# beadm create -p bigpool testbe

Creating a BE in a different pool takes some time because rather than create a clone in the same
pool, which is virtually instantaneous, beadm must actually copy the ZES datasets using ZFS’s
send and receive dataset capability.

You can create a boot environment based on a boot environment other than the currently active
BE using beadm create -e:

# beadm create -e b95 altbe

The altbe environment will be created based on the current contents of BE b95. You can also
specify a snapshot of a BE to be used as the source, by including the snapshot name in the BE
specification:

## beadm create -e b95@install altbe
You can create a snapshot of a BE using beadm create by specifying the snapshot name:
# beadm create altbe@testsnap

This creates a snapshot with the provided snapshot name for each dataset that’s a component of
the BE.

You can also set ZFS properties on a BE’s datasets at creation time using the -o option to beadm
create. For example, you can create the BE’s datasets as compressed using the following
command:

f# beadm create -o compression=on altbe

Any ZFS dataset property may be set using this option. See Chapter 8 or the zfs(1M) man page
for a list of the ZFS dataset properties.

Of course, you also need to be able to destroy BEs to free the disk space they occupy; this can
be done using beadm destroy:

# beadm destroy altbe
Are you sure you want to destroy altbe? This action cannot be undone (y/[n]): y

You can force the destroy operation to not prompt by adding the -F option to the command.
This is most useful for scripting; we don’t recommend getting into the habit of using -F interac-
tively, as it’s all too easy to destroy a boot environment accidentally.

SNARE Be aware that the destroy operation also destroys the ZFS snapshots from which the

S 100t environment is cloned, unless those snapshots have other dependent clones, in
which case they cannot be destroyed until those clones are promoted to remove the dependency.
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You can destroy a specific snapshot by specifying the snapshot name to beadm destroy:

# beadm destroy altbe@testsnap

Mounting boot environments

Finally, if you need to correct a problem with a boot environment or compatre files between boot
environments, you can mount and unmount BEs using beadm mount and beadm unmount:

# beadm mount b95 /b95
# beadm Tist

BE Active Mountpoint Space Policy Created

altbe - - 71.5K static 2008-08-24 21:19

b95 - /b95 79.5K static 2008-08-23 22:13

opensolaris NR / 2.50G static 2008-08-22 21:53

# 1s /b95

bin COPYRIGHT etc kernel lost+found net proc save tmp
boot  dev export Tib media opt root sbin usr
cdrom devices home LICENSE mnt platform rpool  system var

# beadm unmount b95

& Currently, you must be careful to always unmount a mounted boot environment

% before rebooting the system; otherwise, an attempt to boot from that BE will cause
the system to panic because the datasets’ mountpoint properties will be set to an incorrect
value.

Managing a Package Repository

IPS packages are published to, and installed from, repository servers that are accessed over a
network. You may be completely satisfied using the repositories provided by the OpenSolaris
community, Sun, or other software providers and community members, as the extensive list of
packages provided by the various repositories is likely to meet your needs. However, if you're
a software developer or a system administrator, you may want to run your own repository

for development purposes, to distribute your custom packages using your own servers, or to
provide a local mirror of a repository to optimize performance and network utilization.

Mirroring has recently been implemented; see the IPS documentation for instructions
“ on setting up a mirror repository.

An IPS repository is provided by the SMF service application/pkg/server. This service is
disabled by default, so to start using it you first need to enable it:

# svcadm enable application/pkg/server

This starts the IPS server, which is the daemon program pkg.depotd(1M). The service config-
uration is specified by the service’s SMF properties, which are members of the pkg application
property group. The properties are described in Table 6-2.
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Application/pkg/server SMF Properties

Property Name Description

content_root Path to server’s static web content; defaults to /usr/share/1ib/pkg

inst_root Path to repository storage; defaults to /var/pkg/repo

log_access Pathname of access log; defaults to no access log for SMF service,
stdout if run from a terminal

log_errors Pathname of error log; defaults to stderr, meaning the errors appear in
the SMF service log

port Network port for repository; defaults to 80

proxy_base Base URL for the server; used for reverse proxy configurations with a

web server. The default value is empty.

socket_timeout Seconds to wait for client response before closing the connection;
defaults to 60 seconds

threads Number of threads used to serve requests; defaults to 10

S §’£F See Chapter 13 for more information on managing SMF services.

For example, to configure the IPS server to use port 8000, use the svccfg command, and then
svcadm to refresh and restart the server:

# svccfg -s application/pkg/server setprop pkg/port = 8000
# svcadm refresh application/pkg/server
# svcadm restart application/pkg/server

& We recommend that you modify the inst_root property to use a pathname that’s
® outside of the boot environment’s datasets. That way, the repository is not cloned
in each boot environment. For example, you can create a dataset called rpool/export/repo
mounted at /export/repo and then modify the inst_root property to this value.

You can view the status of your repository server by connecting to it with your web browser.
The status page from pkg.opensolaris.org/release is shown in Figure 6-3.

Using the web interface, you can view statistics for a repository and browse information about
each package, which is the same information you can obtain from the command line using pkg
info and pkg contents.

The IPS repository also provides an RSS feed of package updates to the repos-

' itory at the path /feed. For the opensolaris.org repository, the URL is thus
http://pkg.opensolaris.org/release/feed. This enables you to use the Live Bookmarks
feature of Firefox or another RSS reader to track updates to repositories, providing an alert to
packages you may want to install or update.
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A web browser can be used to view the IPS repository status.
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Fle Edit View Higtory HBookmarks JTools Help i §
@-... ..» = h’lﬂ e Q 0 : is.org shtml N I.iJ IGl* | Guagle —
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OpenSolaris Packaging Repository
Catal Bl
About A
Packages 22883
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» Vsl opersolieis com Last Updated "5 1aas
= Visit opengalass. ong
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Search Packages
| Search)
Search Tips:
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fusrfbinfvim
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«.xhta?
» Tofind packages based on specilic matching characers use T and 18
Jusr/bing [calt
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Release and Granch | 200011 (0.5.11-0.101) 13 | Browse |
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Once you have a repository running, the next task is publishing packages into it, which is done
using the pkgsend(1) command. See its man page for basic information. Chapter 24 provides a
detailed example of building an IPS package and publishing it into a repository.

IPS also provides the pkgrecv (1) command to copy a package from an IPS repository in a for-
mat that allows it to be modified and then republished using pkgsend. See the man page for
more information.

If you’re familiar with other packaging systems, you may have noticed that there is
no on-disk format specified for an IPS package. The IPS designers intend to provide
such a format in the near future, but it does not currently exist.

.\.

Building Your Own Distribution

Rather than use the OpenSolaris software management tools to manage your own installation
of the OpenSolaris distribution, you may want to build your own custom distribution based
on its packages. This is possible because, as described in Chapter 1, the core technology in
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OpenSolaris is freely redistributable. The tools used to construct the OpenSolaris distribution,
called the Distribution Constructor, are also open source and available for you to use in
constructing your own distribution. This topic is beyond the scope of this book, but to explore
further, install the Distribution Constructor using the following command:

# pkg install SUNWdistro-const

Once this package is installed, consult the distro_const(1M) man page and the documen-
tation links it provides to get started building your own distribution. You can also consult the
Distribution Community group, www.opensolaris.org/os/community/distribution/, for
assistance. The builders of most of the distributions discussed in Chapter 2 are members of this
community group.

If you do build a custom distribution that you’d like to redistribute, be aware that

“ you need to conform to the OpenSolaris trademark and branding guidelines, which
are maintained by the Trademark and Branding project, http://opensolaris.org/os/project/
branding/.

Resources

The Image Packaging System development is hosted at http://opensolaris.org/os/
project/pkg.

The boot environment management utilities and Distribution Constructor are products of the
Caiman installer project, http://opensolaris.org/os/project/caiman.

The Distributions community group provides resources for distribution creators; its home page
ishttp://opensolaris.org/os/community/distribution.

Summary

This chapter introduced the concepts underlying the innovative new packaging system in Open-
Solaris, the Image Packaging System (IPS), and demonstrated how to perform many of the com-
mon software management tasks using both the graphical Package Manager and the pkg com-

mand, including updating to a new release of the operating system and managing multiple boot
environments. You also learned how to create a package repository and obtain the tools needed
to build your own distribution. You're ready to manage the software on an OpenSolaris system!
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penSolaris includes support for a variety of storage devices and

local file systems, as well as a traditional volume manager. This

chapter describes these capabilities, with the exception of ZFS,
which is described in the next chapter. Network file system support is
described in Chapter 10.

Although data is usually stored on disk, it is generally accessed through a
file system, hiding device-specific details. OpenSolaris provides file system
support through a pluggable framework so that a variety of file systems
can be used concurrently and applications are unaware of the type of
underlying file system on which their data actually resides. Applications
simply access files and directories through the standard POSIX APIs,
while the kernel transparently manages the low-level access using the file
system—specific code. New file systems can be introduced at any time
without affecting existing application code.

This chapter describes the general disk storage support provided in
OpenSolaris and focuses on the local file systems that applications use

to store data. However, because of the flexible nature of the file system
interface in UNIX, and the way that UNIX has traditionally exposed
services such as networking through the file system API, OpenSolaris

also provides access to a variety of other services as if they were true file
systems. This way, those services can be accessed using the familiar file
APIs, even though the underlying service may be quite different. One
example is the Process File System, procfs, which is a pseudo-file system
that actually provides access to all of the running processes on the system.
This file system is described in the proc(4) man page. Some of the other
nontraditional file systems are used for contracts, ctfs(7fs), or kernel
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modules, 0bjfs(7fs). You can learn more about these types of file systems on their man
pages.

The file systems described in this chapter are the more traditional local file systems used for data
storage. Because of its close relationship with disks and standard file systems, the Solaris Volume
Manager (SVM) is also discussed.

Disks

Before delving into the specifics of each file system, you need to first understand how storage is
managed on OpenSolaris. Although most data is still commonly stored on traditional hard disk
drives, a variety of other media are treated by the system as if they were a standard disk. This
includes DVD drives, USB sticks, and system memory. Modern disks present a logical view of
the device as a sequential array of disk blocks, normally 512 bytes in size. Each block is individ-
ually addressable, but it is up to the operating system and file system to manage accesses down
to the individual byte level within a block. In addition to exposing blocks, older disks exposed
the concept of heads, tracks, and cylinders. These concepts still persist, but this data is usually
fabricated and no longer has any actual relationship to the underlying physical hardware.

Disk device names

All disks have a name under the /dev/dsk and /dev/rdsk subdirectories. Because disks can
be accessed at both the block level and the individual byte level, each disk is exposed with two
different names. The block-level access is made through the /dev/dsk name, and the byte-level
access, which is known as raw access, is made through the /dev/rdsk name (hence the “r”).
Some commands must be used with the block name, while others must be used with the raw
name. These restrictions are described as each command is discussed.

Although OpenSolaris has a convention for naming individual disks, it is not always followed by
third-party device drivers, so you should not make any assumptions about how a disk will be
named. For disks managed by a driver that is part of OpenSolaris, the name is normally of the
following form:

ciFtirdisir

The name has up to four parts, with an embedded hex number for each part. A typical example
would be the name c0t0d0s0 or even c1t01000003BA4E5E2000002A0047FA3E22d0s2. The
t# portion of the name is optional and might not be present with some disks, depending on the
driver that manages the device. The meanings of each part of the name are controller (¢), target

(t), disk (d), and slice (s).

Another common style of disk name that you will encounter follows a form similar to the ctds
name but instead of the s# component, it ends with a p# component. An example would be
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c0t0d0p0. The meaning of this part of the name is partition (p). Both slices and partitions are
described in the next section.

As previously mentioned, the name is created by the device driver for the specific disk and
might not follow this convention. You don’t need to worry about the exact style of the

name — just understand that each disk has specific names in the file system, which you use to
access and manage that disk. Depending on what you're doing, different paths and names are
used for the same device.

If you have many disks attached to your system, it can be confusing to determine which name

is associated with each disk. The format command, described below, is probably the easiest
tool to display the list of disks on the system. The prtconf command can also be used to
display a detailed view of the configuration of the system, which includes the layout of the
system buses and the devices attached to each bus. The dev_11ink property in the output shows
the /dev/dsk name for each disk, but you still need a detailed understanding of the system’s
hardware configuration to understand the output. This example shows a portion of the prtconf
output:

$ prtconf -v
sd, instance #18

Device Minor Nodes:
dev=(27,1152)

dev_path=/pci@5,0/pcil022,7450@4/pcil08e,534d@4,1/sd@0,0:a
spectype=blk type=minor
dev_link=/dev/dsk/c2t0d0s0
dev_link=/dev/sdl44a

dev_path=/pci@5,0/pcil022,7450@4/pcil08e,534d@4,1/sd@0,0:a,raw
spectype=chr type